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第 1 章 超算有限元分析系统(SciFEA2.1)简介 

超算有限元分析系统(SciFEA)可用于固体力学、传热、渗流、电

磁等问题的有限元计算模拟。 
 

具体的计算模块包括: 
弹性力学平面应力模块、平面应变模块、轴对称模块、三维模块； 
二维传热模块、轴对称传热模块；三维传热模块； 
二维渗流模块、三维渗流模块； 
二维静电模块、三维静电模块； 
二维静磁模块、三维静磁模块； 
二维 Biot 固结模块、三维 Biot 固结模块； 
二维正交各向异性模块、三维正交各向异性模块； 
二维桁架模块、三维桁架模块； 
二维刚架模块、三维刚架模块； 
二维板壳模块、三维板壳模块； 
二维瞬态传热模块、轴对称瞬态传热模块；三维瞬态传热模块； 
二维无压渗流模块、三维无压渗流模块； 
二维 Duncan 模块、三维 Duncan 模块； 

 
 

超算有限元分析系统(SciFEA)可用于机械、土木、电气、电子、

热能、航空航天、地质、能源等专业的有限元计算分析。也可用于高

校研究所等单位的有限元教学与科研。 
超算有限元分析系统总体分为界面、有限元计算、有限元前后处

理三大部分。其中有限元前后处理采用国际著名的前后处理软件包

GID。SciFEA 系统提供 GID 的输入输出接口模块。 
 软件运行的环境包括硬件部分和软件部分。推荐配置为: 
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硬件 

主机:Pentium IV 以上处理器 

存储器:512M 以上内存和 8G 以上硬盘,4M 以上显存 

显示器：分辨率至少 800³600。 

软件 

操作系统：Windows2000,WindowXP 
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第2章  超算有限元分析系统(SciFEA2.1)软件安装与配置 

2.1 软件安装 

①运行安装的 SciFEA-Setup.exe，系统出现界面如图 2-1 所示： 

 

 

 

 

 

图 2-1 
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②请点击“Next”按键，系统出现界面如图 2-2 所示： 

 

 

 

 

 

 

图 2-2 
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③请点击“Next”图标按键，系统出现界面如图 2-3 所示： 

 

图 2-3 

④填入“Name”和“Company”请点击“Next”按键，系统出现

界面如图 2-4 所示： 

⑤请点击“Next”按键，系统出现界面如图 2-5 所示： 
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图 2-4                                       图 2-5 

⑥请点击“Next”按键，系统出现界面如图 2-6 所示： 

⑦请点击“Next”按键，系统出现界面如图 2-7 所示： 
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图 2-6                                      图 2-7 

⑨最后系统出现界面如图 2-8 所示： 

 

 

图 2-8 
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⑩请点击“Finish”按键，安装完毕。 

安装完成后，用户可在 Windwos 程序菜单中选择“超算有限元

分析系统”，运行 SciFEA 软件进行有限元分析。 

2.2 软件注册 

2.2.1 计算部分注册 
SciFEA 软件注册包括计算及前后处理两部分的注册；计算部分在计

算的单元规模小于 700 个单元时无需注册，当计算规模大于 700 个单

元时需要注册。SciFEA 注册说明如下： 

①运行 SciFEA 软件之后，进入页面然后点帮助中的软件注册，如图

2-9。 

 

图 2-9 

 

 

 

②点软件注册之后，出现如图 2-10 所示注册对话框。 

http://www.supcompute.com/downloads/SciFEA注册说明.doc
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图 2-10 

③然后请把电脑上红圈部分的内容，对应填写在申请表当中，如下表

所示。并填写完整注册申请信息，发送到北京超算。 
④收到北京超算的 SciFEA 软件注册码后，填入图 2-10 中，单击“OK”

按钮完成注册。 
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2.2.2 前后处理部分注册 

SciFEA 前后处理采用国际著名的前后处理软件包 GiD。GiD 软件包在

划分的网格总数小于 700 时也无需注册，当网格总数大于 700 时（三

维模型时不注册使用的最大网格数为 3000）才需注册。具体过程如

下。 

①通过 SciFEA 界面启动前处理，进入到 GiD 系统，按图 2-11 所示操

作获取注册信息。 

姓名 
 单

位 
 

联系

电话 
 电

子邮件 
 

研究

领域 
 

 

机器

名 
yinhx 系

统信息 
b49f6ab9b8f88977 
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图 2-11 
②选择 Help-> Register 后，系统会弹出一个对话框如图 2-12，点

击里面的网址并登录到 GiD 网站。 

 

图 2-12 
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③目前 SciFEA 集成的是 GiD9 版本，所以选择图 2-13 所示的注册选

项。 

 

图 2-13 
④进入注册页面后，拖动网页滚动条到最后（前的信息可以不填），

按照下面 2-14 的图示填写注册信息。 

 
图 2-14 

⑤最后，单击“Send”按钮就可以获得一次有效期一个月的注册码。 
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2.3 2.3 模块挂载操作流程 

①启动 SciFEA 软件进入操作界面； 

单击界面菜单键工具条，选择模块挂载；如下图 

 
图 2-15 

② 选中所需要挂载的模块，如轴对称稳态传热模型，点击确认即可

成功挂载模块。 

打开文件：在 SciFEA 的安装目录下进行如下操作
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图 2-16 
然后再选择需要打开的项目 udm.pro 如下图所示 

 
图 2-17 

2.4 2.4 升级说明 

① 首先在北京超算公司网站首页最新公告栏找到相应升级的压缩

包，下载并解压缩后会得到相应的 udm 文件夹和 udmlist 文件。 

② 把解压缩得到的 udm 文件夹和 udmlist 文件放在 SciFEA 的安装

目录下，如下图 

 
图 2-18 

③ 然后就是进行模块挂载操作（具体操作流程请参照模块挂载操作

流程） 
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第3章 超算有限元分析系统(SciFEA2.1)界面； 

1、打开软件之后，出现界面如图 3-1 所示： 

 
图 3-1 

2、点击“项目”中有“新建项目”，“打开项目”，“退出”三项选择；

点“新建项目”按键，出现界面如图 3-2 所示： 

你可以根据自己的要求填写或是选择。 

 

图 3-2  新建项目对话框 
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3、点击“项目”中的“打开项目”按键，出现界面如图 3-3 所示： 

 

图 3-3 

选择好之后，出现界面如图 3-4 所示： 
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      图 3-4  打开项目对话框 

 

4、点击“前处理”中有“材料参数”，“边界条件”，“弹性力学”，“传

热”，“渗流”，“电磁”选择项；其中“弹性力学”又分“二维线弹性

平面应力”，“二维线弹性平面应变”，“二维轴对称问题”，“三维空间

问题”；“传热”分“二维传热”和“三维传热”；“渗流”分“二维渗

流”和“三维渗流”；“电磁”分“二维静电场”，“三维静电场”，“二

维静磁场”，“三维静磁场”。 

点击"前处理"中的“材料参数”，出现界面如图 3-5 所示： 

 

 

图 3-5  材料参数对话框 

 

点击“前处理”中的“边界条件”，出现界面如图 3-6 所示： 

 
图 3-6  边界条件对话框 
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5、点击“计算”中有“设置最大载荷步”、“弹性力学”、“传热”、“渗

流”、“电磁”选择项；其中“弹性力学”又分“二维线弹性平面应力”，

“二维线弹性平面应变”，“二维轴对称问题”，“三维空间问题”；“传

热”分“二维传热”和“三维传热”；“渗流”分“二维渗流”和“三

维渗流”；“电磁”分“二维静电场”，“三维静电场”，“二维静磁场”，

“三维静磁场”。 

点击“计算”中的“设置最大载荷步”按键，出现界面如图 3-7 所

示： 

 

图 3-7 

6、点击“后处理”中有“弹性力学”、“传热”、“渗流”、“电磁”选

择项；其中“弹性力学”又分“二维线弹性平面应力”，“二维线弹性

平面应变”，“二维轴对称问题”，“三维空间问题”；“传热”分“二维

传热”和“三维传热”；“渗流”分“二维渗流”和“三维渗流”；“电

磁”分“二维静电场”，“三维静电场”，“二维静磁场”，“三维静磁场”。 

7、点击“帮助”中有“帮助”，“用户向导”，“软件注册”，“访问超

算”，“版本说明”选择项。 

点击“帮助”中的“软件注册”，出现界面如图 3-8 所示： 
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图 3-8  软件注册对话框 

8、点击“帮助”中的“版本说明”，出现界面如图 3-9 所示： 

 
图 3-9  版本说明对话框 
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第4章 建模与网格剖分 

4.1 前处部分 

4.1.1 主界面 
用户选择项目后再点击前处理菜单或前处理按钮即可启动有限元计算的

前处理器 GID， GID 的基本界面如图 4-1 所示。 

 
图 4-1 界面 

 

4.1.2 工具条 

 
图 4-2 工具条 

 

工具条是一种作为方便用户操作的辅助菜单，其每一项功能
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都可以在相应的菜单中找到对应的命令，所以在这里，只介绍每

一项的功能及对应菜单的位置，具体的功能及操作在菜单对应项

中具体说明，用户可以参考下面的章节。 

可以看到，本工具条被分割为五部分 ，每一个部分分别对应以下的菜单

项 。 
4.1.3 第一部分： 

功能： 

 
图 4-3 视图工具条 

对应的菜单： 
放大：View>Zoom>In 
缩小：View>Zoom>Out 
居中：View>Rotate>Center 
刷新：View>Redraw 
旋转：View>Rotate>Trackball 
移动：View>Pan>Two point 

4.1.4 第二部分 
功能 

     
图 4-4 创建几何模型工具条 

对应菜单： 
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    创建直线：Geometry>Create>Line 
    创建圆弧：Geometry>Create>Arc 
    创建样条曲线：Geometry>Create>NURBS Line 
    创建多折线：Geometry>Create>Polyline 

4.1.5 第三部分 
功能： 

 

图 4-5 创建模块工具条 

对应菜单 
创建样条曲面：Geometry>Create>NURBS Surface>By contour 
创建体：Geometry>Create>Volume>By contour 
创建模块：Geometry>Create>Object 
GID 中还有的几何模块有： 

 
图 4-6 模块工具条 

对应的菜单： 
    矩形：Geometry>Create>Object>Rectangle 
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    多边形：Geometry>Create>Object>Polygon 
    圆：Geometry>Create>Object>Circle 
    球：Geometry>Create>Object>Sphere 
    圆柱：Geometry>Create>Object>Cylinder 
    圆锥：Geometry>Create>Object>Cone 

多棱柱：Geometry>Create>Object>Prism 
圆环：Geometry>Create>Object>Torus 

 
4.1.6 第四部分 

功能 

 
图 4-7 删除和察看属性工具条 

对应菜单： 
删除：Geometry>Delete 
属性：Utilities>List 
其中删除可以根据几何模型的种类，分为删除关键点，线，面，体。 

       功能： 

 

图 4-8 删除工具对象条 

        对应菜单 
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        删除关键点：Geometry>Delete>Point 
        删除线：Geometry>Delete>Line 
        删除面：Geometry>Delete>Surface 

删除体 Geometry>Delete>Volume 
删除所有类型：Geometry>Delete>All Types 

 
其中属性功能可以察看关键点，线，面，体，以及节点和单元的属性。 

功能 

 

图 4-9 属性工具条 

 

对应菜单 
    在几何模型界面（具体参见下一工具条操作） 
    察看关键点属性：Utilities>List>point 
    察看线属性：Utilities>List>line 
    察看面属性：Utilities>List>Surface 
    察看体属性：Utilities>List>Volume 
    在网格模型界面（具体参见下一工具条操作） 
    察看节点属性：Utilities>List>Node 

            察看单元属性：Utilities>List> Element 
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4.1.7 第五部分 
功能： 

 
图 4-10 几何模型和网格模型切换工具条 

对应菜单： 
       Meshing>Mesh View。 

在不同的模型情况下，有些菜单的功能项会有相应的变化，例如上面提到

的属性工具菜单的变化。 
 

4.1.8 菜单 

   
图 4-11 

GID 的所有功能，用户都可以在此处找到，菜单按照如下功能分出。 
 File：文件操作 
 View：视图选择与调整 
 Geometry：几何模型操作 
 Utilities：辅助操作 
 Data：施加边界条件 
 Meshing：划分网格操作 
 Calculate：数据导出操作 
 Help：帮助文档 

下面我们按照菜单的顺序，对菜单中的一些常用的功能，以及使用方法做

一个简要的介绍，如果你想了解更多，更详细的功能，可以查找 GID Reference 

Manual，或者可以在帮助中找到。 
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4.2 后处理部分 

用户在完成有限元计算模拟之后再点击后处理菜单或后处理按钮即可启

动有限元计算的后处理器 GID，再选择 Files->postprocess 菜单即可进入 GID

后处理的界面。其基本界面如图 4-12 所示。 

 
图 4-12 后处理基本界面 

4.2.1 后处理工具条 

 
图 4-13 功能工具条 

工具条是一种作为方便用户操作的辅助菜单，其每一项功能都可
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以在相应的菜单中找到对应的命令，所以在这里，只介绍每一项

的功能及对应菜单的位置，具体的功能及操作在菜单对应项中具

体说明，用户可以参考下面的章节。 

可以看到，本工具条被分割为五部分 ，每一个部分分别对应以下的菜单

项 。 
4.2.2 View 工具条 

该部分对应 View 菜单，该操作和功能与前处理中的一致，可以参见前处

理界面说明中 View 菜单说明文档。 
 
功能： 

 
图 4-14  View 菜单 

    对应菜单 
 放大：View>Zoom>In 
 缩小：View>Zoom>Out 
 居中：View>Rotate>Center 
 刷新：View>Redraw 
 旋转：View>Rotate>Trackball 
 移动：View>Pan>Two point 
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4.2.3 光源、显示类型及透视工具条 

功能： 

 

图 4-15 光源、显示类型及透视工具条 

 
对应菜单 

 光源位置： View>Render>Chang light dir 
 显示类型： Windows>View Style 
 透视方式： Windows>View Style 

 
对于显示类型和透视方式有以下的选择项： 

 
功能： 
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图 4-16 显示类型 

 

 
图 4-17 透视方式 

4.2.4 剪切后的显示工具条 

功能： 

     
图 4-18 剪切后的显示 

 
对应菜单： 

 实体显示与消隐：Windows>View style 
 面显示与消隐：Windows>View style 
 分割面显示消隐：Windows>View style> 
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4.2.5 剪切面工具条 

功能： 

 
图 4-19 剪切面 

对应菜单 
 做分割面：Do cuts>Cut Plane 

4.2.6 结果值工具条 

功能： 

 
图 4-20 

对应菜单： 
 调整最大显示值：Option>Contour>Max Options>Set Value 
 调整最小显示值：Option>Contour>Min Options>Set Value 
 按照实际值显示：Option>Contour>Reset All 
 列出单元、节点属性：Utilities>List 
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4.2.7 菜单条 

 

图 4-21  菜单条 

 Files：文件操作菜单 
 View：视图选择与调整 
 Utilities：辅助功能操作 
 Do Cuts：剪切操作 
 View Results：结果显示方式 
 Options：修改显示属性 
 Window：功能对话框 
 Help：帮助文档 

下面我们按照菜单的顺序，对菜单中的一些常用的功能，以及使用方法做

一个简要的介绍，如果你想了解更多，更详细的功能，可以查找 GID Reference 

Manual，或者可以在帮助中找到。 
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第5章  固体力学线弹性问题 

5.1 平面应力问题 

5.1.1 问题描述 

本章以一个具体的固体力学线弹性问题――带孔平板的拉伸，

来详细说明用 SciFEA 求解此类问题的方法和步骤。 
此问题描述如下：对如图 5-1 所示的承受拉伸载荷的中心开孔正

方形板进行线弹性分析。正方形板边长 100mm，中心孔半径为 10mm，

上下分别施加 100N 的均布载荷，板的材料特性如下：弹性模量（杨

氏模量）为 200000N/mm2，泊松比为 0.3，研究板的受力和变化情况，

特别是小孔附近的应力集中现象。 

 
图 5-1  带孔平板拉伸几何模型 
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5.1.2 求解步骤 

选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 5-2 所示的对话框。 

 

图 5-2  选择项目类型对话框 

(2)点击“问题类型”栏中的“二维平面应力”选项。如图 5-2
所示。 

(3)点击“OK”按钮完成项目类型的选择。 

设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 5-3 所示。或者

单击工具条中的 按钮弹出如图 5-4 所示材料参数数据输入表格。 
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图 5-3  选择材料参数输入 

 

 
图 5-4  材料参数输入对话框 

 

(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 5-5 所示。 
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图 5-5  填写完成材料数据输入 

 

(3) 选择“前处理”—>“边界条件”按钮，如图 5-6 所示。或

者单击工具条中的 按钮弹如图 5-7 所示数据输入表格。 

 
图 5-6  选择边界条件输入 
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图 5-7  边界条件输入对话框 

 
(4)按照问题描述中的参数依次填入边界条件数据表格。填写完

成后如图 5-8 所示。对本问题施加一法向力即可，负号表示受拉。 

 
 

图 5-8  填写完成边界条件输入 

 
建模、设置材料属性和施加边界条件 

(1) 启动 GID 以创建模型。点击菜单选择“前处理”—>“弹性

力学”—>“二维线弹性平面应力”，如图 5-9 所示。 
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图 5-9  启动前处理 

或者单击工具条中的 按钮弹出如图 5-10 所示前处理初始化窗口。 

 
图 5-10 前处理初始化窗口 
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(2) 建模。通过对几何模型进行分析，可以根据对称性取 1/4 部

分进行简化。 
a. 点击菜单【Geometry】-【Create】-【Line】，在命令栏依次输

入点坐标：10,0，按 Enter 键，输入 50,0，按 Enter 键，输入 50,50，
按 Enter 键，输入 0,50，按 Enter 键，输入 0,10，按 Enter 键，按“Esc”
键，生成平板的外边界如图 5-11 所示。 

 
图 5-11  生成平板外边界 

 
b. 点击菜单【Geometry】-【Create】-【Arc】，Gid 中定义不共

线三点即可生成圆弧，在 FEPG.Gid 命令栏依次输入坐标：10 ,0，按

Enter 键，系统提示是否和已有点连接，选择连接(Join)，继续输入 8 ,6，
按 Enter 键，输入 0 ,10，按 Enter 键，生成中间半圆弧如图 5-12 所示。 
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 图 5-12  生成中间半圆弧 

c. 点击菜单【Geometry】-【Create】-【NURBS surface】-【By 
contour】，用鼠标拉出一个矩形框选中所有线和圆弧，按“Esc”键即

可生成一个封闭的面如图 5-13 所示。 

 
图 5-13  生成封闭面 

(3).选择问题类型。点击菜单【Data】-【Problem Type】-【SCI】，
弹出“Dialog Window”，点击“确定”按钮即可。 

(4).定义材料特性、施加载荷约束。点击菜单【Data】-【Conditions】
弹出“Conditions”对话框如图 5-14 所示。 
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① 定义材料。点击表示面单元的按钮 ，选中下拉菜单中的

“Surface－aet3”，在“mate Num”（即 Material Number）中填入“1”，
点击“Assign”，选择生成的面，点击“Finish”即定义好材料特性。

用户可以点击菜单【Draw】-【Colors】来观察是否已经定义成功。

如图 5-15 所示。 
 

                 
 

图 5-14  Conditions 对话框              图 5-15  定义材料属性并检查 

 
②施加载荷。点击线单元按钮 ，选中下拉菜单中的“Line-all2”，

在“mate Num”中填入“1”，点击“Assign”按钮，选择上端要施加

载荷的边，如图 5-16 所示。然后，点击 Conditions 对话框中的 Finish

按钮。 
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图 5-16  施加载荷 

③定义约束。根据对称性简化条件，须对下边界施加沿 y 方向的

约束条件。在下拉框中选择“line-eliso2da”，并把“u－l”项的值改

为“1”，表示物体 x 方向可以变形。“u－D”项的取默认“0.0”，表

示物体 x 方向没有外载荷。把“v－l”项取默认值“－1”，表示物体

在 y 方向给定位移。“v－D”项的取默认“0.0”，表示物体 y 方向给

定的位移为零（满足对称性条件）。单击“Assign”按钮，选择下底

边，如图 5-17 所示，完成下底边约束条件的指定。           
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     图 5-17 定义约束条件 

类似地，把“u－l”项的值改为“－1”，表示物体 x 方向给定位移。

“u－D”项的取默认“0.0”，表示物体 x 方向给定的位移为零（满足

对称性条件）。把“v－l”项取默认值“1”，表示物体在 y 方向可以

自由变形。“v－D”项的取默认“0.0”，表示物体 y 方向没有外载荷。

单击“Assign”按钮，选择左边，如图 5-18 所示，完成左边约束条

件的指定。  
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图 5-18  定义约束位移 

需要说明的是，这几步定义材料，施加载荷的操作没有先后顺序要求，

但必须保证不能遗漏某个条件的定义。 

划分网格和导出数据 
(1).划分网格。点击菜单【Meshing】-【Generate】，弹出“Enter 

Value window”对话框，要求定义单元尺寸大小，输入“5”，点击“OK”

按钮，如图 5-19 所示。 

 

定义单元尺寸大小 
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此时弹出“Progress in meshing”进度条，网格划分完毕后弹出消

息框显示总的单元数和节点数，如图 5-20 所示。 

 

 

 

图 5-20 划分网格得到的单元节点信息 

 

点击“OK”按钮后即可得到划分完的网格模型,如图 5-21 所示。

由于中间小孔附近是应力会发生集中的地方，需要进行网格加密以提

高计算精度，点击菜单【Meshing】-【Assign unstruct size】-【line】，
弹出“Enter Value window”对话框，要求定义细分单元尺寸的大小，

输入“0.4”，点击“OK”按钮，选择圆弧，按“ESC”键，弹出确认

对话框，点击“OK”。然后重新生成一下网格，点击【Meshing】-

【Generate】，然后依提示操作，即可得到加密后的网格模型如图 5-22
所示。 
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图 5-21  生成网格模型         图 5-22  加密后网格模型 

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【Files】
-【Save】菜单，保存为GID文件。点击菜单【Calculate】-【Calculate】，
弹出“process info”消息框，如图 5-23 所示，点击“ok”按钮，

然后退出 Gid，至此前处理工作结束。 

 

图 5-23  转化数据消息框 

有限元计算 
(1) 点击菜单选择“计算”—>“弹性力学”—>“二维线弹性平

面应力”，如图 5-24 所示。或者单击工具条中的 按钮弹出如图 5-25
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所示计算模拟窗口。 

 
 

图 5-24  启动有限元计算 

 

 
 

图 5-25  计算模拟窗口 
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5.1.3 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度，不同方式来输出计算结果。 
(1)点击“后处理”—>“弹性力学”—>“二维线弹性平面应力”，

如图 5-26 所示。 

 
图 5-26 进入后处理结果分析 

(2)点击菜单【Files】-【Postprocess】进入后处理程序。 
(3)选择左边工具条中结果显示框架按钮，选择第一个子按钮。

如图 5-27 所示。 

 
图 5-27  结果显示框架 
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(4)点击菜单【Windows】-【Deform mesh】弹出“Mesh Deformation”
对话框，“Main Mesh”中点选“Original”，“Reference Mesh”中点选

“Deformed”、“Use color”项选“off mesh”然后点击“Apply”按钮，

即可在图形区看到变形前后的模型，如图 5-28 所示。 

 
 

图 5-28  变形前后模型 
 

(5)继续在“Reference Mesh”中点选“Off”, 然后点击“Apply”
按钮关闭变形后的构形图。点击“Close”按钮关闭“Mesh Deformation”
对话框。点击菜单【View results】-【Deformation】-【unoda0】可以

看到填充后的变形图。 
(6)点击菜单【View results】-【Contour fill】-【unoda0】-【v】

显示沿 y 方向的位移云图，如图 5-29 所示。 
(7)点击菜单【View results】-【Contour fill】-【unodb0】-【syy】

显示沿 y 方向的正应力场云图，如图 5-30 所示。 
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图 5-29  y 方向位移云图               图 5-30  y 方向应力云图 
(8)对模型边界上的 y 向应力绘图表来表达。点击菜单【View 

results】-【Graphs】-【Border Graph】-【Set X axis】-【X_Variation】，
设定 x 轴变量，如图 5-31a 所示，然后再点击【View results】-【Graphs】
-【Border Graph】-【Set Y axis】-【unobd0】-【syy】，设定 y 轴变量，

如图 5-31b 所示，最后点击【View results】-【Graphs】-【Border Graph】
-【Select Border】，如图 5-32 所示，在图形区选取边界，按“Esc”
键，即可在图形区显示整个边界上的 y 向应力曲线图，如图 5-33 所

示。 
 

 
 

图 5-31a  设定 x 轴变量 
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图 5-31b  设定 y 轴变量 

 
 

图 5-32  选取边界 

 
图 5-33  边界上 y 向应力曲线图 
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5.1.4 相关讨论 

SciFEA 是一个非常灵活的系统，能很方便的对已完成的有限元

模型作一些修改，如改变加载方式、约束方式、材料模型等等。下面

就在本章例题的基础上作一些简单的变化来说明 SciFEA 的灵活性。 
5.1.4a 考虑板的自重情况 

(1) 如图 5-34 所示重新将材料参数填写成如下形式（假设密度为

7.8e-6kg/mm-3） 

 
图 5-34  重新填写材料参数 

(2) 从选择前处理开始的其他各步骤完全一样。 
(3)后处理结果分析如下。变形前后模型如图 5-35 所示，y 方向

位移云图如图 5-36 所示。 
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图 5-35  变形前后模型 

 
图 5-36  y 向位移云图 
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5.1.4b 改变加载方式 
例题中板受一均布载荷的作用，如果平板在某点承受一集中力，

那么如何实现这种加载呢？我们直接在 5.1.2 节的算例基础上进行修

改，使例题所示平板在右上角垂直方向受一个 300N 大小的集中力的

作用，计算相应的变形和应力。具体步骤如下。 

(1)点击 按钮直接进入【GID】。 

(2)重新定义 condition 如下，材料和约束条件不变，点击“点单元”

按钮，在“point_eliso2da”栏目中填入“u－I”为“1”，“u－D”为

“0”，“v－I”为“1”，“v－D”为“300”，并“Assign”给右上角点，

如图 5-37 所示。 
(3)然后进行保存计算，与前面的例题相同，这里就不再详细叙述

了，结果显示如图 5-38 所示。 

 
图 5-37  施加点载荷 
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图 5-38 y 方向位移云图 
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5.2 三维空间问题 

5.2.1 问题描述 

本节以一个具体的三维固体力学线弹性问题――铁块的拉伸，

来详细说明 FEPG 系统求解此类问题的方法和步骤。 
此问题描述如下：对如图 5-39 所示的承受拉伸载荷正方体铁块

进行线弹性分析。正方体块边长 100mm，底部固定，上面施加 100N
的均布载荷，块的材料特性如下：杨氏模量 200000N/mm2，泊 松 比
0.3，密度 7.8³10-6Kg/mm3，研究块的受力和变化情况。 

 

 
图 5-39  铁块拉伸几何模型 
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5.2.2 求解步骤 

选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 5-40 所示的对话框。 

 
 

图 5-40  选择项目类型对话框 

 

(2)点击“问题类型”栏中的“三维空间问题”选项。如图 5-40
所示。 

(3)点击“OK”按钮完成项目类型的选择。 

设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 5-41 所示，或者

单击工具条中的 按钮弹出如图 5-42 所示材料参数数据输入表格。 
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图 5-41  选择材料参数 

 

 

 

图 5-42  材料参数输入对话框 

 

(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 5-43 所示。 
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图 5-43  填写完成材料数据输入 

 

(3) 选择“前处理”—>“边界条件”按钮，如图 5-44 所示。或

者单击工具条中的 按钮弹出如图 5-45 所示数据输入表格。 

 
 

图 5-44  选择边界条件输入 
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图 5-45  边界条件输入对话框 

 

(4)按照问题描述中的参数依次填入边界条件数据表格。填写完

成后如图 5-46 所示。对本问题施加一法向力即可，负号表示受拉。 

 
 

图 5-46  填写完成边界条件输入 

 

建模、设置材料属性和施加边界条件 
(1) 启动 GID 以创建模型。点击菜单选择“前处理”—>“弹性

力学”—>“三维空间”，如图 5-47 所示；或者单击工具条中的 按

钮，均弹出如图 5-48 所示前处理初始化窗口。 
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图 5-47  启动前处理 

 
图 5-48 前处理初始化窗口 

 进入前处理器 GID 后按照问题描述中的尺寸进行几何建模，

分步骤如下： 
a.点击菜单【Geometry】-【Create】-【Object】-【Rectangle】，

在命令栏依次输入点坐标：0,0，按 Enter 键，输入 100,100, 按 Enter
键，接着按 Esc 键，点击菜单【Utilities】-【Copy】，弹出对话框，

按图 5-49 修改对话框，改“Entities type”为“Surfaces”，改“Second 
point”中“z”坐标为 100，改“Do extrude”为“Volumes”，然后，
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点击“Select”按钮，选择建好的面，再点击“Copy”对话框中的“Finish”
按钮，模型就建好了。旋转模型，得到图 5-50。 

       
图 5-49 Copy 对话框       图 5-50 模型 

b.选择问题类型。点击菜单【Data】-【Problem Type】-【SCI】，
弹出“Dialog Window”，点击“确定”按钮即可。 

c.定义材料特性、施加载荷约束。点击菜单【Data】-【Conditions】
弹出“Conditions”对话框如图 5-51 所示。 

① 定义材料。点击表示体单元的按钮 ，选中下拉菜单中的

“Volume－aew4”，在“mate Num”（即 Material Number）中填入“1”，
点击“Assign”选择生成的体，点击“Finish”即定义好材料特性。

用户可以点击菜单【Draw】-【Colors】来观察是否已经定义成功。

如图 5-52 所示。  
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图 5-51Conditions 对话框            图 5-52  定义材料属性并检查 

②施加载荷。点击面单元按钮 ，选中下拉菜单中的

“Surface-alt3”，在“mate Num”中填入“1”，点击“Assign”按钮，

选择上端要施加载荷的面，如图 5-53 所示。然后，点击 Conditions

对话框中的 Finish 按钮。 
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图 5-53  施加载荷 

 

③定义约束。在下拉框中选择“Surface-eliso3da”，保持“u-I，
v-I,w-I”项的值为“-1”，保持“u-D，v-D，w-D”都为“0”不变，

点击“Assign”按钮，选择要定义约束的下边界，如图 5-54 所示。 
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    图 5-54 定义约束条件 

 
用户可以单击菜单【Draw】-【Colors】来观察是约束条件否已经定

义成功。如图 5-55 所示。 

        
图 5-55  定义约束位移 
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需要说明的是，这几步定义材料，施加载荷的操作没有先后顺序

要求，但要保证不能遗漏某个条件的定义。 

划分网格和导出数据 
(1).划分网格。点击【Meshing】-【Generate】弹出“Enter Value 

window”对话框，要求定义单元尺寸大小，保持默认值，点击“ok”，
如图 5-56 所示。 

 

图 5-56  保持单元大小默认值不变 

此时弹出“Progress in meshing”进度条，网格划分完毕后弹出消

息框显示总的单元数和节点数，如图 5-57 所示。 

 
Dialog window 
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点击“ok”按钮后即可得到划分完的网格模型。单击【Meshing】
-【Boundaries】,系统弹出对话框，选择“Yes”；单击鼠标右键，

选择“Render”->“Filled”得到如图 5-58 所示网格剖分图。 

 
生成网格模型 

（2）.把前处理数据转化为 SciFEA 所需计算格式。点击

【Files】-【Save】菜单，保存为 GID 文件。点击菜单【Calculate】

-【Calculate】，弹出“process info”消息框，如图 5-59 所示，

点击“ok”按钮，然后退出 Gid，至此前处理工作结束。 

 

图 5-59  转化数据消息框 
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有限元计算 
(1) 点击菜单选择“计算”—>“弹性力学”—>“三维空间”，如图

5-60 所示。 

 
图 5-60  启动有限元计算 

或者单击工具条中的 按钮弹出如图 5-61 所示计算模拟窗口。 

 
图 5-61  计算模拟窗口 
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5.2.3 结果分析 

(1)点击 按钮直接进入【GID】。 

(2)点击菜单【File】-【Postprocess】进入后处理程序。 
(3)点击菜单【View results】-【Deformation】-【unoda0】，即可

在图形区看到变形后的模型，如图 5-62 所示。 
(4)点击菜单【View results】-【Contour fill】-【unoda0】-【w】

显示沿 z 方向的位移云图，如图 5-63 所示。 
(5)点击菜单【View results】-【Contour fill】-【unodb0】-【szz】

显示沿 z 方向的应力场云图，如图 5-64 所示。 
 

 
图 5-62  变形后模型 
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图 5-63  z 方向位移云图 

 
图 5-64  z 方向应力云图 
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5.3.1 问题描述 

5.3.2 求解步骤 
5.3.3 选择项目 

(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 5-3-1 所示的对话框。 
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图 5-3-1 选择项目类型对话框 

(2)点击“问题类型”栏中的“二维弹性平面应力”选项。如图

5-3-1 所示。 

(3)点击“OK”按钮完成项目类型的选择。 

5.3.4 设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 5-3-2 所示。或

者单击工具条中的 按钮弹出如图 5-3-3 所示材料参数数据输入表

格。 

 
图 5-3-2  选择材料参数输入 
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图 5-3-3  材料参数输入对话框 

 

(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 5-3-4 所示。 

 
图 5-3-4  填写完成材料数据输入 

 

(3) 选择“前处理”—>“边界条件”按钮，如图 5-3-5 所示。

或者单击工具条中的 按钮弹如图 5-3-6 所示数据输入表格。 
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图 5-3-5  选择边界条件输入 

 
图 5-3-6  边界条件输入对话框 

(4)按照问题描述中的参数依次填入边界条件数据表格。填写完

成后如图 5-3-7 所示。对本问题施加一法向力即可，负号表示受拉。 
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图 5-3-7  填写完成边界条件输入 

5.3.5 建模、设置材料属性和施加边界条件 
(1) 启动 GID 以创建模型。点击菜单选择“前处理”—>“弹性

力学”—>“二维弹性平面应力”，如图 5-3-8 所示。 

 
图 5-3-8  启动前处理 
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或者单击工具条中的 按钮弹出前处理初始化窗口。 

(2) 建模。通过对几何模型进行分析，可以根据对称性取 1/4 部

分进行简化。 
 点击菜单【Geometry】-【Create】-【Line】，在命令栏依次输

入点坐标:生成平板的外边界如图 5-3-9 所示。 
 

    
图 5-3-9  生成平板外边界 
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(3).选择问题类型。点击菜单【Data】-【Problem Type】-【SCI】，
弹出“Dialog Window”，点击“确定”按钮即可。 

(4).定义材料特性、施加载荷约束。点击菜单【Data】-【Conditions】
弹出“Conditions”对话框如图 5-3-10 所示。 

① 点击表示面单元的按钮 ，选中下拉菜单中的“line-eliso2d”，
点击“Assign”，选择生成的面，点击“Finish”即定义好材料特性。

用户可以点击菜单【Draw】-【Colors】来观察是否已经定义成功。

如图 5-3-11 所示。 

 
图 5-3-11 

②点击线单元按钮 ，选中下拉菜单中的“Line-all2”，在“mate 
Num”中填入“1”，点击“Assign”按钮，选择上端要施加载荷的边，

如图 5-3-12 所示。然后，点击 Conditions 对话框中的 Finish 按钮。 
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图 5-3-12  施加载荷 

 

③点击表示面单元的按钮 ，最后得到如图 5-3-13: 
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     图 5-3-13 定义约束条件 
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5.3.5 划分网格和导出数据 
(1).划分网格。点击菜单【Meshing】-【Generate】，弹出“Enter 

Value window”对话框，要求定义单元尺寸大小，输入“0.2”，点击

“OK”按钮，如图 5-3-13 所示。 

 

图 5-3-13 定义单元尺寸大小 

此时弹出“Progress in meshing”进度条，网格划分完毕后弹出消

息框显示总的单元数和节点数，如图 5-3-14 所示。 

 

图 5-3-14 划分网格得到的单元节点信息 
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点击“OK”按钮后即可得到划分完的网格模型,如图 5-3-15 所示。 

                

 

图 5-3-15  生成网格模型                             

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【Files】
-【Save】菜单，保存为GID文件。点击菜单【Calculate】-【Calculate】，
弹出“process info”消息框，如图 5-3-16 所示，点击“ok”按钮，

然后退出 Gid，至此前处理工作结束。 
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图 5-3-16  转化数据消息框 

5.3.6 有限元计算 
(1) 点击菜单选择“计算”—>“弹性力学”—>“二维线弹性平

面应力”，如图 5-3-17 所示。或者单击工具条中的 按钮弹出如图

5-3-18 所示计算模拟窗口。 

 
图 5-3-19 启动有限元计算 
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图 5-3-20  计算模拟窗口 

5.3.7 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度，不同方式来输出计算结果。 
(1)点击“后处理”—>“弹性力学”—>“二维线弹性平面应力”，

如图 5-3-21 所示。 
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图 5-3-21 进入后处理结果分析 
 

(2)点击菜单【Files】-【Postprocess】进入后处理程序。 
(3)点击菜单【View results】-【Contour fill】-【unoda0】-【v】

显示沿 y 方向的位移云图，如图 5-3-22 所示。 
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图 5-3-23  y 方向位移云图 
 

(7)点击菜单【View results】-【Contour fill】-【unodb0】-【syy】
显示沿 y 方向的正应力场云图，如图 5-3-24 所示。 
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                        图 5-3-24 y 方向应力云图 
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5.4.1 问题描述 

5.4.2 求解步骤 

5.4.3 选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 5-3-25 所示的对话框。 

 

图 5-3-26 选择项目类型对话框 
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(2)点击“问题类型”栏中的“二维弹性平面应变”选项。如图

5-3-26 所示。 

(3)点击“OK”按钮完成项目类型的选择。 

 

5.4.4 设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 5-3-27 所示，或

者单击工具条中的 按钮弹出如图 5-3-28 所示材料参数数据输入表

格。 

 
 

图 5-3-27  选择材料参数 
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图 5-3-28  材料参数输入对话框 

 

(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 5-3-29 所示。 

 
 

图 5-3-29  填写完成材料数据输入 

 

(3) 选择“前处理”—>“边界条件”按钮，如图 5-3-30 所示。

或者单击工具条中的 按钮弹出如图 5-3-31 所示数据输入表格。 
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图 5-3-30  选择边界条件输入 

 

  

 
图 5-3-31 边界条件输入对话框 

 

(4)按照问题描述中的参数依次填入边界条件数据表格。填写完

成后如图 5-3-32 所示。对本问题施加一法向力即可，负号表示受拉。 
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图 5-3-32  填写完成边界条件输入 

 

5.4.5 建模、设置材料属性和施加边界条件 
(1) 启动 GID 以创建模型。点击菜单选择“前处理”—>“弹性

力学”—>“二维线弹性平面应变”，如图 5-3-33 所示；或者单击工

具条中的 按钮，均弹出前处理初始化窗口。 

 
图 5-3-33  启动前处理 
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 进入前处理器GID后按照问题描述中的尺寸进行下几何建模，

最后得到模型图 5-3-34 如下： 
     

 
图 5-3-34 模型 

b.选择问题类型。点击菜单【Data】-【Problem Type】-【SCI】，
弹出“Dialog Window”，点击“确定”按钮即可。 

c.定义材料特性、施加载荷约束。点击菜单【Data】-【Conditions】
弹出“Conditions”对话框。 
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① 定义材料。点击表示体单元的按钮 ，选中下拉菜单中的

“lineelso2dea，在当中填入数据，点击“Assign”选择好线，点击

“Finish”,用户可以点击菜单【Draw】-【Colors】来观察是否已经定

义成功。如图 5-3-35 和图 5-3-36 所示。  

 
 

                     图 5-3-35  定义材料属性并检查 
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图 5-3-36 

 

②施加载荷。点击面单元按钮 ，选中下拉菜单中的

“Surface-aet3”，在“mate Num”中填入“1”，点击“Assign”按钮，

选择上端要施加载荷的面，如图 5-3-37 所示。然后，点击 Conditions

对话框中的 Finish 按钮。 
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图 5-3-38  施加载荷 

 

5.4.6 划分网格和导出数据 
(1).划分网格。点击【Meshing】-【Generate】弹出“Enter Value 

window”对话框，要求定义单元尺寸大小，保持默认值，点击“ok”，
如图 5-3-39 所示。 
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图 5-3-39  保持单元大小默认值不变 
 

此时弹出“Progress in meshing”进度条，网格划分完毕后弹出消

息框显示总的单元数和节点数，如图 5-3-40 所示。 

 

图 5-3-40  Dialog window 

点击“ok”按钮后即可得到划分完的网格模型。得到如图 5-3-41
所示网格剖分图。 



 103 

 

图 5-3-41 生成网格模型 

（2）.把前处理数据转化为 SciFEA 所需计算格式。点击

【Files】-【Save】菜单，保存为 GID 文件。点击菜单【Calculate】

-【Calculate】，弹出“process info”消息框，如图 5-3-42 所

示，点击“ok”按钮，然后退出 Gid，至此前处理工作结束。 
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图 5-3-42 转化数据消息框 

5.4.7 有限元计算 
(1) 点击菜单选择“计算”—>“弹性力学”—>“二维弹性平面应力”，

如图 5-3-43 所示。 

 
图 5-3-43  启动有限元计算 

或者单击工具条中的 按钮弹出如图 5-3-44 所示计算模拟窗口。 
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图 5-3-44  计算模拟窗口 

5.4.8 结果分析 

(1)点击 按钮直接进入【GID】。 

(2)点击菜单【File】-【Postprocess】进入后处理程序。 
(3)点击菜单【View results】-【Contou Fill】-【unoda0】-【u】，

即可在图形区看到变形后的模型，如图 5-3-45 所示。 
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图 5-3-45 

 
图 5-3-46 
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第6章 热传导问题 

6.1 二维热传导问题 

6.1.1 问题描述 

这里我们通过一个热传导问题来详细说明 SciFEA 解决此类问题

的操作步骤。 

此问题描述如下：一个长方形截面的冷空气通道的尺寸如下图

6-1 所示。假设在垂直于纸面的方向上，冷空气及通道墙壁的温度变

化很小，可以忽略。通道的导热系数是 0.044；内壁温度维持在 0 度，

外壁温度维持在 30 度，求通道壁面中的温度分布。 

1.
2m

2m

2.
2m

3m
 

图 6-1-1  冷空气通道 
该问题的偏微分方程及其边值条件如下：    

是上面的冷空气通道 ,)*( inequek , 

的内壁，是区域 11,0|
1

onu  

的外壁。是区域 22 ,30|
2

onu  
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6.1.2 求解步骤 

选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 6-1-2 所示的对话框。 

 

图 6-1-2  选择项目类型对话框 

(2)点击“问题类型”栏中的“二维稳态传热”选项。如图 6-1-2
所示。 

(3)点击“OK”按钮完成项目类型的选择。 

设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 6-1-3 所示。或

者单击工具条中的 按钮弹出如图 6-1-4 所示材料参数数据输入表



 109 

格。 

 
 

图 6-1-3  选择材料参数输入 

 

 
图 6-1-4  材料参数输入对话框 

(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 6-1-5 所示。 
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图 6-1-5  填写完成材料数据输入 

 
(3) 选择“前处理”—>“边界条件”按钮，如图 6-1-6 所示。

或者单击工具条中的 按钮弹如图 6-1-7 所示数据输入表格。 

 
 

图 6-1-6  选择边界条件输入 
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图 6-1-7  边界条件输入对话框 

 
(4)按照问题描述中的参数依次填入边界条件数据表格。填写完

成后如图 6-1-8 所示。 

 
 

图 6-1-8  填写完成边界条件输入 

 

建模、设置材料属性和施加边界条件 
(1) 启动 GID 以创建模型。点击菜单选择“前处理”—>“传热”

—>“二维传热”，如图 6-1-9 所示；或者单击工具条中的 按钮弹出

如图 6-1-10 所示前处理初始化窗口。 
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图 6-1-9  启动前处理 

 

 
 

图 6-1-10 前处理初始化窗口 
 

 (2) 建模。 
a. 如下图 6-1-11 所示，点击【Geometry】—【Create】—【Line】, 
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图 6-1-11 点击 Line 菜单项 

 

如下图 6-1-12，6-1-13 所示，在 GID 命令栏中先输入 0,0，按 ENTER

键，然后输入 0,0.5，按 ENTER 键。 

              

图 6-1-12 输入 0,0                 图 6-1-13  输入 0,0.5 

 

 

如下图 6-1-14，6-1-15 所在 FEPG.GID 命令栏中再输入 0,1.7，

按 ENTER 键，然后输入 0,2.2，按 ENTER 键。这样我们产生了三条线

段。 
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图 6-1-14 输入 0,1.7                  图 6-1-15 输入 0,2.2 

 

如下图 6-1-16 所示，点击【Utilities】—【Copy】菜单项，将

出现如下图 6-1-17 所示的 Copy 对话框。 

      
  图 6-1-16 点击 Copy 菜单项                 图 6-1-17 Copy 对话框 

如下图 6-1-18 所示，在 Copy 对话框中，Entities type 项中选

中 Lines。如下图 6-1-19 所示，在 Copy 对话框中，Second Point

项中的 x坐标改为 0.5。 

         

图 6-1-18 选中 Line                    图 6-1-19 

如下图 6-1-20 所示，在 Copy 对话框中，Do extrude 项中，选中

Surfaces。 



 115 

 

图 6-1-20 选中 Surfaces 

点击 Copy 对话框中的 Select 按钮，选中上面产生的三条线段，

按 Esc 键。我们将产生如下图 6-1-21 所示的三个长方形。 

 
图 6-1-21  三个长方形 

在 Copy 对话框中，将 Second Point 项中的 x坐标改为 2.0。点

击 Copy 对话框中的 Select 按钮，然后选中上面产生的三个长方形的

右边三条竖直的线段(注意，选中的线段将变成红色线，未选中的线

段是蓝色的，不要多选线段)，选择完后，按 Esc 键。我们将有如下

图 6-1-22 所示的六个长方形。 
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图 6-1-22  六个长方形 

在 Copy 对话框中，将 Second Point 项中的 x坐标改为 0.5。点

击 Copy 对话框中的 Select 按钮，然后选中六个长方形的最右边三条

竖直的线段，选择完后，按 Esc 键。我们将有如下图 6-1-23 所示的

九个长方形。 

 

图 6-1-23  九个长方形 
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如下图 6-1-24 所示，点击【Geometry】—【Delete】—【Surface】

菜单项，选中九个长方形中间的那个长方形，选择完后，按 Esc 键。 

 

图 6-1-24 点击 Surface 菜单项 

如下图 6-1-25 所示，我们的模型就建好了。点击 Copy 对话框中的

Cancel 按钮，关闭 Copy 对话框。 

 

图 6-1-25  模型 

b.选择问题类型。如图 6-1-26 所示，点击菜单【Data】-【Problem 
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Type】-【SCI】，将弹出如图 6-1-27 所示对话框，点击“确定”按钮

即可。 

  
图 6-1-26 选 FEPG          图 6-1-27 Dialog Window 

 

c.定义材料特性、边界条件。如图 6-1-28 点击【Data】—

【Conditions】， 弹出如图 6-1-29 的 Conditions 对话框。 

① 定义材料。点击其中的 ，加入关于面的条件，如材料号、初

值、边值等，点击如图 6-1-29 所示的 Conditions 对话框中的下拉菜

单，选中 Surface-aet3，然后点击 Conditions 对话框中的 Assign

按钮，选中整个区域，然后，点击 

Conditions 对话框中的 Finish 按钮。这样，面材料号施加完毕。 

                   
图 6-1-28                          图 6-1-29 

②定义边界条件。如下图 6-1-30 所示，点击 Conditions 对话框

中的 ，加入关于线的条件，如材料号、初值、边值等。如图 6-1-30

所示，选择 line- fouri2da，然后点击图 6-1-30 中的 Assign 按钮，
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然后设 u-1 为-1,u-D 为 0，选中区域所有的内边界（共 4条边）。然

后，点击 Conditions 对话框中的 Finish 按钮。 

 

 
 

图 6-1-30 Conditions 

 

点击 Conditions 对话框中的下拉菜单，选中 line- fouri2da，修改

如图 6-1-31 所示 Conditions 对话框中的 u-1 为-1,u-D 为 30, 然后

点击图 6-1-31 中的 Assign 按钮，施加边值是 30 的边，选中区域所

有的外边界（共 12 条边）。然后，点击 Conditions 对话框中的 Finish

按钮。这样，边上的 line- fouri2da 施加完毕。点击 Conditions

对话框中的 Close 按钮。到此，关于材料号和边值条件的施加已完成。 
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图 6-1-31 Conditions 

 

划分网格和导出数据 
(1).划分网格。点击菜单【Meshing】-【Generate】，弹出“Enter 

Value window”对话框，要求定义单元尺寸大小，输入“0.2”，点击

“ok”按钮，如图 6-1-32 所示。 

 

图 6-1-32 定义单元尺寸大小 

此时弹出“Progress in meshing”进度条，网格划分完毕后弹出消

息框显示总的单元数和节点数，如图 6-1-33 所示,点 OK。 
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图 6-1-33  消息框 

(2).把前处理数据转化为 SciFEA 所需计算格式。点击

【Files】-【Save】菜单，保存为 GID 文件。点击菜单【Calculate】

-【Calculate】，弹出“process info”消息框，如图 6-1-34 所

示，点击“ok”按钮，然后退出 Gid，至此前处理工作结束。 

 

图 6-1-34 转化数据消息框 
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有限元计算 
(1) 点击菜单选择“计算”—>“传热”—>“二维传热”，如图

6-1-35 所示，或者单击工具条中的 按钮弹出如图 6-1-36 所示计算

模拟窗口。 

 
图 6-1-35  启动有限元计算 

 
图 6-1-36 计算模拟窗口 
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6.1.3 结果分析 
对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度，不同方式来输出计算结果。 
(1) 点击“后处理”—>“传热”—>“二维传热”，如图 6-1-37

所示。 

 
图 6-1-37 进入后处理结果分析 

(2)点击 按键，然后再点菜单【View results】-【Contour fill】
-【unoda0】，显示最后一个时间步温度场云图分布，如图 6-1-38 所示。 

 

图 6-1-38 温度场云图分布 
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6.2 型材瞬态传热过程分析 

6.2.1 问题描述 

    有一横截面为矩形的各向同性型材,如图 6-2-1 所示。其初始温度

为 500℃，现突然将其置于温度为 20℃的空气中，求 1分钟后该型材

的温度场分布及其中心温度随时间的变化规律，材料性能参数如表

6-2-1 所示。 

 

图 6-2-1  型材横截面示意图 

表 6-2-1 

密度    ㎏/m
3 

导热系数 

W/（m²℃） 

比热 C 

J/（㎏²℃） 

对流系数 

W/(㎡²℃) 

2400 30 352 110 

6.2.2 问题分析 

该问题属于瞬态热传导问题。由于材料沿长度方向的尺寸远大于

其他两个方向上的尺寸，将其简化为平面问题。在分析过程中到型材

横截面的 1/4 建立几何模型。 
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6.2.3 求解步骤 

选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 6-2-2 所示的对话框。 

 

图 6-2-2 选择项目类型对话框 

(2)点击“问题类型”栏中的“二维瞬态传热”选项，在项目名

称栏中输入该项目的名称，如“pingban”。如图 6-2-2 所示。 

(3)点击“OK”按钮完成项目类型的选择。 

设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 6-2-3 所示。或

者单击工具条中的 按钮弹出如图 6-2-4 所示材料参数数据输入表

格。 
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图 6-2-3 选择材料参数输入 

 

图 6-2-4 材料参数输入对话框 
(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 6-2-5 所示。                 

 
图 6-2-5 填写完成材料数据输入 

(3)选择“前处理”—>“边界条件”按钮，如图 6-2-6 所示。或

者单击工具条中的 按钮弹如图 6-2-7 所示数据输入表格。 
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图 6-2-6 选择边界条件输入           图 6-2-7  边界条件输入对话框 

 
按照问题描述中的参数依次填入边界条件数据表格。填写完成

后如图 6-2-8 所示。 

 
 

图 6-2-8 填写完成边界条件输入 

 

建模、设置材料属性和施加边界条件 
(1) 启动 GID 以创建模型。点击菜单选择“前处理”—>“传热”

—>“二维瞬态传热”，如图 6-2-9 所示。 
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图 6-2-9 启动前处理 

或者单击工具条中的 按钮弹出前处理初始化窗口。 

(2) 建模。a. 如下图 6-2-10 所示，点击【Geometry】—【Create】

—【Line】, 

 
 

图 6-2-10 点击 Line 菜单项 

 

然后在 GID 命令栏依次输入点坐标：0,0，按 ENTER 键，输入 0.2,0,

按 ENTER，输入 0.2,0.1，按 ENTER 键，输入 0,0.1,按 ENTER 键，输

入 0,0.1,按 ENTER,输入 0,0,按 ENTER，接着按 Esc 键，最后得到模

型如图 6-2-11： 
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图 6-2-11 模型 

b.选择问题类型。如图 6-2-12 所示，点击菜单【Data】-【Problem 
Type】-【SCI】，将弹出如图 6-2-13 所示对话框，点击“确定”按钮

即可。 
 

  
图 6-2-12 选 SCI            图 6-2-13 Dialog Window 

 

c.定义材料特性、边界条件。如图 6-2-14 点击【Data】—

【Conditions】， 弹出 Conditions 对话框。 
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图 6-2-14 

 
如下图所示，点击 Conditions 对话框中的 ，选择 Line-all2,

然后设置 mat Num 的值为 1；最后点击 Assign 按钮，分别选中区域

中的两边。然后，点击 Conditions 对话框中的 Finish 按钮，最后结

果如图 6-2-15。 

 

图 6-2-15 



 131 

然后再选择 当中的 surface-D1fourt2da,设置 u-D1 值为 500，

作为温度初始值，如图 6-2-16 所示。 

 

图 6-2-16 

然后再选择 当中的 Surface-aet3，设置 mate Num 栏材料代号

为 1，如图 6-2-17 所示。 
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图 6-2-17 

 

划分网格和导出数据 
(1).划分网格。点击菜单【Meshing】-【Generate】，弹出“Enter 

Value window” 

对话框，要求定义单元尺寸大小，输入“0.01，点击“ok”按钮，如

图 6-2-18 所示。 

 
图 6-2-18 定义单元尺寸大小 

此时弹出“Progress in meshing”进度条，网格划分完毕后弹
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出消息框显示总的单元数和节点数，如图 6-2-19 所示,点 OK。 

 

图 6-2-19 消息框 

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【Files】

-【Save】菜单，保存为 GID 文件。点击菜单【Calculate】-【Calculate】，

弹出“process info”消息框，如图 6-2-20 所示， 

点击“OK”按钮，然后退出 Gid，至此前处理工作结束。 

 
图 6-2-20 转化数据消息框 

6.2.4 有限元计算 

点击菜单选择“计算”—>“传热”—>“二维瞬态传热”，如图

6-2-21 所示。或者单击工具条中的 按钮弹出如图 6-2-22 所示计算
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模拟窗口。 

 
 

图 6-2-21  启动有限元计算 

 

 
 

图 6-2-22 计算模拟窗口 
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6.2.5 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度，不同方式来输出计算结果。 
(1)点击“后处理”—>“传热”—>“二维瞬态传热”，如图 6-2-23

所示。 

 
 

图 6-2-23 进入后处理结果分析 

(2)点击 按键，然后再点菜单【View results】-【Contour fill】
-【unoda0】，显示最后一个时间步温度场云图分布，如图 6-2-24 所示。 
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图 6-2-24 

6.3 三维瞬态传热 

6.3.1 问题描述 

     图 6-3-1 所示为一带轮的零件图及结构示意图(图中长度单位为

mm)。带轮材料的热性能参数如表 6-3-1所示。带轮的初温度为 500℃,

将其突然放入温度为 0℃的水中,水的对流系数为 110W/(㎡²℃).求

解: 

     (1)1 分钟及 5分钟后带轮的温度场分布。 

     (2)零件图上 A、B、C、D、E 各点温度随时间变化关系。B、E

两点距中心轴的距离 125OBL mm ， 350OEL mm 。 

表 6-3-1  带轮材料热性能参数 

密度㎏/m3 导热系数 W/(m²℃) J(㎏²℃) 

2400 70 328 
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图 6-3-1 

问题分析 

该问题属于瞬态热分析问题。选取如图 6-3-1 所示的部分带轮作为几何模

型，在建模过程中采用国际单位制。 

6.3.2 求解步骤 

选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 6-3-2 所示的对话框。 
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图 6-3-2 选择项目类型对话框 

(2)点击“问题类型”栏中的“三维瞬态传热”选项。如图 6-3-2
所示。 

(3)点击“OK”按钮完成项目类型的选择。 

 

设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 6-3-3 所示。或

者单击工具条中的 按钮弹出如图 6-3-4 所示材料参数数据输入表

格。 
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图 6-3-3 选择材料参数输入 

 

 
 

图 6-3-4 材料参数输入对话框 

 
(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 6-3-5 所示。                 
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图 6-3-5 填写完成材料数据输入 

 

(2)选择“前处理”—>“边界条件”按钮，如图 6-3-6 所示。或

者单击工具条中的 按钮弹如图 6-3-7 所示数据输入表格。 

 
图 6-3-6  选择边界条件输入 
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图 6-3-7  边界条件输入对话框 

 
按照问题描述中的参数依次填入边界条件数据表格。填写完成

后如图 6-3-8 所示。 
 

 
 

图 6-3-8  填写完成边界条件输入 

 

建模、设置材料属性和施加边界条件 
(1) 启动 GID 以创建模型。点击菜单选择“前处理”—>“传热”

—>“三维瞬态传热”，如图 6-3-9 所示。 
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图 6-3-9 启动前处理 

或者单击工具条中的 按钮弹出前处理初始化窗口。 

(2) 建模。 
a. 如下图 6-3-10 所示，点击【Geometry】—【Create】—【Line】, 

 

 
 

图 6-3-10 点击 Line 菜单项 

然后在GID命令栏依次输入点坐标：0.1,0，按 ENTER键；输入0.15,0,

按 ENTER；输入 0.15,0.125，按 ENTER 键；输入 0.175,0.15,按 ENTER

键；输入 0.3,0.15,按 ENTER；输入 0.325,0.125,按 ENTER 键；输入

0.325,0.05,按 ENTER 键；输入 0.375,0.05，按 ENTER 键；输入



 143 

0.375,0.375，按 ENTER 键；输入 0.325,0.375，按 ENTER 键；输入

0.325,0.25，按 ENTER 键；输入 0.3,0.225，按 ENTER 键；输入

0.175,0.225，按 ENTER 键；输入 0.15,0.25，按 ENTER 键；输入

0.15,0.5，按 ENTER 键；输入 0.1,0.5，按 ENTER 键；输入 0.1,0，

按 ENTER 键，接着按 Esc 键。然后再点 ，如图 6-3-11 然后设置

Entities  type 为 lines；Second  point 中的 z 值为 0.05；Do  extrude
为 Surfaces；最后得到模型如图 6-3-12： 

         
 

图 6-3-11                 图 6-3-12 模型 

 

b.选择问题类型。如图 6-3-13 所示，点击菜单【Data】-【Problem 
Type】-【SCI】，将弹出如图 6-3-14 所示对话框，点击“确定”按钮

即可。 
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图 6-3-13 选 SCI         图 6-3-14 Dialog Window 

 

c.定义材料特性、边界条件。如图 6-3-15 点击【Data】—

【Conditions】， 弹出 Conditions 对话框。 

 

 

图 6-3-15 
 

定义面边界条件：点击 Conditions 对话框中的 ，选择 surface  

D1fourt3da,然后设置 u-D1 框数值为 500。最后点击图中的 Assign

按钮，选中整个图型，最后点击 Conditions 对话框中的 Finish 按钮，

最后结果如图 6-3-16； 

定义面材料属性：选择 Surface-alt3，设置材料参数 mate Num

值为 1，最后得到如图 6-3-17。 
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图 6-3-16                       图 6-3-17 

定义体初始条件：点击 Conditions 对话框中的 ，选中

volume-D1fourt3da，设置 u-D1 框的数值为 500，然后点击图中的

Assign 按钮，选中区域所有的边界，然后点击 Conditions 对话框中的

Finish 按钮。点击 Conditions 对话框中的 Close 按钮,最后结果如图

6-3-18。 

 

图 6-3-18 
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定义体材料属性：然后再选择 Volume-aew4，设置 mate Num 框数

值为1，点击Assign键后，选中所有区域，点击Finish键，如图6-3-19

所示。 

 
图 6-3-19 

 

划分网格和导出数据 
(1).划分网格。点击菜单【Meshing】-【Generate】，弹出“Enter Value 

window” 

对话框，要求定义单元尺寸大小，输入“0.025，点击“ok”按钮，

如图 6-3-20 所示。 

 
图 6-3-20 定义单元尺寸大小 
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此时弹出“Progress in meshing”进度条，网格划分完毕后弹出消

息框显示总的单元数 1656 和节点数 502，如图 6-3-21 所示,点“OK”

按钮确认。 

 

图 6-3-21 消息框 

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【Files】-

【Save】菜单，保存为 GID 文件。点击菜单【Calculate】-【Calculate】，

弹出“process info”消息框，如图 6-3-22 所示， 

点击“OK”按钮确认，然后退出 Gid，前处理工作至此结束。 

 
图 6-3-22 转化数据消息框 
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6.3.3 有限元计算 

点击菜单选择“计算”—>“传热”—>“三维瞬态传热”，如图

6-3-23 所示；或者单击工具条中的 按钮弹出如图 6-3-24 所示计算

模拟窗口。 

 
图 6-3-23  启动有限元计算 

 
图 6-3-24 计算模拟窗口 
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6.3.4 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度，不同方式来输出计算结果。 
(1)点击“后处理”—>“传热”—>“三维瞬态传热”，如图 6-3-25

所示。 

 
图 6-3-25 进入后处理结果分析 

(2)点击 按键，然后再点菜单【View results】-【Contour fill】
-【unoda0】，显示最后一个时间步温度场云图分布，如图 6-3-26 所示。 
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图 6-3-26 
 

6.4 轴对称瞬态传热 

6.4.1 问题描述 

一个直径为 0.12m，温度为 900℃的钢球突然放入盛满了水的、

完全绝热的横截面直径和高度为 0.6m 的圆柱体水箱中,水的温度为

20℃,材料参数如表 6-4-1 所示.求解 10 分钟后钢球与水的温度场分

布(忽略水的流动,钢球置于水箱正中央)。 

表 6-4-1 材料性能参数 

材料 

密度      

3/kg m  

导热系数 K 

W/(M²℃) 

比热 C 

J/(㎏²℃) 

水 1000 0.61 4185 

钢 7800 70 448 
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问题分析 

该问题属于瞬态热传导问题.研究对象为钢球和水,根据轴对称性,在

求解过程中取钢球和水中心纵截面的确 1/4 建立几何模型,并选择轴

对称单元进行分析求解。 

6.4.2 求解步骤 

选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 6-4-1 所示的对话框。 

 

图 6-4-1 选择项目类型对话框 



 152 

(2)点击“问题类型”栏中的“轴对称瞬态传热”选项。如图 6-4-1
所示。 

(3)点击“OK”按钮完成项目类型的选择。 

设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 6-4-2 所示。或

者单击工具条中的 按钮弹出如图 6-4-3 所示材料参数数据输入表

格。 

 
图 6-4-2 选择材料参数输入 

 
图 6-4-3 材料参数输入对话框 

(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 6-4-4 所示。                 
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图 6-4-4 填写完成材料数据输入 

(2)选择“前处理”—>“边界条件”按钮，如图 6-4-5 所示。或

者单击工具条中的 按钮弹如图 6-4-6 所示数据输入表格。 

  
图 6-4-5  选择边界条件输入        图 6-4-6  边界条件输入对话框 
按照问题描述中的参数依次填入边界条件数据表格。填写完成后如图

6-4-7 所示。 

 
图 6-4-7  填写完成边界条件输入 
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建模、设置材料属性和施加边界条件 
(1) 启动 GID 以创建模型。点击菜单选择“前处理”—>“传热”

—>“轴对称瞬态传热”，如图 6-4-8 所示。或者单击工具条中的 按

钮弹出前处理初始化窗口。 

 
图 6-4-8 启动前处理 

(2) 建模。a. 如下图 6-4-9 所示，点击【Geometry】—【Create】—

【Line】, 

 

图 6-4-9 点击 Line 菜单项 

然后在 GID 命令栏依次输入点坐标：0,0，按 ENTER 键；输入 0.06，

0,按 ENTER；输入 0.3,0，按 ENTER 键；输入 0.3,0.3,按 ENTER 键；
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输入 0,0.3,按 ENTER；输入 0,0.06,按 ENTER 键；输入 0,0,按 ENTER

键；接着按 Esc 键。最后得到如图 6-4-10： 

 

图 6-4-10 模型 

b.选择问题类型。如图 6-4-11 所示，点击菜单【Data】-【Problem 
Type】-【SCI】，将弹出如图 6-4-12 所示对话框，点击“确定”按钮

即可。 

       
图 6-4-11 选 SCI                图 6-4-12 Dialog Window 

 

c.定义材料特性、边界条件。如图 6-4-13 点击【Data】—

【Conditions】， 弹出 Conditions 对话框。 
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图 6-4-13 

 
① 定义边界条件。如下图 6-4-14 所示，点击 Conditions 对话框中

的 ，加入条件，如图所示，选择 surface-D1fourtrza，在 u-D1

栏中填入数字 900，点击 Assign 按键，选中扇形区域，代表钢球

的温度；对于钢球以外的区域，重复上述同样操作，不同的是，

在 u-D1 栏中填入数字 20，代表钢球以外区域的温度如图 6-4-14

所示。最后点击 Conditions 对话框中的 Finish 按钮，结束设置。 

 
图 6-4-14 

② 定义材料属性，选择 Condition 对话框中的 Surface-aet3 选项，

在 mate Num 框中输入材料代号 1，表示钢材料，点击 Assign 按

钮，选中钢球区域；然后再在 mate Num 里面输入材料代号 2，表

示水，点击 Assign 按钮，选中钢球以外区域，如图 6-4-15 所示。 
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图 6-4-15 

划分网格和导出数据 
(1).划分网格。点击菜单【Meshing】-【Generate】，弹出“Enter Value 

window” 

对话框，要求定义单元尺寸大小，输入“0.022，点击“ok”按钮，

如图 6-4-16 所示。 

 
图 6-4-16 定义单元尺寸大小 

此时弹出“Progress in meshing”进度条，网格划分完毕后弹出消

息框显示总的单元数和节点数，如图 6-4-17 所示,现实总的三角

形单元数为 1114，总的节点数为 603，点 OK 确认。 
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图 6-4-17 消息框 

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【Files】-

【Save】菜单，保存为 GID 文件。点击菜单【Calculate】-【Calculate】，

弹出“process info”消息框，如图 6-4-18 所示， 

点击“ok”按钮，然后退出 Gid，至此前处理工作结束。 

 
图 6-4-18 转化数据消息框 

6.4.3 有限元计算 
(1) 点击菜单选择“计算”—>“传热”—>“轴对称瞬态传热”，

如图 6-4-19 所示。 
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图 6-4-19  启动有限元计算 

 

或者单击工具条中的 按钮弹出如图 6-4-20 所示计算模拟窗口。 

 
图 6-4-20 计算模拟窗口 
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6.4.4 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度，不同方式来输出计算结果。 
(2) 点击“后处理”—>“传热”—>“轴对称瞬态传热”，如图

6-4-21 所示，或者直接点击后处理图标。 

 
图 6-4-21 进入后处理结果分析 

(3) 点击 按键，然后再点菜单【View results】-【Contour fill】-

【unoda0】，显示最后一个时间步温度场云图分布，如图 6-4-22 所示。 

 
图 6-4-22 
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6.5 轴对称瞬态传热 

6.5.1 问题描述 

6.5.2 求解步骤 

6.5.2.a 选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 6-5-1 所示的对话框。 

 
图 6-5-1 选择项目类型对话框 
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(2)点击“问题类型”栏中的“轴对称稳态热固耦合”选项。如

图 6-5-1 所示。 

(3)点击“OK”按钮完成项目类型的选择。 

6.5.2.b 设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 6-5-2 所示。或

者单击工具条中的 按钮弹出如图 6-5-3 所示材料参数数据输入表

格。 

 
图 6-5-2  选择材料参数输入 



 163 

 
图 6-5-3  材料参数输入对话框 

 

(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 5-5-4 所示。 

 

 
图 6-5-4  填写完成材料数据输入 

 

(3) 选择“前处理”—>“边界条件”按钮，如图 6-5-5 所示。

或者单击工具条中的 按钮弹如图 6-5-6 所示数据输入表格。 
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图 6-5-5  选择边界条件输入 

 

图 6-5-6  边界条件输入对话框 
(4)按照问题描述中的参数依次填入边界条件数据表格。填写完



 165 

成后如图 6-5-7 所示。对本问题施加一法向力即可，负号表示受拉。 
 

 
 

 
图 6-5-7  填写完成边界条件输入 
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6.5.2.c.建模、设置材料属性和施加边界条件 
(1) 启动 GID 以创建模型。点击菜单选择“前处理”—>“传热”

—>“轴对称瞬态传热”，如图 6-5-8 所示。 

 
 

图 6-5-8  启动前处理 

或者单击工具条中的 按钮弹出前处理初始化窗口。 

(2) 建模。通过对几何模型进行分析，可以根据对称性取 1/4 部

分进行简化。 
 点击菜单【Geometry】-【Create】-【Line】，在命令栏依次输

入点坐标:生成平板的外边界如图 6-5-9 所示。 
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图 6-5-9  生成平板外边界 

 
(3).选择问题类型。点击菜单【Data】-【Problem Type】-【SCI】，

弹出“Dialog Window”，点击“确定”按钮即可。 
(4).定义材料特性、施加载荷约束。点击菜单【Data】-【Conditions】

弹出“Conditions”对话框如图 6-5-10 所示。 
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① 点击表示面单元的按钮 ，选中下拉菜单中的“line-eliso2d”，
点击“Assign”，选择生成的面，点击“Finish”即定义好材料特性。

用户可以点击菜单【Draw】-【Colors】来观察是否已经定义成功。

如图 6-5-11 所示。 

 
                    

 
图 6-5-11 
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②点击线单元按钮 ，选中下拉菜单中的“Line-all2”，在“mate 
Num”中填入“1”，点击“Assign”按钮，选择上端要施加载荷的边，

如图 6-5-12 所示。然后，点击 Conditions 对话框中的 Finish 按钮。 

 
图 6-5-12  施加载荷 
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③点击表示面单元的按钮 ，最后得到如图 6-5-13: 
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图 6-5-13 定义约束条件 
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6.5.2.d 划分网格和导出数据 
(1).划分网格。点击菜单【Meshing】-【Generate】，弹出“Enter 

Value window”对话框，要求定义单元尺寸大小，输入“0.2”，点击

“OK”按钮，如图 6-5-13 所 

示。 

 

图 6-5-13 定义单元尺寸大小 

此时弹出“Progress in meshing”进度条，网格划分完毕后弹出消

息框显示总的单元数和节点数，如图 6-5-14 所示。 

 

图 6-5-14 划分网格得到的单元节点信息 
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点击“OK”按钮后即可得到划分完的网格模型,如图 6-5-15 所示。 

 

图 6-5-15  生成网格模型                             

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【Files】
-【Save】菜单，保存为GID文件。点击菜单【Calculate】-【Calculate】，
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弹出“process info”消息框，如图 6-5-16 所示，点击“ok”按钮，

然后退出 Gid，至此前处理工作结束。 

 

图 6-5-16  转化数据消息框 

6.5.3 有限元计算 
(1) 点击菜单选择“计算”—>“传热”—>“轴对称瞬态传热”，

如图 6-5-17 所示。或者单击工具条中的 按钮弹出如图 6-5-18 所示

计算模拟窗口。 

 
图 6-5-19 启动有限元计算 
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图 6-5-20  计算模拟窗口 
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6.5.4 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度，不同方式来输出计算结果。 
(1) 点击“后处理”—>“传热”—>“轴对称瞬态传热”，如图

6-5-21 所示。 

 
图 6-5-21 进入后处理结果分析 

(2)点击菜单【Files】-【Postprocess】进入后处理程序。 
(3)点击菜单【View results】-【Contour fill】-【unoda0】-【v】

显示沿 y 方向的位移云图，如图 6-5-22 所示。 
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图 6-5-23  y 方向位移云图 
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第7章 渗流问题 

7.1 二维渗流问题 

7.1.1 问题描述 

渗流问题是水利工程常见的一种问题，实际工程中，人们常常要

对渗流进行计算，以求得需要部位的渗流压力。本节我们给出一个二

维坝基渗流问题的例子，通过这个例子，我们可以清楚地看到应用

SciFEA 解决此类问题的方法的步骤。 

如图所示在各向同性土层上有一个水坝，左右两侧边界、土层下

岩石和坝体本身都假设是不透水的。在和水坝的左方水域水头为 15，

右方水域水头为 5。土层的渗流系数是 5.0d-7。求土层的渗流压力分

布。 

 
图 7-1-1 二维坝基渗流 

问题分析： 

对于上面二维稳态渗流问题方程如下： 
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如上图区域的左方水域

如上图区域的右方水域

是上面的区域

onu
onu

inequpk

5
15

,)*(







 

其中u表示压力， pk 是渗透率， eq是流体源项。 

7.1.2 求解步骤 

选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 7-1-2 所示的对话框。 

 
图 7-1-2  选择项目类型对话框 

(2)点击“问题类型”栏中的“二维稳态渗流”选项。如图 7-1-2
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所示。 

(3)点击“OK”按钮完成项目类型的选择。 

设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 7-1-3 所示。或

者单击工具条中的 按钮弹出如图 7-1-4 所示材料参数数据输入表

格。 

 
图 7-1-3  选择材料参数输入 

 

图 7-1-4  材料参数输入对话框 
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(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 7-1-5 所示。 

 
图 7-1-5  填写完成材料数据输入 

 

(3) 选择“前处理”—>“边界条件”按钮，如图 7-1-6 所示。

或者单击工具条中的 按钮弹如图 7-1-7 所示数据输入表格。 

 
图 7-1-6  选择边界条件输入 
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图 7-1-7  边界条件输入对话框 

(4)按照问题描述中的参数依次填入边界条件数据表格。填写完

成后如图 7-1-8 所示。 

 
图 7-1-8  填写完成边界条件输入 

建模、设置材料属性和施加边界条件 
(1) 启动 GID 以创建模型。点击菜单选择“前处理”—>“渗流”

—>“二维渗流”，如图 7-1-9 所示。或者单击工具条中的 按钮弹出

如图 7-1-10 所示前处理初始化窗口。 
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图 7-1-9  启动前处理 

 

 

 

图 7-1-10 前处理初始化窗口 
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(4)建模。a. 如图 7-1-11 所示，点击【Geometry】—【Create】

—【Line】, 

 

图 7-1-11 点击 Line 菜单项 

 

如下图 7-1-12，7-1-13 所示，在 GID 命令栏中先输入 0,0，按 ENTER

键，然后输入 250,0，按 ENTER 键，然后依次输入(250,100)、(171，

100)、(171，60)、(170，60)、(170，100)、(76，100)、(76，60)、

(75，60)、(75，100)、(0，100)、(0，0)。 

 

           
 

图 7-1-12 输入 0,0                 图 7-1-13  输入 250,0 

 

输入最后一个 0,0 时，系统提示是否连接原先节点，如下图 7-1-14。

选择”JOIN”，形成如图 7-1-15 所示封闭线段。 



 185 

 

图 7-1-14 选择连接 

    

图 7-1-15 形成的封闭线段 

 

如下图 7-1-16 所示，点击【Geometry】—【Creat】—【NURBS surface】-

—【By contour】菜单项，选择图 7-1-15 中的所有线段，形成如图

7-17 所示的几何面。 
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图 7-1-16 选择创建面的菜单项  

 

图 7-1-17 渗流几何模型 

 

b.选择问题类型。如图 7-1-18 所示，点击菜单【Data】-【Problem 
Type】-【SCI】，将弹出如图 7-1-19 所示对话框，点击“确定”按钮

即可。 
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图 7-1-18 选 FEPG                  图 7-1-19 

 

c.定义材料特性、边界条件。如图 7-1-20 点击【Data】—

【Conditions】， 弹出如图 7-1-21 的 Conditions 对话框。 

① 定义材料。点击其中的 ，加入关于面的条件，如材料号、初

值、边值等，点击如图 7-1-21 所示的 Conditions 对话框中的下拉菜

单，选中 Surface-aet3，然后点击 Conditions 对话框中的 Assign

按钮，选中整个区域，然后，点击 Conditions 对话框中的 Finish

按钮。这样，面材料号施加完毕。 

       
图 7-1-20                  图 7-1-21   Conditions 

 

②定义边界条件。如下图 7-1-22 所示，点击 Conditions 对话框

中的 ，加入关于线的条件，如材料号、初值、边值等。如图 7-1-22

所示，保持 line- darcy2da 不变，保持 u-l 为－1,u-D 改为 15.0,
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然后点击图 7-1-22 中的 Assign 按钮，施加 id 号为-1 的边（指出那

些给定渗流压力的边），选中区域压力水头为 15 的线段。然后，点击

Conditions 对话框中的 Finish 按钮。这样，压力水头为 15 的边界

施加完毕。再将 u-D 改为 5.0，然后再次点击图 7-1-22 中的 Assign

按钮，选中区域压力水头为 5 的线段。然后，点击 Conditions 对话

框中的 Finish 按钮。这样，压力水头为 5的边界也施加完毕。 

 

图 7-1-22 

点击如图 7-1-22 所示的 Draw->Colors,显示的边界条件的施加

情况如图 7-1-23 所示。 

                 
图 7-1-23 
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划分网格和导出数据 
(1).划分网格。点击菜单【Meshing】-【Generate】，弹出“Enter Value 

window”对话框，要求定义单元尺寸大小，输入“2”，点击“ok”按

钮，如图 7-1-24 所示。 

 

图 7-1-24  定义单元尺寸大小 

此时弹出“Progress in meshing”进度条，网格划分完毕后弹出消

息框显示总的单元数和节点数，如图 7-1-25 所示。 

 

图 7-1-25  消息框 



 190 

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【Files】

-【Save】菜单，保存为 GID 文件。点击菜单【Calculate】-

【Calculate】，弹出“process info”消息框，如图 7-1-26 所

示，点击“OK”按钮，然后退出 Gid，至此前处理工作结束。 

 

图 7-1-26  转化数据消息框 

有限元计算 
(1) 点击菜单选择“计算”—>“渗流”—>“二维渗流”，如图

7-27 所示。或者单击工具条中的 按钮弹出如图 7-1-28 所示计算模

拟窗口。 

 
图 7-1-27  启动有限元计算 
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图 7-1-28  计算模拟窗口 

 

7.1.3 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度，不同方式来输出计算结果。 
(1) 点击“后处理”—>“渗流”—>“二维渗流”，如图 7-1-29

所示。 

 
图 7-1-29 进入后处理结果分析 
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(2)点击菜单【View results】-【Contour fill】-【unoda0】，如图 7-1-30

所示，显示得到渗流场云图分布，如图 7-1-31 所示。 
 

 
图 7-1-30 选择渗流压力水头云图 

 



 193 

 
图 7-1-31 渗流场云图分布 

 

(3)点击菜单【View results】-【Display Vectors】-【unoda0】-
【|unodb0|】，如图 7-1-32 所示，显示得到渗流速度场云图分布，

如图 7-1-33 所示。 

 
图 7-1-32 选择渗流速度矢量图 
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图 7-1-33 渗流速度场云图分布 
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7.2 二维无压渗流问题 

7.2.1 问题描述 

7.2.2 求解步骤 

选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 7-2-1 所示的对话框。 

 

图 7-2-1 选择项目类型对话框 

(2)点击“问题类型”栏中的“二维无压渗流”选项。如图 7-2-1
所示。 

(3)点击“OK”按钮完成项目类型的选择。 
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设置材料参数和边界条件 
 

(1)选择“前处理”—>“材料参数”按钮，如图 7-2-2 所示。或

者单击工具条中的 按钮弹出如图 7-2-3 所示材料参数数据输入表

格。 

 
图 7-2-2 选择材料参数输入 

 

 

图 7-2-3 材料参数输入对话框 
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(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 7-2-4 所示。                 

 
图 7-2-4 填写完成材料数据输入 

 

(2)选择“前处理”—>“边界条件”按钮，如图 7-2-5 所示。或

者单击工具条中的 按钮弹如图 7-2-6 所示数据输入表格。 

 
图 7-2-5  选择边界条件输入 
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图 7-2-6  边界条件输入对话框 

按照问题描述中的参数依次填入边界条件数据表格。填写完成

后如图 7-2-7 所示。 

 
图 7-2-7  填写完成边界条件输入 

 
建模、设置材料属性和施加边界条件 

(1) 启动 GID 以创建模型。点击菜单选择“前处理”—>“渗流”

—>“二维无压渗流”，如图 7-2-5 所示。 
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图 7-2-5 启动前处理 

或者单击工具条中的 按钮弹出前处理初始化窗口。 

(2) 建模。a. 如下图 6-11 所示，点击【Geometry】—【Create】—

【Line】, 

 

图 6-11 点击 Line 菜单项 

然后在 GID 命令栏依次输入点坐标：0,0，按 ENTER 键；输入 91，0,

按 ENTER；输入 87,2，按 ENTER 键；输入 61,15,按 ENTER 键；输入

57,17,按 ENTER；输入 51,17,按 ENTER 键；输入 45,15,按 ENTER 键；



 200 

输入 6,2,按 ENTER 键；输入 0,0,按 ENTER 键；接着按 Esc 键：最后

得到如图： 

 

 
图 7-2-7 模型 

b.选择问题类型。如图 7-2-8 所示，点击菜单【Data】-【Problem 
Type】-【SCI】，将弹出如图 7-2-9 所示对话框，点击“确定”按钮

即可。 

 
图 7-2-8 选 SCI            图 7-2-9 Dialog Window 

c.定义材料特性、边界条件。如图 7-2-10 点击【Data】—

【Conditions】， 弹出 Conditions 对话框。 
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图 7-2-10 

③ 定义边界条件。如下图所示，点击 Conditions 对话框中的 ，

加入条件，如图所示，选择 line-free2da,然后分别设值为如图

7-2-11 一样；最后点击图中的 Assign 按钮，分别选中区域中的

各点。然后，点击 Conditions 对话框中的 Finish 按钮，最后结

果如图 7-2-11。 

 
图 7-2-11 

②点击 Conditions 对话框中的 ，选中 surface-D1free2da，然后

分别设值为如图 7-2-12 一样；然后点击 Conditions 对话框中的

Finish 按钮。点击 Conditions 对话框中的 Close 按钮,最后结果如
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图 7-2-12。 

 
图 7-2-12 

然后再选择 Surface-aeq4, 然后设值为如图 7-2-13 一样；然后点击

Conditions 对话框中的 Finish 按钮。点击 Conditions 对话框中的

Close 按钮,最后结果如图 7-2-13。 

 
图 7-2-13 
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划分网格和导出数据 
(1).划分网格。点击菜单【Meshing】-【Generate】，弹出“Enter Value 

window” 

对话框，要求定义单元尺寸大小，输入“9.3”，点击“ok”按钮，如

图 7-2-13 所示。 

 

图 7-2-13 定义单元尺寸大小 

此时弹出“Progress in meshing”进度条，网格划分完毕后弹出消

息框显示总的单元数和节点数，如图 7-2-14 所示,点 OK。 

 

图 7-2-14 消息框 

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【Files】-【Save】菜单，
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保存为 GID 文件。点击菜单【Calculate】-【Calculate】，弹出“process info”
消息框 7-2-15 所示， 

点击“ok”按钮，然后退出 Gid，至此前处理工作结束。 

 
图 7-2-15 转化数据消息框 

7.2.3 有限元计算 

(1) 点击菜单选择“计算”—>“渗流”—>“二维无压力渗流”，

如图 7-2-16 所示。 

 
图 7-2-16  启动有限元计算 

或者单击工具条中的 按钮弹出如图 7-2-17 所示计算模拟窗

口。 
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图 7-2-17 计算模拟窗口 

7.2.4 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度，不同方式来输出计算结果。 
(5) 点击“后处理”—>“渗流”—>“二维无压渗流”，如图 7-2-18

所示。 
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图 7-2-18 进入后处理结果分析 

(6) 点击 按键，然后再点菜单【View results】-【Contour fill】
-【unoda0】，显示最后一个时间步温度场云图分布，如图 7-2-19
所示。 

 
图 7-2-19 
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7.3 二维无压渗流 

7.3.1 问题描述 

湖南益阳发电厂贮灰场灰坝工程（渗流及边坡稳定计算成果） 
一、工程概况 

湖南省益阳电厂贮灰场灰坝位于益阳电厂东南侧距益阳电厂约 5 公里的

野鸭水库南侧 
的冲沟中。 

初期坝为均质土坝由主坝、副坝组成。主坝最大坝高为 30 米，上游坡设

有强透水性的 
排水垫层作为排水设施，在垫层底部连接水平盲沟使排水垫层与水平盲沟构成

联合排渗体系；同时设置纵向盲沟，使之构成排水网络，以确保排水系统畅通，

以此用来降低坝体浸润线，并使渗透比降满足规范要求，达到坝体渗透稳定与

边坡稳定之目的。 
坝址区工程地质条件：主要岩层岩性，第一层为可塑的粉质粘土，含砂及

少量有机质，主要分布于基冲沟田垅中平均厚度 3.2 米，第二层为粉质粘土含

碎石、砂、铁锰质氧化物，其厚度为 2.2 米。第三层为板岩，强风化、泥质砂

质胶结夹条带状千枚岩，其平均厚度为 2.5 米。 

坝肩山体坡度为20 ～30 ，坡顶高程为 80～115.6 米。上部粘性土层和

强风化板岩厚度 3～4 米，下部为中风化板岩，产状走向 9～36 度，倾向北西

倾角 68～72 度，据湖南省电力勘测设计院初步设计阶段地质报告所作结论。

坝肩处山体部分不会产生大的土质滑坡及岩质滑坡，上坝料选择了库区及附近

山坡的强风化板岩风化料。为了科学地论证灰坝设计的合理与可行性，湖南省

益阳发电有限责任公司委托中国水利水电科学研究院岩土工程研究所对贮灰

场坝进行土料试验研究。灰坝渗流有限元计算分析及坝体坡稳定计算分析，此

项工作得到了湖南省电力设计院的配合。 
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图 7-3-1 

7.3.2 求解步骤 

选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 7-3-2 所示的对话框。 

 

图 7-3-2 选择项目类型对话框 
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(2)点击“问题类型”栏中的“二维无压渗流”选项。如图 7-3-2
所示。 

(3)点击“OK”按钮完成项目类型的选择。 

设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 7-3-3 所示。或

者单击工具条中的 按钮弹出如图 7-3-4 所示材料参数数据输入表

格。 

    
图 7-3-3 选择材料参数输入         图 7-3-4 材料参数输入对话框 

 

(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如 7-3-5 所示。                 

 
图 7-3-5 填写完成材料数据输入 
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(2)选择“前处理”—>“边界条件”按钮，如图 7-3-6 所示。或

者单击工具条中的 按钮弹如图 7-3-7 所示数据输入表格。 

        
图 7-3-6  选择边界条件输入        图 7-3-7  边界条件输入对话框 

按照问题描述中的参数依次填入边界条件数据表格。填写完成

后如图 7-3-8 所示。 
 

 
 

图 7-3-8  填写完成边界条件输入 

 

建模、设置材料属性和施加边界条件 
(1) 启动 GID 以创建模型。点击菜单选择“前处理”—>“渗流”

—>“二维无压渗流”，如图 7-3-9 所示。 
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图 7-3-9 启动前处理 

或者单击工具条中的 按钮弹出前处理初始化窗口。 

 (2) 建模。a. 如下图 7-3-10 所示，点击【Geometry】—【Create】

—【Line】. 

 

 

 

图 7-3-10 
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如下图 7-3-11 所示，我们的模型就建好了。 

 

图 7-3-11 模型 

b.选择问题类型。如图 7-3-12 所示，点击菜单【Data】-【Problem 
Type】-【SCI】，将弹出如图 7-3-13 所示对话框，点击“确定”按钮

即可。 

 
图 7-3-12 选 SCI        图 7-3-13 Dialog Window 

c.定义材料特性、边界条件。如图 7-3-14 点击【Data】—

【Conditions】， 弹出 Conditions 对话框。 
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图 7-3-14 

定义边界条件。如下图 7-3-15所示，点击 Conditions 对话框中的 ，

加入条件，如图 7-3-15 所示，选择 Line-all2,然后分别设值为如图

11 一样；最后点击图中的 Assign 按钮，分别选中区域中的各点。然

后，点击 Conditions 对话框中的 Finish 按钮，最后结果如图 7-3-15；

然后再选择 line-free2da，最后得到如图 7-3-16。 

 

图 7-3-15 
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图 7-3-16 

②点击 Conditions 对话框中的 ，选中 surface-D1free2da，然后

点击图中的Assign按钮，选中区域所有的边界，然后点击Conditions

对话框中的 Finish 按钮。点击 Conditions 对话框中的 Close 按钮,

最后结果如图 7-3-17。 

 
图 7-3-17 
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然后再选择 Surface-aeq4，最后得到如图 7-3-18。 

 

 
图 7-3-18 

划分网格和导出数据 
(1).划分网格。点击菜单【Meshing】-【Generate】，弹出“Enter Value 

window” 

对话框，要求定义单元尺寸大小，输入“17”，点击“ok”按钮，如

图 7-3-19 所示。 

 
图 7-3-19 定义单元尺寸大小 
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此时弹出“Progress in meshing”进度条，网格划分完毕后弹出消

息框显示总的单元数和节点数，如图 7-3-20 所示,点 OK。 

 

图 7-3-20 消息框 

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【Files】-【Save】菜单，

保存为 GID 文件。点击菜单【Calculate】-【Calculate】，弹出“process info”
消息框，如图 7-3-21 所示， 

点击“ok”按钮，然后退出 Gid，至此前处理工作结束。 
 

 
图 7-3-21 转化数据消息框 
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7.3.3 有限元计算 

(1) 点击菜单选择“计算”—>“渗流”—>“二维无压渗流”，

如图 7-3-22所示。 

 
图 7-3-22  启动有限元计算 

或者单击工具条中的 按钮弹出如图 7-3-23所示计算模拟窗口。 

 
图 7-3-23计算模拟窗口 
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7.3.4 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度，不同方式来输出计算结果。 
(7) 点击“后处理”—>“渗流”—>“二维无压渗流”，如图 7-3-24

所示。 
 
 

 
 

图 7-3-24 进入后处理结果分析 

(8) 点击 按键，然后再点菜单【View results】-【Contour fill】
-【unoda0】，显示最后一个时间步温度场云图分布，如图 7-3-25所示。 
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图 7-3-25 
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第8章 电磁问题 

8.1 二维静电问题 

8.1.1 问题描述 

一个带挡板的变压器模型，如图 8-1 所示。其中指定的几条边上

给定第一类边界条件，边界上每点都约束住，电位值分别为 0 和 25，
介质的介电常数为 8.854e-12，求解它的电位分布。 

 µÚ Ò» À́ ±ß ½ç
u£½ 0

 µÚ Ò» À́ ±ß ½ç
u£½ 25

 µÚ ¶þ À́ ±ß ½ç
 ±ä Ñ¹ Æ÷µ² °å

 
图 8-1-1  带挡板变压器模型 

8.1.2 求解步骤 

选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 8-1-2 所示的对话框。 
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图 8-1-2  选择项目类型对话框 

(2)点击“问题类型”栏中的“二维稳态电场”选项。如图 8-1-2
所示。 

(3)点击“OK”按钮完成项目类型的选择。 

设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 8-1-3 所示。或

者单击工具条中的 按钮弹出如图 8-1-4 所示材料参数数据输入表

格。 
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图 8-1-3  选择材料参数输入 

  
图 8-1-4  材料参数输入对话框 

 
(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 8-1-5 所示。 
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图 8-1-5  填写完成材料数据输入 

 

(3)选择“前处理”—>“边界条件”按钮，如图 8-1-6 所示。或

者单击工具条中的 按钮弹如图 8-1-7 所示数据输入表格。 

    
 
图 8-1-6  选择边界条件输入         图 8-1-7  边界条件输入对话框 

 
(4)按照问题描述中的参数依次填入边界条件数据表格。填写完

成后如图 8-1-8 所示。 
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图 8-1-8  填写完成边界条件输入 

 

建模、设置材料属性和施加边界条件 
(1) 启动 GID 以创建模型。点击菜单选择“前处理”—>“电磁”

—>“二维静电场”，如图 8-1-9 所示。或者单击工具条中的 按钮弹

出如图 8-1-10 所示前处理初始化窗口。 

 
图 8-1-9  启动前处理 
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图 8-1-10 前处理初始化窗口 

 
(2) 建模。a.点击菜单【Geometry】-【Create】-【Line】，创建直

线，在命令栏中依次输入坐标 5.75,1.5，按 Enter 键，输入 7,1.5，按

Enter 键，输入 7,6，按 Enter 键，输入 0,6，按 Enter 键，输入 0,2，
按 Enter 键，输入 3,2，按 Enter 键，输入 3,0，按 Enter 键，输入 5,0，
按 Enter 键，输入 5,0.5，按 Enter 键，输入 7,0.5，按 Enter 键，输入

7,1，按 Enter 键，输入 5.25,1，按 Enter 键，生成直线如图 8-1-11 所

示。 
b.点击菜单【Geometry】-【Create】-【Point】，在命令栏中输入

坐标 5.75,0.5，创建一个点为下面创建圆弧做准备，再点击菜单

【Geometry】-【Create】-【Arc】，选取三点创建一圆弧，坐标分别

为（5.75, 1.5）、（5.25, 1）、（5.75, 0.5），如图 8-12 所示。 
c.点击菜单【Geometry】-【Create】-【Intersection】-【Line-line】，

选择圆弧线和中间相交的直线，求它们的交点并把圆弧在交点处截

断，如图 8-1-13 所示。 
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图 8-1-11  生成直线 

 
图 8-1-12  生成圆弧 
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图 8-1-13  求圆弧交点并截断 

d.点击菜单【Geometry】-【Delete】-【Line】，选中要删去的圆

弧下段，同样操作以删去刚才所作的辅助点，如图 8-1-14 所示。 

 
图 8-1-14  删去多余的圆弧和点 

e. 点击菜单【Geometry】-【Create】-【NURBS surface】-【By 
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contour】，选中所有线以生成一个面，如图 8-1-15 所示。 

 
图 8-1-15  生成面 

 

f.选择问题类型。点击菜单【Data】-【Problem Type】-【sci】，
弹出“Dialog Window”，点击“OK”按钮即可。 

g.材料特性、初始条件。点击菜单【Data】-【Conditions】弹出

“Conditions”对话框。 
 
① 定义材料。点击表示面单元的按钮 ，选中下拉菜单中的

“Surface－aet3”,在 mate Num 栏中设置材料代号为 1，点击“Assign”
按钮，然后选择生成的面，点击“Finish”按钮即定义好材料特性。

点击“Draw”选择“Colors”如图 8-1-16 所示。 
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图 8-1-16  定义材料特性 

②定义初始电位。点击线单元按钮 ，选中下拉菜单中的

“line-elec2da”，保持“u-l”为“-1”不变，保持“u-D”中为“0” 不
变，点击“Assign”按钮，选择电位为 0 的边界，点击“Finish”按

钮。“u-D”中填入“25”，选择电位为 25 的边界，点击“Finish”按

钮。点击“Draw”选择“Colors”如图 8-1-17 所示。 

 
图 8-1-17  设定电位边界 
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划分网格和导出数据 
(1).划分网格。点击菜单【Meshing】-【Generate】，在弹出的要

求输入单元尺寸大小对话框中输入“0.25”，如图 8-1-18 所示，点击

“ok”按钮，即可生成网格模型如图 8-1-19 所示。 

 
图 8-1-18  设置网格特征尺寸 

 

图 8-1-19  生成网格模型 

 

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【Files】

-【Save】菜单，保存为 GID 文件。点击菜单【Calculate】-【Calculate】，

弹出“process info”消息框，如图 8-1-20 所示，点击“OK”按钮，

然后退出 Gid，至此前处理工作结束。 
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图 8-1-20  转化数据消息框 

有限元计算 
(1) 点击菜单选择“计算”—>“电磁”—>“二维静电场”，如

图 8-1-21 所示。或者单击工具条中的 按钮弹出如图 8-1-22 所示计

算模拟窗口。 

 
图 8-1-21  启动有限元计算 
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图 8-1-22  计算模拟窗口 

8.1.3 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度，不同方式来输出计算结果。 
(1) 点击“后处理”—>“电磁”—>“二维静电场”，如图 8-1-23

所示。 
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图 8-1-23 进入后处理结果分析 

 
(2) 点击菜单【View results】-【Contour fill】-【unoda0】，如图

8-1-24 所示，显示得到电场云图分布，如图 8-1-25 所示。 

     
 

图 8-1-24 选择电场分布云图           图 8-1-25 电场云图分布 
(3) 点击菜单【View results】-【Display Vectors】-【unoda0】-

【|unodb0|】，如图 8-1-26 所示，显示得到渗流场云图分布，如图 8-1-27
所示。 
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图 8-1-26 选择电场强度矢量图       图 8-1-27 电场强度矢量图 

 

 (4)点击菜单【View】-【Label】-【Select】-【.Res】，选中想查

看电位值的某一区域的点，按“ESC”键即可显示，如图 8-1-28 所示。 
 

      
 

图 8-1-28  查看某一区域节点的电位值大小 
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第9章 结构力学问题 

9.1 二维刚架问题 

9.1.1 问题描述 

平面二维刚架，弹性模量 EX=2e11N/m2，截面面积 A=0.1m2，

截面惯性矩 I=1d-3m4，在刚架顶端承受一水平力 F=10N，试求解刚

架的受力状态。 

 

图 9-1-1 

9.1.2 求解步骤 

选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 9-1-2 所示的对话框。 
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图 9-1-2 选择项目类型对话框 

(2)点击“问题类型”栏中的“二维刚架”选项。如图 9-1-2 所

示。 

(3)点击“OK”按钮完成项目类型的选择。 

 

设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 9-1-3 所示。或

者单击工具条中的 按钮弹出如图 9-1-4 所示材料参数数据输入表

格。 
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图 9-1-3 选择材料参数输入 

 

图 9-1-4 材料参数输入对话框 

 
(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 9-1-5 所示。                 
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图 9-1-5 填写完成材料数据输入 

 
建模、设置材料属性和施加边界条件 

(1) 启动 GID 以创建模型。点击菜单选择“前处理”—>“结构

力学”—>“二维刚架”，如图 9-1-6 所示。或者单击工具条中的 按

钮弹出前处理初始化窗口。 

 
图 9-1-6 启动前处理 

(2) 建模。a. 如下图 9-1-7 所示，点击【Geometry】—【Create】

—【Line】, 
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图 9-1-7 点击 Line 菜单项 

然后在 GID 命令栏依次输入点坐标：0,0，按 ENTER 键；输入 1，0,

按 ENTER；输入 1,1，按 ENTER 键；输入 0,1,按 ENTER 键；输入 0,0,

按 ENTER；接着按 Esc 键.最后得到模型如图 9-1-8： 

 
图 9-1-8 模型 

b.选择问题类型。如图 9-1-9 所示，点击菜单【Data】-【Problem 
Type】-【SCI】，将弹出如图 9-1-10 所示对话框，点击“确定”按钮

即可。 
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图 9-1-9 选 SCI             图 9-1-10 Dialog Window 

 

c.定义材料特性、边界条件。如图 9-1-11 点击【Data】—

【Conditions】， 弹出 Conditions 对话框。 

 

 
图 9-1-11 

 
定义边界条件。点击 Conditions 对话框中的 ，加入条件，如图

所示，选择point-beam2da,然后分别设各点的值为如图u-1为-1,v-1

为-1,st-1 为-1；u-1 为-1,u-d 为 10，v-1 为 1, st-1 为 1；最后点

击图中的 Assign 按钮，分别选中区域中的各点。然后，点击

Conditions 对话框中的 Finish 按钮，最后结果如图 9-1-12。 
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图 9-1-12 
 

点击 Conditions 对话框中的 ，选中 Line-bmull2，修改

Conditions对话框中的mate Num为 1,然后点击图中的Assign按钮，

选中区域所有的边界，然后点击Conditions对话框中的Finish按钮。

这样，边上的 Line-bmull2 施加完毕。点击 Conditions 对话框中的

Close 按钮,最后结果如图 9-1-13。 
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图 9-1-13 

划分网格和导出数据 
(1).划分网格。点击菜单【Meshing】-【Generate】，弹出“Enter 

Value window” 

对话框，要求定义单元尺寸大小，输入“10”，点击“ok”按钮，如图

9-1-14 所示。 

 

图 9-1-14 定义单元尺寸大小 
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此时弹出“Progress in meshing”进度条，网格划分完毕后弹出消息

框显示总的单元数和节点数，如图 9-1-15 所示,点 OK。 

 
图 9-1-15 消息框 

 

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【Files】

-【Save】菜单，保存为 GID 文件。点击菜单【Calculate】-【Calculate】，

弹出“process info”消息框，如图 9-1-16 所示，点击“ok”按钮，

然后退出 Gid，至此前处理工作结束。 

 

图 9-1-16 转化数据消息框 
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9.1.3 有限元计算 

点击菜单选择“计算”—>“结构力学”—>“二维刚架”，如图

9-1-17 所示。或者单击工具条中的 按钮弹出如图 9-1-18 所示计算

模拟窗口。 

 
图 9-1-17  启动有限元计算 
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图 9-1-18 计算模拟窗口 
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9.1.4 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度，不同方式来输出计算结果。 
(1)点击“后处理”—>“结构力学”—>“二维刚架”，如图 9-1-19

所示。 

 
图 9-1-19 进入后处理结果分析 

(2)点击 按键，然后再点菜单【View results】-【Contour fill】
-【unoda0】，显示最后一个时间步温度场云图分布，如图 9-1-20 所示。 

 
图 9-1-20 
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9.2 三维刚架问题 

9.2.1 问题描述 

空间三维刚架，弹性模量 EX=2e11N/m2，泊松比 PRXY=0.3，
截面面积 A=0.12m2，Ix=2.5d-3m4，Iy=1.6d-3m4，Iz=9d-4m4，刚架顶

端分别承受 x、y 方向 10N 的作用力，试算刚架在荷载作用下的变形。 

9.2.2 求解步骤 

选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 2-1 所示的对话框。 

 
图 9-2-1  选择项目类型对话框 

(2)点击“问题类型”栏中的“三维刚架”选项。如图 9-2-1 所

示。 
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(3)点击“OK”按钮完成项目类型的选择。 

设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 9-2-2 所示。或

者单击工具条中的 按钮弹出如图 9-2-3 所示材料参数数据输入表

格。 

 
图 9-2-2  选择材料参数输入 

 

图 9-2-3  材料参数输入对话框 
(2)按照问题描述中的参数依次填入材料参数数据表格。填写完成

后如图 9-2-4 所示。 
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图 9-2-4  填写完成材料数据输入 

建模、设置材料属性和施加边界条件 
 (1) 启动 GID 以创建模型。点击菜单选择“结构力学”—>“三

维刚架”，如图 9-2-5 所示；或者单击工具条中的 按钮弹出前处理

初始化窗口。 

 
图 9-2-5  启动前处理 
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(2) 建模。a. 如下图 9-2-6 所示，点击【Geometry】—【Create】—

【Line】， 

 
图 9-2-6 点击 Line 菜单项 

然后在 GID 命令栏依次输入点坐标：0,0，按 ENTER 键；输入 1，0,

按 ENTER；输入 1,1，按 ENTER 键；输入 0,1,按 ENTER 键；输入 0,0,

按 ENTER；接着按 Esc 键.最后模型如图 9-2-7： 

 
图 9-2-7 模型 

b.选择问题类型。如图 9-2-8 所示，点击菜单【Data】-【Problem 
Type】-【SCI】，将弹出如图 9-2-9 所示对话框，点击“确定”按钮

即可。 

  
图 9-2-8 选 FEPG                  图 9-2-9 

c.定义材料特性、边界条件。如图 9-2-10 点击【Data】—

【Conditions】， 弹出 Conditions 对话框。 
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图 9-2-10 

定义边界条件。点击 Conditions 对话框中的 ，选择

point-beam3da,然后分别设各点的值为如图 u-1 为-1,v-1 为 1,w-1

为-1，anx-1 为-1,any-1 为-1,anz-1 为-1；u-1 为 1, u-D 为 10，v-1

为-1, v-D 为 10，w-1 为 1，anx-1 为 1,any-1 为 1,anz-1 为 1；最后

点击图中的 Assign 按钮，分别选中区域中的各点。然后，点击

Conditions 对话框中的 Finish 按钮，最后结果如图 9-2-11。 

 

图 9-2-11 

点击 Conditions 对话框中的 ，选中 Line-bmull2，修改
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Conditions对话框中的mate Num为 1,然后点击图中的Assign按钮，

选中区域所有的边界然后，点击Conditions对话框中的Finish按钮。

最后结果如图 9-2-12。 

 

 

图 9-2-12 

 

选择对话框中 Line-bmsll2 选项，设置 mate Num 材料代号为 1，

如图 9-2-13 所示。 
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图 9-2-13 

选择对话框中 Line-bmqll2 选项，设置 mate Num 材料代号为 1，

如图 9-2-14 所示。 
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图 9-2-14 

 

d 划分网格和导出数据 

(1).划分网格。点击菜单【Meshing】-【Generate】，弹出“Enter 

Value window”对话框，要求定义单元尺寸大小，输入“10”，点击

“OK”按钮，如图 9-2-15 所示。 

 

图 9-2-15 定义单元尺寸大小 



 255 

 

此时弹出“Progress in meshing”进度条，网格划分完毕后弹出消

息框显示总的单元数和节点数，如图 9-2-16 所示。 

 
图 9-2-16 消息框 

 

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【Files】

-【Save】菜单，保存为 GID 文件。点击菜单【Calculate】-【Calculate】，

弹出“process info”消息框，如图 9-2-17 所示，点击“ok”按钮，

然后退出 Gid，至此前处理工作结束。 

 

 

图 9-2-17 转化数据消息框 
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9.2.3 有限元计算 

点击菜单选择“计算”—>“结构力学”—>“三维刚架”，如图

9-2-18 所示。或者单击工具条中的 按钮弹出如图 9-2-19 所示计算

模拟窗口。 

 

 
 
 

图 9-2-18  启动有限元计算 
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图 9-2-19 计算模拟窗口 
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9.2.4 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操作，

可以从不同角度，不同方式来输出计算结果。 

(1)点击“后处理”—>“结构力学”—>“三维刚架”，如图 9-2-20

所示。 

 
图 9-2-20 进入后处理结果分析 

(2)点击菜单【View results】-【Contour fill】-【unoda0】，

如图 9-2-21 所示，显示得到轴力分布图，如图 9-2-22 所示。 

 
图 9-2-21 选择渗流压力水头云图 
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图 9-2-22 

9.3 二维板壳问题 

9.3.1 问题描述 

平面二维板，材料参数如下：弹性模量 EX=2e11N/m2，泊松比

PRXY=0.3，板厚 H=0.1m，水平方向承受 q=100 的均布力。 

9.3.2 求解步骤 

选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 9-3-1 所示的对话框。 
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图 9-3-1  选择项目类型对话框 

(2)点击“问题类型”栏中的“二维板壳”选项。如图 9-3-1 所

示。 

(3)点击“OK”按钮完成项目类型的选择。 

设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 9-3-2 所示。或

者单击工具条中的 按钮弹出如图 9-3-3 所示材料参数数据输入表

格。 
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图 9-3-2  选择材料参数输入 

 

 

图 9-3-3  材料参数输入对话框 

 
(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 9-3-4 所示。                 
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图 9-3-4  填写完成材料数据输入 

 

建模、设置材料属性和施加边界条件 
(1) 启动 GID 以创建模型。点击菜单选择“前处理”—>“结构

力学”—>“二维板壳”，如图 9-3-5 所示；或者单击工具条中的 按

钮弹出前处理初始化窗口。 

 
图 9-3-5  启动前处理 

 

(2) 建模。a. 如下图 9-3-6 所示，点击【Geometry】—【Create】—

【Line】, 
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图 9-3-6 点击 Line 菜单项 

 

然后在 GID 命令栏依次输入点坐标：0,0，按 ENTER 键；输入 2，0,

按 ENTER；输入 2,1，按 ENTER 键；输入 0,1,按 ENTER 键；输入 0,0,

按 ENTER；接着按 Esc 键。最后模型如图 9-3-7： 

 
图 9-3-7 

 
b 选择问题类型。点击菜单【Data】-【Problem Type】-【sci】，

弹出“Dialog Window”，点击“确定”按钮即可。 
c 定义边界条件。①点击 Conditions 对话框中的 ，选中

line-plate2da，修改Conditions对话框中的w-1为-1,s-1为-1,o-1

为-1,并保持w-D，s-D和o-D的值为0.0不变，然后点击图中的Assign

按钮，选中区域两边的边界，然后点击Conditions对话框中的Finish

按钮。这样，边上的 line-plate2da 施加完毕。点击 Conditions 对

话框中的 Close 按钮,最后结果如图 9-3-7-8。 
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图 9-3-8 

②点击 Conditions 对话框中的 ，然后选择 Surface-csuq4m，

在 mate Num 栏中输入材料代号 1，然后点击图中的 Assign 按钮，选

择整个面，然后点击 Conditions 对话框中的 Finish 按钮。最后结果

如图 9-3-9。 

 
图 9-3-9 
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划分网格和导出数据 
(1).划分网格。点击菜单【Meshing】-【Generate】，在弹出的要求

输入单元尺寸大小对话框中输入“5”，如图 9-3-10 所示，点击“OK”

按钮，即可生成网格模型。 

 
图 9-3-10  设置网格特征尺寸 

此时弹出“Progress in meshing”进度条，网格划分完毕后弹出消

息框显示总的单元数和节点数，如图 9-3-11 所示。 

 

图 9-3-11 消息框 

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【Files】

-【Save】菜单，保存为 GID 文件。点击菜单【Calculate】-【Calculate】，

弹出“process info”消息框，如图 9-3-12 所示，点击“OK”按钮，
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然后退出 Gid，至此前处理工作结束。 

 
图 9-3-12 转化数据消息框 

9.3.3 有限元计算 

(1) 点击菜单选择“计算”—>“结构力学”—>“二维板壳”，

如图 9-3-13所示。或者单击工具条中的 按钮弹出如图 9-3-14 所示

计算模拟窗口。 

 
图 9-3-13  启动有限元计算 
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图 9-3-14  计算模拟窗口 
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9.3.4 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度，不同方式来输出计算结果。 
(1) 点击“后处理”—>“结构力学”—>“二维板壳”，如图 9-3-15

所示。 

 
图 9-3-15 进入后处理结果分析 

(2) 点击菜单【View results】-【Contour fill】-【unoda0】，显示

得到结果，如图 9-3-16所示。 

 
图 9-3-16 
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9.4 三维板壳问题 

9.4.1 问题描述 

长度 L=50m，厚度 t=0.25m，半径 r=25m，密度ρ =36.7347kg/m3

的开口圆柱形屋顶，在两端由墙支撑，所对应的圆心角θ =40°（如

图 9-4-1）。已知材料的弹性模量 E=432MPa，泊松比μ =0，重力加速

度取 g=9.8m/s2，求屋面中部 A 点的位移。

 
图 9-4-1 

9.4.2 求解步骤 

选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 9-4-2 所示的对话框。 



 270 

 

图 9-4-2  选择项目类型对话框 

(2)点击“问题类型”栏中的“三维板壳”选项。如图 9-3-1 所

示。 

(3)点击“OK”按钮完成项目类型的选择。 

设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 9-4-3 所示。或

者单击工具条中的 按钮弹出如图 9-4-4 所示材料参数数据输入表

格。 
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图 9-4-3  选择材料参数输入 

 

图 9-4-4  材料参数输入对话框 

(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 9-4-5 所示。 
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图 9-4-5  填写完成材料数据输入 

建模、设置材料属性和施加边界条件 
(1) 启动 GID 以创建模型。点击菜单选择“前处理”—>“结构

力学”—>“二维板壳”，如图 9-4-6 所示；或者单击工具条中的 按

钮弹出前处理初始化窗口。 

 

图 9-4-6  启动前处理 

(2) 建模。a. 如下图 9-4-7 所示，点击【Geometry】—【Create】—
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【Arc】, 

 

图 9-4-7 点击 Line 菜单项 

然后在 GID 命令栏依次输入点坐标：0,25，按 ENTER 键；输入 8.5505，

23.4923,按 ENTER；输入 6.0697,19.1511，按 ENTER 键；接着按 Esc
键。得到圆弧如图 9-4-8： 

 

图 9-4-8 
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选择【Utilities】-Copy 选项，如图 9-4-9 所示，在 Entities type 下拉

菜单中选择 Lines，First point 设置(0,0,0)作为起始点坐标，在 Second 
point 中设置(0,0,25)，在 Do extrude 选项菜单中，选择 Surfaces 以使

复制后的两条弧线间生成我们需要的曲面。最后生成模型如图 9-4-10
所示 

 
图 9-4-9 
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图 9-4-10 

b 选择问题类型。点击菜单【Data】-【Problem Type】-【sci】，
弹出“Dialog Window”，点击“确定”按钮即可。 

c 定义边界条件。①点击 Conditions 对话框中的 ，选中

point-plate2da，分别设置 u-l,v-l,w-l,s-l,o-l,c-l 相应栏目中值

为-1，1，-1，-1，-1，-1 并且保持 u-D,v-D,w-D,s-D,o-D,c-D 相应

栏目中值为 0.0，点击 Assign 按钮，选中图 9-4-11 中所示的绿色标

记的点；分别设置 u-l,v-l,w-l,s-l,o-l,c-l 相应栏目中值为-1，-1，

1，1，-1，-1 并且保持 u-D,v-D,w-D,s-D,o-D,c-D 相应栏目中值为

0.0，点击 Assign 按钮，选中图 9-4-11 中所示的黄色标记的点。 
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图 9-4-11 

②点击 Conditions 对话框中的 ，选中 line-plate2da，分别

设置 u-l,v-l,w-l,s-l,o-l,c-l 相应栏目中值为 1，1，-1，-1，-1，

1 并且保持 u-D,v-D,w-D,s-D,o-D,c-D 相应栏目中值为 0.0，点击

Assign 按钮，选中图 9-4-12 中所示的绿色标记的边；分别设置

u-l,v-l,w-l,s-l,o-l,c-l 相应栏目中值为-1，-1，1，1，1，-1 并

且保持 u-D,v-D,w-D,s-D,o-D,c-D 相应栏目中值为 0.0，点击 Assign

按钮，选中图 9-4-12 中所示的黄色标记的边；分别设置

u-l,v-l,w-l,s-l,o-l,c-l 相应栏目中值为-1，1，1，1，-1，-1 并

且保持 u-D,v-D,w-D,s-D,o-D,c-D 相应栏目中值为 0.0，点击 Assign

按钮，选中图 9-4-12 中所示的蓝色标记的边。 
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图 9-4-12 

④ 点击 Conditions 对话框中的 ，然后选择 Surface-csuq4m，在

mate Num 栏中输入材料代号 1，然后点击图中的 Assign 按钮，选

择整个面，然后点击 Conditions 对话框中的 Finish 按钮。最后

结果如图 9-4-13。 
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图 9-4-13 

划分网格和导出数据 
(1).划分网格。点击菜单【Meshing】-【Generate】，在弹出的要求

输入单元尺寸大小对话框中输入“3”，如图 9-4-14 所示，点击“OK”

按钮，即可生成网格模型。 

 
图 9-4-14  设置网格特征尺寸 

此时弹出“Progress in meshing”进度条，网格划分完毕后弹出消

息框显示总的单元数和节点数，如图 9-4-15 所示。 
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图 9-4-15 消息框 

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【Files】

-【Save】菜单，保存为 GID 文件。点击菜单【Calculate】-【Calculate】，

弹出“process info”消息框，如图 9-4-16 所示，点击“OK”按钮，

然后退出 Gid，至此前处理工作结束。 

 

图 9-4-16 转化数据消息框 

9.4.3 有限元计算 

(1) 点击菜单选择“计算”—>“结构力学”—>“二维板壳”，

如图 9-4-17所示。或者单击工具条中的 按钮弹出如图 9-4-18 所示
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计算模拟窗口。 

 
图 9-4-17  启动有限元计算 

 

图 9-4-18  计算模拟窗口 
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9.4.4 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度，不同方式来输出计算结果。 
(3) 点击“后处理”—>“结构力学”—>“二维板壳”，如图 9-4-19

所示。 

 
图 9-4-19 进入后处理结果分析 

(4) 点击菜单【View results】-【Contour fill】-【unoda0】，显示

得到结果，如图 9-4-20所示。 
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图 9-4-20 计算结果云图 

 

9.5 二维桁架问题 

9.5.1 问题描述 

已知一屋架如图 9-4-1 所示，截面尺寸及材料性能见表 1，L=12m，

P=39kN。 
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图 9-5-1 

 

理论解 C 点的竖向位移为： 

1.67c cm   
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我们可以采用二维桁架的公式库生成计算程序，建立模型如图9-5-8，

并计算，得出的位移云图如图9-5-17，C 点的竖向位移为 1.6614cm。 

 

9.5.2 求解步骤 

选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 9-5-2 所示的对话框。 

 

图 9-5-2  选择项目类型对话框 

(2)点击“问题类型”栏中的“二维桁架”选项。如图 9-5-2 所

示。 

(3)点击“OK”按钮完成项目类型的选择。 
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设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 9-5-3 所示，或

者单击工具条中的 按钮弹出如图 9-5-4 所示材料参数数据输入表

格。 

 
图 9-5-3  选择材料参数 

 

图 9-5-4  材料参数输入对话框 

(5) 按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 9-5-5 所示。 
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图 9-5-5 填写完成材料数据输入 

建模、设置材料属性和施加边界条件 
(1) 启动 GID 以创建模型。点击菜单选择“前处理”—>“结构

力学”—>“二维桁架”，如图 9-5-6 所示。或者单击工具条中的 按

钮，均弹出前处理初始化窗口。 

 
图 9-5-6  启动前处理 
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 (2) 建模。a. 如下图 9-5-7 所示，点击【Geometry】—【Create】—

【Line】, 

 
图 9-5-7 点击 Line 菜单项 

然后在 GID 命令栏依次输入点坐标：0,0，按 ENTER 键；输入 333.6，

0,按 ENTER；输入 866.4,0，按 ENTER 键；输入 1200,0,按 ENTER 键；

输入 900,50,按 ENTER；输入 600,100，按 ENTER 键；输入 300,50，

按 ENTER 键；输入 0,0，按 ENTER 键；接着按 Esc 键，最后得到如图

9-5-8： 

 

图 9-5-8 模型 
b.选择问题类型。点击菜单【Data】-【Problem Type】-【SCI】，

弹出“Dialog Window”，点击“确定”按钮即可。 
c.定义边界条件①如图 9-5-9 所示，点击 Conditions 对话框中的

，加入关于线的条件，如材料号、初值、边值等。如图所示，选

择 point-bar2da，然后分别设各点的值为如图 9-5-9 所示：u-1 为 1，

v-1 为-1，u-D 和 v-D 都为 0.0，点击 Assign 按钮，选中代表 A点的

左下角的支点；设置 u-1 为 1，u-D 为 0.0，v-1 为 1，v-d 为-39.0e3，

点击 Assign 按钮，选中桁架中的各节点；设置 u-1 为-1，u-D 为 0.0，
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v-1 为-1，v-D 为 0.0，点击 Assign 按钮，选中代表 B点的右下角的

铰点；最后，分别选中区域中的各点。然后，点击 Conditions 对话

框中的 Finish 按钮，最后结果如图 9-5-9。 

 
图 9-5-9 

②点击 Conditions 对话框中的 ，选中 Line-trull2，修改

Conditions 对话框中的 mate Num 分别设置为 4，点击图中的 Assign

按钮，选择图 9-5-10 中标记为绿色的杆；修改 mate Num 值为 3，点

击图中的 Assign 按钮，选择图 9-5-10 中标记为黄色的杆；修改 mate 

Num 值为 1，点击图中的 Assign 按钮，选择图 9-5-10 中标记为蓝色

的杆；修改 mate Num 值为 2，点击图中的 Assign 按钮，选择图 9-5-10

中标记为紫色的杆；修改 mate Num 值为 5，点击图中的 Assign 按钮，

选择图 9-5-10 中标记为青色的杆，然后点击 Conditions 对话框中的

Finish 按钮。这样，边上的 Line-trull2 施加完毕。点击 Conditions

对话框中的 Close 按钮,最后结果如图 9-5-10 所示。 
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图 9-5-10 
划分网格和导出数据 

(1).划分网格。点击【Meshing】-【Generate】弹出“Enter Value 
window”对话框，要求定义单元尺寸大小，保持默认值，点击“ok”，
如图 9-5-11 所示。 

 
图 9-5-11 保持单元大小默认值不变 

此时弹出“Progress in meshing”进度条，网格划分完毕后弹出消

息框显示总的单元数和节点数，如图 9-5-12 所示。 
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图 9-5-12  Dialog window 

点击“OK”按钮后即可得到划分完的网格模型。得到如图 9-5-13

所示网格剖分图。 

 
图 9-5-13 生成网格模型 

（2）.把前处理数据转化为 SciFEA 所需计算格式。点击【Files】
-【Save】菜单，保存为 GID 文件。点击菜单【Calculate】-【Calculate】，
弹出“process info”消息框，如图 9-5-14 所示，点击“ok”按钮，

然后退出 Gid，至此前处理工作结束。 

 
图 9-5-14  转化数据消息框 
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9.5.3 有限元计算 

(1) 点击菜单选择“计算”—>“结构力学”—>“二维桁架”，如图

9-5-15 所示。或者单击工具条中的 按钮弹出如图 9-5-16 所示计算

模拟窗口。 

 
图 9-5-15  启动有限元计算 
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图 9-5-16 计算模拟窗口 

9.5.4 结果分析 

(对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度、不同方式来输出计算结果。删除) 

(1)点击 按钮直接进入【GID】。 

(2)点击菜单【File】-【Postprocess】进入后处理程序。 
(3)点击菜单【View results】-【Contor Fill】-【unoda0】，如图

9-5-17 所示。 
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图 9-5-17 
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9.6 三维桁架问题 

9.6.1 问题描述 

    空间三维桁架，弹性模量 EX=2.1e11N/m2，截面面积 A=0.01m2。

具体尺寸、荷载见算例。 

9.6.2 求解步骤 

9.5.2a 选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 9-5-1 所示的对话框。 

 
图 9-6-1  选择项目类型对话框 

(2)点击“问题类型”栏中的“三维桁架”选项。如图 9-6-1 所
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示。 

(3)点击“OK”按钮完成项目类型的选择。 

9.5.2b 设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 9-6-2 所示。或

者单击工具条中的 按钮弹出如图 9-6-3 所示材料参数数据输入表

格。 

 
图 9-6-2  选择材料参数输入 

 
图 9-6-3  材料参数输入对话框 

(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 9-6-4 所示。 
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图 9-6-4  填写完成材料数据输入 

 
9.5.2c 建模、设置材料属性和施加边界条件 

(1) 启动 GID 以创建模型。点击菜单选择“前处理”—>“结构

力学”—>“三维桁架”，如图 9-6-5 所示；或者单击工具条中的 按

钮弹出前处理初始化窗口。 

 
图 9-6-5  启动前处理 

(2) 建模。a. 如下图 9-6-6 所示，点击【Geometry】—【Create】
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—【Line】, 

 

图 9-6-6 点击 Line 菜单项 

然后在 GID 命令栏依次输入点坐标：0,0，按 ENTER 键；输入 0，1,

按 ENTER；输入 0,0，1，按 ENTER 键；输入 1,0,按 ENTER 键；接着

按 Esc 键，最后模型如图 9-6-7： 

 

图 9-6-7  模型 

 

b.选择问题类型。如图 9-6-8 所示，点击菜单【Data】-【Problem 
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Type】-【SCI】，将弹出如图 9-6-9 所示对话框，点击“确定”按钮

即可。 
 

     

图 9-6-8 选 FEPG           图 9-6-9 Dialog Window 

 

c.定义材料特性、边界条件。如图点击【Data】—【Conditions】， 

弹出如图 9-6-10 的 Conditions 对话框。 

 
图 9-6-10 Conditions 

①定义边界条件。点击 Conditions 对话框中的 ，加入关于线

的条件，如材料号、初值、边值等。如图所示，选择 point-bar3da,

然后分别设各点的值为如图u-1为1,v-1为 1,w-1为 1；u-1为-1,v-1

为-1,w-1 为-1；u-1 为 15,v-1 为 15,w-1 为 1；最后点击 Assign 按

钮，分别选中区域中的各点。然后，点击 Conditions 对话框中的

Finish 按钮，最后结果如图 9-6-11。 
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图 9-6-11 

②点击 Conditions 对话框中的 ，选中 Line-trull2，修改

Conditions对话框中的mate Num为 1,然后点击图中的Assign按钮，

选中区域所有的边界然后，点击Conditions对话框中的Finish按钮。

这样，边上的 line- fouri2da 施加完毕。点击 Conditions 对话框中

的 Close 按钮,最后结果如图 9-6-12。 
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图 9-6-12 

9.5.2d 划分网格和导出数据 

(1).划分网格。点击菜单【Meshing】-【Generate】，弹出“Enter 

Value window”对话框，要求定义单元尺寸大小，输入“100”，点击

“ok”按钮，如图 9-6-13 所示。 

 

图 5-13 定义单元尺寸大小 

此时弹出“Progress in meshing”进度条，网格划分完毕后弹出消

息框显示总的单元数和节点数，如图 9-6-14 所示,点 OK。 
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图 9-6-14 消息框 
 

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【Files】

-【Save】菜单，保存为 GID 文件。点击菜单【Calculate】-【Calculate】，

弹出“process info”消息框，如图 9-6-15 所示，点击“ok”按钮，

然后退出 Gid，至此前处理工作结束。 

 

图 9-6-15 转化数据消息框 
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9.6.3 有限元计算 

(1) 点击菜单选择“计算”—>“结构力学”—>“三维桁架”，如图

9-6-16 所示。或者单击工具条中的 按钮弹出如图 9-6-17 所示计算

模拟窗口。 

 
图 9-6-16 启动有限元计算 

 
图 9-6-17 计算模拟窗口 
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9.6.4 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度，不同方式来输出计算结果。 
(1)点击“后处理”—>“结构力学”—>“三维桁架”，如图 9-6-18
所示。 

 
图 9-6-18 进入后处理结果分析 

(2) 点击 按键，然后再点菜单【View results】-【Contour fill】
-【unoda0】，显示最后一个时间步温度场云图分布，如图

9-6-19 所示。 

 
图 9-6-19 
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第10章 流固耦合 

10.1 二维 Biot 固结问题 

10.1.1 问题描述 

 
图 10-1-1 计算模型示意 

如图 1 所示，计算有限厚土层受均布局部荷载所引起的固结。土层厚

12h m ，顶部透水，底面不透水，受宽度 6B m 的均布局部荷载

4 21.96 10 /q N m  ，土的弹性模量
6 23.92 10 /E N m  ，泊松比 0.3  ，

渗透系数
32.16 10 /k m d  （米/天）。 

10.1.2 问题分析 
由于土层在横向上是可以透水的，但在为了简化问题的模型，我们可以选

取较大的横向尺寸，在本例中，选取长为36m，宽为12m的一块面积。 
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10.1.3 前处理 

选择项目 

 
图 10-1-2 选择项目类型 

 
如图 10-1-2 所示，启动 SciFEA，选择“项目”下的“新建项目”菜单，

弹出如下对话框，填写项目名称，点击“问题类型”中的二维 Biot 固结选项，

点击“OK”完成项目类型的选择。 
 

设置材料参数和边界条件 
 
（1）选择“前处理”中的“材料参数” 
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图 10-1-3（a）、材料参数 

 

     图 10-1-3（b）、材料参数 
 

如图 10-1-3 所示，填写材料参数如图中所示数值，填写完成后，点击“保

存”后退出。 
 

       （2）选择“前处理”中的“边界条件” 

 
图 10-1-4、边界条件 
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     如图 10-1-4 所示，表示的是力和流量的边界条件，总共有两组，通过点

击“增加”来新增加另一组数据。输入具体的参数值见图 10-1-4 中。 
 

10.1.4 建模、施加边界条件和设置材料属性 

 
（1）启动 GiD 

 

图 10-1-5 启动 GiD 
       如图 10-1-5 所示，点击“前处理”－〉“流固耦合”－〉“二维 Biot 固
结”。 
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（2）建模 
 
第一步，画线。 
    

 
图 10-1-6  创建直线 

 
如图 10-1-6 所示，点击“Geometry”-〉“create”-〉“line” 

紧接着，在命令行中输入坐标：（0，0）、（15，0）、（21，0），（36，0），
（36，12），（21，12）、（15，12）、（0，12），（0，0）。 
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图 10-1-7  命令窗口                    图 10-1-8  连接点对话框 

     
在连接点处的对话框中，点击“JION”连接这两个点为一点，以下相同。

这样创建出来的线框模型如下图 10-1-9 所示 

     
图 10-1-9  线框模型（1）             图 10-1-10  线框模型（2） 

 
再次输入结点（15，0）、（15，12）；（21，0）、（21，12），从而整个图

形的线框模型就创立完成，最终如上图 10-1-10 所示 
        

第二步，生成 3 个面 
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图 10-1-11  创建面 

    如图 10-1-11 所示，点击“Geometry”—〉“create” —〉“NURBS surface” 
—〉“By Contour”，启动面的创建。 

 
图 10-1-12  选择线来创建面 

 
     如图 10-1-12 所示，选择四条边（图 10-1-12 中红线所示）来创建平面。 
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（3）施加力和流量边界条件 

 
图 10-1-13  选择“sci” 

 

          
图 10-1-14                        图 10-1-15 

 
如图 10-1-13 所示，点击“Date”—〉“Problem type” —〉“sci”，然后如

图 10-1-14 所示，在弹出的对话框中点击“OK”，最后点击“Date”—〉“Condition”
启动边界条件填写。 

第一步，施加流量边界条件 
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图 10-1-16 

 
图 10-1-17 
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在对话框中选择“line-all2”（如图 10-1-16），然后在“mate Num”栏中填

写“1”，再点 
击“Finish”选择图形中所示红线。 

 
第二步，施加力的边界条件 

 

图 10-1-18  力的边界条件 
 

    在“mate Num”栏中填写“2”，再点击“Finish”选择图形中所示红

线。 
 
第三步，设置位移和水压边界条件 
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图 10-1-19 

 
 

 

图 10-1-20 
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图 10-1-21 
 

     如图 10-1-19 所示，选择“line-biot2da”，具体的数值也如图 10-1-19 所示，

（-1 表示固定值，1 表示值可变），再选择模型中红色线条；同样地，重复按

图 10-1-21 所示，完成位移和水压边界条件的设置。 
（4）设置材料属性 

 

 
图 10-1-22、设置材料属性 
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如图 10-1-21 所示，选择“Surface-aeq4”，在“mate Num”中填写“1”，

点击“finish”，最后选择整个面，这样就完成了材料属性的赋值。 
 

10.1.5 划分网格 

 
(1)  设置边的节点 

 

 
图 10-1-23、设置边节点 
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图 10-1-24、设置划分的数目 

      
图 10-1-25、选择上下边             图 10-1-26、选择左右边 

 

(2) 设置单元类型       
图 10-1-27、选择单元类型 
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    如图 10-1-27 所示，点击“Meshing”—〉“Element type”—〉“Quadrilateral”，
在弹出的对话框中点击“OK”； 
(3)  划分网格  

 

  

图 10-1-28                        图 10-1-29 网格示意 
如图 10-1-28 所示，点击“Meshing”—〉“Generate”，在在弹出的对话框

中点击“OK”，网格划分成功，网格如图 10-1-29 所示。 
 

(4)  生成 SciFEA 文件 

           
图 10-1-30                             图 10-1-31 
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    如图 10-1-30 所示，点击“Calculate”—〉“Calculate”，将弹出如图 10-1-31
所示的对话框，在点击“OK”按钮，保存，并退出 GiD。 
 

10.1.6 计算 

回到 SciFEA 软件，点击图标 ，启动计算程序，如图 10-1-32 所示。 

 
图 10-1-32  计算程序显示 
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10.1.7  后处理 

(1)  点击 按钮启动 GiD 的后处理； 

(2)  点击 查看计算给果的云图； 
(3)   查看等值线图； 

 
图 10-1-33  查看等值线图 

点击“View results”—〉“Contour Lines”，其中，“unodp0”表示孔压，

“unodq0”表示流量，“unodu0”表示位移，“unods0”表示应力。 
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图 10-1-34   y 方向的位移变形图 
(4)  变形矢量图 

 

 
图 10-1-35   查看矢量图 



 322 

点击“View results”—〉“Display Vectors”，其中， “unodq0”表示

流量，“unodu0”表示位移，“unods0”表示应力。 

 
                        图 10-1-36  整体的变形矢量图 

10.1.8 查看变形图 

 
图 10-1-37  查看变形图 

点击“View results”—〉“Defomation”，其中， “unodq0”表示流量，

“unodu0”表示位移。 
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图 10-1-38  查看变形云图 
 

10.2 三维 Biot 固结问题 

10.2.1 问题描述 

 
图 10-2-1  计算模型 
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如图 1 所示，计算有限厚土层受均布局部荷载所引起的固结。土层厚

12h m ，顶部透水，底面和侧面不透水，受边长为 6m 的均布局部荷载

4 21.96 10 /q N m  ，土弹性模量 6 23.92 10 /E N m  ，泊松比 0.3  ，

渗透系数 32.16 10 /k m d  （米/天）。 

10.2.2 前处理 

1、选择项目 
     参见二维 biot 分析，启动 SciFEA，选择“项目”下的“新建项目”菜单，

弹出如下对话框，填写项目名称，点击“问题类型”中的三维 Biot 固结选项，

点击“OK”完成项目类型的选择。 
2、设置材料参数和边界条件 

      与二维 biot 分析相同，参见二维 biot 例子。 
3、建模、施加边界条件和设置材料属性 
（1）启动 GiD   

 

图 10-2-2  启动 GiD 
     （2）建模 
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第一步、画线以及建立底面。 

 
图 10-2-3  创建直线 

      通过命令行输入坐标（6，0，0）、（12，0，0）和（18，0，0），再点击

菜单栏的“Utilities”—〉“copy”，如下图所示 

 
图 10-2-4、由线生成面 
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在弹出的 “copy”栏中，具体的参数设置见下图： 

 
图 10-2-4  copy 工具 

 
 
 

参数设置完成后，点击“Select”选择绘图工作区的线，如下图所示 
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图 10-2-5  选择要复制的线 
 
再安“Esc”或 copy 工具栏上的“Finish”，有的底面的第一组面 
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图 10-2-6  生成了第一组面 
重复图 10-2-5、图 10-2-6 中的操作，就可得到建好的底面图 
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图 10-2-7、完成了底面 

 
第二步，由面生成体 
同样运用“copy”按钮来建立体，其参数设置为 
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图 10-2-8  参数设置 

选择图中的所有的面，就能得到如下的体 
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图 10-2-9  建好的体 
（3）施加力和流量边界条件 

 
图 10-2-10  旋转“sci” 
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图 10-2-11                                   图 10-2-12 

如图 10-2-10 所示，点击“Date”—〉“Problem type” —〉“sci”，然后如

图 10-2-11 所示，在弹出的对话框中点击“OK”，最后点击“Date”—〉“Condition”
启动边界条件填写。 

 
第一步，施加流量边界条件和力的边界条件 
施加的方法可参见二维例子，在顶面中央处为力边界条件，其他的周围表

面为流量边界条件，如下图所示 

 
图 10-2-13  施加流量边界条件和力的边界条件 

第二步，设置位移和水压边界条件 
施加的方法也可参见二维例子。在本例中，上表面：位移不约束，水压约

束为 0；四周以及底表面位移约束，水压不约束。位移和水压边界条件如下图

所示 
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图 10-2-14  施加位移和水压边界条件 

 
（4）设置材料属性 

     材料属性的设置与二维情况类似，材料性质赋予给这个模型。 
 

4、结构化划分体网格 
 
（1）设定边的等分数量 
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图 10-2-15  选择结构化划分体网格 
选择“meshing”—〉“Structured”—〉“Volumes”，如图 10-2-15，再选择整

个模型体，然后弹出提示将线分成多少份的对话框，，如下图 

 
图 10-2-16  设置边的份数 

在本例中，选择划分为：6，如图 10-2-16 所示，然后再选择这个模型的线，这

样就分配成功。 
 

（2）选择划分单元的类型 
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图 10-2-17  选择划分单元的类型 

如图 10-2-17 所示，选择“Meshing”—〉“Element type”—〉“Hexahedra”
（六面体）网格类型，在弹出对话框中，点击“OK”后，选择整个模型。 

 
（3）生成网格 

在弹出的对话框中，设值为“6”，点击“OK”，就能得到网格图，如下图 10-2-18
所示： 
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图 10-2-18  有限元网格 

 
5、生成 SciFEA 文件 
 

      
         图 10-2-19                       图 10-2-20 

 
如图 10-2-19 所示，点击“Calculate”—〉“Calculate”，将弹出如图 10-2-31

所示的对话框，再点 
击“OK”按钮，保存，并退出 GiD。 
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10.2.3 计算 

回到 SciFEA 软件，点击图标 ，启动计算程序，如图 32 所示。 

 

                         图 10-2-21  计算时的信息  
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10.2.4 后处理 

（1）点击 按钮启动 GiD 的后处理； 

（2）点击 查看计算给果的云图； 

（3）查看变形等值线图 

 
图 10-2-22  查看 z 方向的变形 

 
图 10-2-23  z 方向的变形图 
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第11章 热固耦合问题 

11.1 11.1.1 二维热弹性 

11.1.2 问题描述 

二维热弹性问题，导热系数 1E-6，弹性模量 2E11，泊松比 0.3，
热膨胀系数 1E-5，换热系数 1E-4，环境系数 2E-3，承受法向力 F=1E5，
求变形状态。 

11.1.3 求解步骤 

11.1.3a 选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 1-1-1 所示的对话框。 
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图 1-1-1 选择项目类型对话框 

(2)点击“问题类型”栏中的“二维热弹性”选项。如图 1-1-1
所示。 

(3)点击“OK”按钮完成项目类型的选择。 

11.1.3b 设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 1-1-2 所示。或

者单击工具条中的 按钮弹出如图 1-1-3 所示材料参数数据输入表

格。 

 
图 1-1-2 选择材料参数输入 
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图 1-1-3 材料参数输入对话框 
(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 1-1-6 所示。                 
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图 1-1-6 填写完成材料数据输入 

(2)选择“前处理”—>“边界条件”按钮，如图 1-1-5 所示。或

者单击工具条中的 按钮弹如图 1-1-6 所示数据输入表格。 

 
图 1-1-5  选择边界条件输入 
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图 1-1-6  边界条件输入对话框 

按照问题描述中的参数依次填入边界条件数据表格。填写完成后如图

1-1-7 所示。 

 
图 1-1-7  填写完成边界条件输入 
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11.1.3c 建模、设置材料属性和施加边界条件 
(1) 启动 GID 以创建模型。点击菜单选择“前处理”—>“热固耦

合”—>“二维热弹性”，如图 1-1-8 所示。或者单击工具条中的 按

钮弹出前处理初始化窗口。 

 
图 1-1-8 启动前处理 

(2) 建模。a. 如下图 1-1-9 所示，点击【几何模型】—【创建】—【直

线】, 
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图 1-1-9 点击 Line 菜单项 

然后在 GID 命令栏依次输入点坐标：0,0，按 ENTER 键；输入 12，0,

按 ENTER；输入 12,5，按 ENTER 键；输入 0,5,按 ENTER 键；输入 0,0,

按 ENTER 键；接着按 Esc 键。最后得到如图 1-1-10： 

 

图 1-1-10 模型 



 346 

b.选择问题类型。如图 1-1-11 所示，点击菜单【数据】-【问题

类型】-【SCI】，将弹出如图 1-1-12 所示对话框，点击“OK”按钮

即可。 

  
图 1-1-11 选 SCI           图 1-1-12 Dialog Window 

c.定义材料特性、边界条件。如图 1-1-13 点击【数据】—【条件】， 

弹出 Conditions 对话框。 

 

图 1-1-13 
⑤ 定义边界条件。如下图 1-1-14 所示，点击 Conditions 对话框中

的 ，施加边界条件，如图所示。最后点击 Conditions 对话框

中的 Finish 按钮，结束设置。 
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图 1-1-14 

⑥ 定义材料属性，选择 Condition 对话框中 的 Surface-aet3 选

项，在 mate Num 框中输入材料代号 1，点击 Assign 按钮，如图

1-1-15 所示。 
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图 1-1-15 

11.1.3d 划分网格和导出数据 
(1).划分网格。 

点击菜单【网格】-【Generate mash】，此时弹出“Progress in meshing”
进度条，网格划分完毕后弹出消息框显示总的单元数和节点数，如图

1-1-16 所示,点 OK 确认。 
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图 1-1-16 消息框 

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【文件】-

【保存】菜单，保存为 GID 文件。点击菜单【计算】-【计算】，

弹出“运行信息”消息框，如图 1-1-17 所示， 

点击“ok”按钮，然后退出 Gid，至此前处理工作结束。 

 
图 1-1-17 转化数据消息框 

11.1.4 有限元计算 
(1) 点击菜单选择“计算”—>“热固耦合”—>“二维热弹性”，

如图 1-1-18 所示。 
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图 1-1-18  启动有限元计算 

或者单击工具条中的 按钮弹出如图 1-1-19 所示计算模拟窗口。 

 
图 1-1-19 计算模拟窗口 
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11.1.5 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度，不同方式来输出计算结果。 
(9) 点击“后处理”—>“热固耦合”—>“二维热弹性”，如图

1-1-20 所示，或者直接点击后处理图标 。 

 
图 1-1-20 进入后处理结果分析 

(10) 点击 按键，然后再点菜单【View results】-【Contour fill】

-【unodb0】，显示最后一个时间步的变形云图分布，如图 1-1-21
所示。 
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图 1-1-21 变形云图 

 

11.2 11.2.1 三维热弹性  

11.2.2 问题描述 

三维热弹性问题，导热系数 1E-6，弹性模量 2E11，泊松比 0.3，
热膨胀系数 1E-5，试求变形状态。 

11.2.3 求解步骤 

11.2.3a 选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 1-3-1 所示的对话框。 
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图 1-3-1 选择项目类型对话框 

(2)点击“问题类型”栏中的“三维热弹性”选项。如图 1-3-1
所示。 

(3)点击“OK”按钮完成项目类型的选择。 

11.2.3b 设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 1-3-2 所示。或

者单击工具条中的 按钮弹出如图 1-3-3 所示材料参数数据输入表

格。 
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图 1-3-2 选择材料参数输入 

 

图 1-3-3 材料参数输入对话框 
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(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 1-3-4 所示。                 

 
图 1-3-4 填写完成材料数据输入 

 

11.2.3c 建模、设置材料属性和施加边界条件 
 

(1) 启动 GID 以创建模型。点击菜单选择“前处理”—>“热固耦

合”—>“三维热弹性”，如图 1-3-8 所示。或者单击工具条中的 按

钮弹出前处理初始化窗口。 
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图 1-3-8 启动前处理 

 

(2) 建模。a. 如下图 1-3-9 所示，点击【几何模型】—【创建】—【物

体】—【多边形棱柱】, 
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图 1-3-9 点击物体菜单项 

 

然后在菜单中设置边数为 4，接着再 GID 命令栏中输入中心点坐标

0,0，按 ENTER 键；选择 Z 方向作为延伸的方向，输入半径 2.25,按

ENTER；输入 6，按 ENTER 键。得到模型如图 1-3-10： 
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图 1-3-10 模型 

b.选择问题类型。如图 1-3-11 所示，点击菜单【数据】-【问题

类型】-【SCI】，将弹出如图 1-3-12 所示对话框，点击“OK”按钮

即可。 

     
图 1-3-11 选 SCI         图 1-3-12 Dialog Window 

c.定义材料特性、边界条件。如图 1-3-13 点击【数据】—【条件】， 

弹出 Conditions 对话框。 

 
图 1-3-13 
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⑦ 定义边界条件。点击 Conditions 对话框中的 ，施加边界条件，

如图所示，施加约束详见图 1-3-14。 

 

图 1-3-14 

⑧ 定义材料属性，选择 Condition 对话框中的 Volume-aew4 选项，

在 mate Num 框中输入材料代号 1，点击 Assign 按钮，如图 1-3-15
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所示。 
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图 1-3-15 

11.2.3d 划分网格和导出数据 
(1).划分网格。 

点击菜单【网格】-【Generate mash】，此时弹出“Progress in meshing”
进度条，网格划分完毕后弹出消息框显示总的单元数和节点数，如图

1-3-16 所示,点 OK 确认。 

 
图 1-3-16 消息框 

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【文件】-
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【保存】菜单，保存为 GID 文件。点击菜单【计算】-【计算】，

弹出“运行信息”消息框，如图 1-3-17 所示， 

点击“ok”按钮，然后退出 Gid，至此前处理工作结束。 

 
图 1-3-17 转化数据消息框 

11.2.4 有限元计算 
(1) 点击菜单选择“计算”—>“热固耦合”—>“三维热弹性”，

如图 1-3-18 所示。 

 
图 1-3-18  启动有限元计算 

或者单击工具条中的 按钮弹出如图 1-3-19 所示计算模拟窗口。 
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图 1-3-19 计算模拟窗口 

11.2.5 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度，不同方式来输出计算结果。 
(11) 点击“后处理”—>“热固耦合”—>“三维热弹性”，如

图 1-3-20 所示，或者直接点击后处理图标。 

 
图 1-3-20 进入后处理结果分析 
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(12) 点击 按键，然后再点菜单【View results】-【Contour fill】

-【unodb】，显示最后一个时间步的变形云图分布，如图 1-3-21
所示。 

 
 

图 1-3-21 变形云图 
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11.3 11.3.1 二维热弹性 

11.3.2 问题描述 

 
二维热弹性问题，导热系数 1E1，弹性模量 2E11，泊松比 0.3，

热膨胀系数 1E-5，换热系数 1E-4，环境系数 2E-3，底面固支（限制

全部自由度），左侧温度 0°，右侧温度 100°，求变形状态。 

11.3.3 求解步骤 

11.3.3a 选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 11-3-1 所示的对话框。 
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图 11-3-1 选择项目类型对话框 

(2)点击“问题类型”栏中的“二维热弹性”选项。如图 11-3-1
所示。 

(3)点击“OK”按钮完成项目类型的选择。 

11.3.3a 设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 11-3-2 所示。或

者单击工具条中的 按钮弹出如图 11-3-3 所示材料参数数据输入表

格。 
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图 11-3-2 选择材料参数输入 

 

图 11-3-3 材料参数输入对话框 
(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 1-1-4 所示。                 

 
图 11-3-4 填写完成材料数据输入 

(2)选择“前处理”—>“边界条件”按钮，如图 11-3-5 所示。
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或者单击工具条中的 按钮弹如图 11-3-6 所示数据输入表格。 

 
图 11-3-5  选择边界条件输入 

 
图 11-3-6  边界条件输入对话框 

按照问题描述中的参数依次填入边界条件数据表格。填写完成后如图

11-3-7 所示。 



 369 

 
图 11-3-7  填写完成边界条件输入 

11.3.3a 建模、设置材料属性和施加边界条件 
(1) 启动 GID 以创建模型。点击菜单选择“前处理”—>“热固耦

合”—>“二维热弹性”，如图 11-3-8 所示。或者单击工具条中的 按

钮弹出前处理初始化窗口。 

 
图 11-3-8 启动前处理 

(2) 建模。a. 如下图 11-3-9 所示，点击【几何模型】—【创建】—



 370 

【直线】, 

 
图 11-3-9 点击 Line 菜单项 

然后在 GID 命令栏依次输入点坐标：0,0，按 ENTER 键；输入 2，0,

按 ENTER；输入 2,1，按 ENTER 键；输入 0,1 ,按 ENTER 键；输入 0,0,

按 ENTER 键；接着按 Esc 键。最后得到如图 1-1-10： 

 

图 11-3-10 模型 
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b.选择问题类型。如图 1-1-11 所示，点击菜单【数据】-【问题

类型】-【SCI】，将弹出如图 11-3-12 所示对话框，点击“OK”按钮

即可。 

 
 

图 11-3-11 选 SCI 图 11-3-12 Dialog Window 
c.定义材料特性、边界条件。如图 11-3-13 点击【数据】—【条

件】， 弹出 Conditions 对话框。 

 

图 11-3-13 
⑨ 定义边界条件。如下图 11-3-14 所示，点击 Conditions 对话框中

的 ，施加边界条件，如图所示。最后点击 Conditions 对话框

中的 Finish 按钮，结束设置。 
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图 11-3-14 

⑩ 定义材料属性，选择 Condition 对话框中 的 Surface-aet3 选

项，在 mate Num 框中输入材料代号 1，点击 Assign 按钮，如图

11-3-15 所示。 
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图 11-3-15 
11.3.3a 划分网格和导出数据 
(1).划分网格。 

点击菜单【网格】-【Generate mash】，此时弹出“Progress in meshing”
进度条，网格划分完毕后弹出消息框显示总的单元数和节点数，如图
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11-3-16 所示,点 OK 确认。 

 
图 11-3-16 消息框 

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【文件】-

【保存】菜单，保存为 GID 文件。点击菜单【计算】-【计算】，

弹出“运行信息”消息框，如图 11-3-17 所示， 

点击“ok”按钮，然后退出 Gid，至此前处理工作结束。 

 
图 11-3-17 转化数据消息框 

11.3.4 有限元计算 
(1) 点击菜单选择“计算”—>“热固耦合”—>“二维热弹性”，



 375 

如图 11-3-18 所示。 

 
图 11-3-18  启动有限元计算 

或者单击工具条中的 按钮弹出如图 11-3-19 所示计算模拟窗

口。 

 
图 11-3-19 计算模拟窗口 
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11.3.5 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度，不同方式来输出计算结果。 
(13) 点击“后处理”—>“热固耦合”—>“二维热弹性”，如图

11-3-20 所示，或者直接点击后处理图标 。 

 
图 11-3-20 进入后处理结果分析 

(14) 点击 按键，然后再点菜单【View results】-【Contour fill】

-【unoda0】-【u】，显示最后一个时间步的变形云图分布，如

图 11-3-21 所示。 
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图 11-3-21 横向变形云图 
(15) 点击菜单【View results】-【Contour fill】-【unodb0】，显示

最后一个时间步的温度云图分布，如图 11-3-22 所示 

 
 

图 11-3-22 温度云图 
(16) 点击菜单【View results】-【Graphs】-【point evolution】-【unodc0】

-【Si-unodc0】，然后在图形中选中第 18 号节点，显示节点 18
处大主应力随时间演进图，如图 11-3-23 所示 
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图 11-3-23 节点 18 处大主应力随时间演进图 

 
 
 

11.4 11.4.1 三维热弹性  

11.4.2 问题描述 

三维热弹性问题，导热系数 1E-6，弹性模量 2E11，泊松比 0.3，
热膨胀系数 1E-5，试求变形状态。 

11.4.3 求解步骤 

11.4.3a 选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 11-4-1 所示的对话框。 
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图 11-4-1 选择项目类型对话框 

(2)点击“问题类型”栏中的“三维热弹性”选项。如图 11-4-1
所示。 

(3)点击“OK”按钮完成项目类型的选择。 

11.4.3b 设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 11-4-2 所示。或

者单击工具条中的 按钮弹出如图 11-4-3 所示材料参数数据输入表
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格。 

 
图 11-4-2 选择材料参数输入 

 

图 11-4-3 材料参数输入对话框 
(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 11-4-4 所示。                 
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图 11-4-4 填写完成材料数据输入 

11.4.3c 建模、设置材料属性和施加边界条件 
(1) 启动 GID 以创建模型。点击菜单选择“前处理”—>“热固耦

合”—>“三维热弹性”，如图 11-4-8 所示。或者单击工具条中的 按

钮弹出前处理初始化窗口。 

 
图 11-4-8 启动前处理 
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(2) 建模。a. 如下图 11-4-9 所示，点击【几何模型】—【创建】—

【物体】, 

 
图 11-4-9 点击物体菜单项 

多次重复使用建立几何模型功能，建立如图 11-4-10 所示的工件模型： 
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图 11-4-10 模型 

b.选择问题类型。如图 11-4-11 所示，点击菜单【数据】-【问题

类型】-【SCI】，将弹出如图 11-4-12 所示对话框，点击“OK”按钮

即可。 

  
图 11-4-11 选 SCI        图 11-4-12 Dialog Window 
c.定义材料特性、边界条件。如图 11-4-13 点击【数据】—【条

件】， 弹出 Conditions 对话框。 
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图 11-4-13 

⑪ 定义边界条件。点击 Conditions 对话框中的 ，施加边界条件，

分别选中 surface-eta 和 surface-etb，设置参数并指定面，如

图 11-4-14 所示。 
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图 11-4-14 

⑫ 定义材料属性，选择 Condition 对话框中的 Volume-aec8 选项，

在 mate Num 框中输入材料代号 1，点击 Assign 按钮，如图 11-4-15
所示。 
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图 11-4-15 

11.4.3d 划分网格和导出数据 
(1).划分网格。 

点击菜单【网格】-【Generate mesh】，此时弹出“Progress in meshing”
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进度条，网格划分完毕后弹出消息框显示总的单元数和节点数，如图

11-4-16 所示,点 OK 确认。 

 
图 11-4-16 消息框 

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【文件】-

【保存】菜单，保存为 GID 文件。点击菜单【计算】-【计算】，

弹出“运行信息”消息框，如图 11-4-17 所示， 

点击“ok”按钮，然后退出 Gid，至此前处理工作结束。 

 
图 11-4-17 转化数据消息框 

11.4.4 有限元计算 
(1) 点击菜单选择“计算”—>“热固耦合”—>“三维热弹性”，

如图 11-4-18 所示。 



 388 

 
图 11-4-18  启动有限元计算 

或者单击工具条中的 按钮弹出如图 11-4-19 所示计算模拟窗

口。 

 
图 11-4-19 计算模拟窗口 

11.4.5 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操
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作，可以从不同角度，不同方式来输出计算结果。 
(1) 点击“后处理”—>“热固耦合”—>“三维热弹性”，如图

11-4-20 所示，或者直接点击后处理图标。 

 
图 11-420 进入后处理结果分析 

(2) 点击 按键，然后再点菜单【View results】-【Contour fill】-

【unoda0】-【u】，显示最后一个时间步的变形云图分布，如图 11-4-21

 
 

图 11-4-21 横向变形云图 
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所示。 
(3) 点击菜单【View results】-【Contour fill】-【unodb0】，显示最

后一个时间步的温度云图分布，如图 11-4-22 所示 

  

图 11-4-22 温度云图 
(4) 点击菜单【View results】-【Graphs】-【point evolution】-【unodc0】

-【Si-unodc0】，然后在图形中选中第 18 号节点，显示节点 18
处大主应力随时间演进图，如图 11-4-23 所示 

 

 

图 11-4-23 节点 18 处大主应力随时间演进图 
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第12章 弹塑性问题 

12.1 平面应力问题 

12.1.1 问题描述 

本例中所使用的材料为低碳钢，材料参数如下表，本例中仅对

强化模型进行计算： 

模型类

型 

参

数 
材料 

弹性模量 
单位（Pa） 

泊松

比 

X 向 
体积

力 

Y 向 
体积

力 

屈服极限 
单位（Pa） 

强化系

数 

理想塑

性 
低碳

钢 
1.96e11 0.29 0 0 2.1e8 0 

强化模

型 
低碳

钢 
1.96e11 0.29 0 0 2.1e8 1.0e3 

问题类型为平面应力，模型及边界条件如下图： 
中心线

Δ y
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图 12-1-1 
模型单位取 m，加载方式为位移增量法，共 150 个载荷步，每

步位移载荷△y 为 1.0e-5m；使用 misses 准则。 

12.1.2 求解步骤 

选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 12-1-2 所示的对话框。 

 

图 12-1-2  选择项目类型对话框 
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(2)点击“问题类型”栏中的“二维塑性平面应力”选项。如图

12-1-2 所示。 

(3)点击“OK”按钮完成项目类型的选择。 

设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 12-1-3 所示。或

者单击工具条中的 按钮弹出如图 12-1-4 所示材料参数数据输入表

格。 

 
图 12-1-3  选择材料参数输入 
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图 12-1-4  材料参数输入对话框 
(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 8-1-5 所示。                 

 
图 12-1-5  填写完成材料数据输入 

 

(3) 选择“前处理”—>“边界条件”按钮，如图 12-1-6 所示。

或者单击工具条中的 按钮弹如图 12-1-7 所示数据输入表

格。 
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图 12-1-6 选择边界条件输入 图 12-1-7 边界条件输入对话框 
 (4)按照问题描述中的参数依次填入边界条件数据表格。填写完

成后如图 12-1-8 所示。 

 
图 12-1-8  填写完成边界条件输入 

建模、设置材料属性和施加边界条件 

(1) 启动 GID 以创建模型。单击工具条中的 按钮弹出如图

12-1-9 所示前处理初始化窗口。 
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图 12-1-9 前处理初始化窗口 

 
(2) 建模。a.点击菜单【模型】-【创建】-【直线】，创建直线，

在命令栏中依次输入坐标 0,0，按 Enter 键，输入 0.01,0，按 Enter 键，

输入 0.01,0.1，按 Enter 键，输入 0,0.1，按 Enter 键，输入 0,0，按 Enter
键，在跳出的对话框中选择“合并”，生成直线如图 12-1-10 所示。 
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图 12-1-10  生成直线 

b. 点击菜单【模型】-【创建】-【样条曲面】-【通过封闭的边

界线】，选中所有线以生成一个面，如图 12-1-11 所示。 
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图 12-1-11  生成面 

c.选择问题类型。点击菜单【数据】-【问题类型】-【sci】，弹出

“Dialog Window”，点击“确定”按钮即可。 
g.材料特性、初始条件。点击菜单【数据】-【条件】弹出“condition”

对话框。① 定义材料。点击表示面单元的按钮 ，选中下拉菜单中

的“Surface－aeq4”,在“mate Num”（即 Material Number）中填入

“1”，点击“指定”选择生成的面，点击“完成” 即定义好材料特

性。点击“绘图”选择“颜色”如图 12-1-12 所示。 
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图 12-1-12  定义材料特性 

① 定义边界位移。点击线单元按钮 ，选中下拉菜单中的

“line-ep2da”，在 u-I，u-D，v-I，v-D，所对应的四栏中分别填入

（1，0，-1，0），点击“指定”，选中下边界；然后按照上述方法

分别指定上边界为（1，0，-1，1.0e-5），右边界为（-1，0，1，0）。
点击“绘图”选择“颜色”如图 12-1-13 所示。 

 
图 12-1-13  设定边界条件 
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划分网格和导出数据 
(1).划分网格。点击菜单【网格剖分】-【产生网格】，如图 12-1-14

所示，点击“ok”按钮，即可生成网格模型如图 12-1-15 所示。 

 
图 12-1-14  生成网格对话框 

 

图 12-1-15  生成网格模型 

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【文件】-

【保存】菜单，保存为 GID 文件。点击菜单【计算】-【计算】，

弹出“process info”消息框，如图 12-1-16 所示，点击“ok”
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按钮，然后退出 Gid，至此前处理工作结束。 

 

图 12-1-16  转化数据消息框 

有限元计算 

点击工具条中的 按钮弹出如图 12-1-17 所示计算模拟窗口。 

 
图 12-1-17  计算模拟窗口 
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12.1.3 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度，不同方式来输出计算结果。 

(1) 点击后处理按钮 。 

(2) 点击菜单【结果显示】-【云图】-【unoda0】-【v】，如图 12-1-18
所示，显示得到竖向位移场云图分布，如图 12-1-19 所示。 

 
 

图 12-1-18 选择竖向位移场云图 图 12-1-19 竖向位移场云图 
(3) 点击菜单【结果显示】-【图表】-【点的时程曲线】-【unoda0】

-【syy】，如图 12-1-20 所示，显示得到点的竖向应力时程曲线分布，

如图 12-1-21 所示。 
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图12-1-20 选择点的竖向应力时程曲线 图 12-1-21 点的竖向应力时程曲线 

12.2 平面应变问题 

12.2.1 问题描述 

本例中所使用的材料为低碳钢，材料参数如下表，本例中仅对

强化模型进行计算： 

模型类

型 

参

数 
材料 

弹性模量 
单位（Pa） 

泊松

比 

X 向 
体积

力 

Y 向 
体积

力 

屈服极限 
单位（Pa） 

强化系

数 

理想塑

性 
低碳

钢 
1.96e11 0.29 0 0 2.1e8 0 

强化模

型 
低碳

钢 
1.96e11 0.29 0 0 2.1e8 1.0e3 

问题类型为平面应变，模型及边界条件如下图： 
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中心线
Δ y

 
图 12-2-1 

模型单位取 m，加载方式为位移增量法，共 50 个载荷步，每步

位移载荷△y 为 1.0e-5m；使用 misses 准则。 

12.2.2 求解步骤 

选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 12-2-2 所示的对话框。 
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图 12-2-2  选择项目类型对话框 

(2)点击“问题类型”栏中的“二维塑性平面应变”选项。如图

12-2-2 所示。 

(3)点击“OK”按钮完成项目类型的选择。 

设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 12-2-3 所示。或

者单击工具条中的 按钮弹出如图 12-2-4 所示材料参数数据输入表

格。 
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图 12-2-3  选择材料参数输入 

 

 
图 12-2-4  材料参数输入对话框 

(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 12-2-5 所示。                 
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图 12-2-5  填写完成材料数据输入 

 

(4) 选择“前处理”—>“边界条件”按钮，如图 12-2-6 所示。

或者单击工具条中的 按钮弹如图 12-2-7 所示数据输入表

格。 

 

 

图 12-2-6 选择边界条件输入 图 12-2-7 边界条件输入对话框 
 (4)按照问题描述中的参数依次填入边界条件数据表格。填写完

成后如图 12-2-8 所示。 
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图 12-2-8  填写完成边界条件输入 

建模、设置材料属性和施加边界条件 

(1) 启动 GID 以创建模型。单击工具条中的 按钮弹出如图

12-2-9 所示前处理初始化窗口。 

 
图 12-2-9 前处理初始化窗口 

(2) 建模。a.点击菜单【模型】-【创建】-【直线】，创建直线，

在命令栏中依次输入坐标 0,0，按 Enter 键，输入 0.01,0，按 Enter 键，

输入 0.01,0.1，按 Enter 键，输入 0,0.1，按 Enter 键，输入 0,0，按 Enter
键，在跳出的对话框中选择“合并”，生成直线如图 12-2-10 所示。 
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图 12-2-10  生成直线 

b. 点击菜单【模型】-【创建】-【样条曲面】-【通过封闭的边

界线】，选中所有线以生成一个面，如图 12-2-11 所示。 

 
图 12-2-11  生成面 

c.选择问题类型。点击菜单【数据】-【问题类型】-【sci】，弹出

“Dialog Window”，点击“确定”按钮即可。 
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d.材料特性、初始条件。点击菜单【数据】-【条件】弹出“condition”
对话框。① 定义材料。点击表示面单元的按钮 ，选中下拉菜单中

的“Surface－aeq4”,在“mate Num”（即 Material Number）中填入

“1”，点击“指定”选择生成的面，点击“完成” 即定义好材料特

性。点击“绘图”选择“颜色”如图 12-1-12 所示。 

 
图 12-2-12  定义材料特性 

② 定义边界位移。点击线单元按钮 ，选中下拉菜单中的

“line-ep2da”，在 u-I，u-D，v-I，v-D，所对应的四栏中分别填入

（1，0，-1，0），点击“指定”，选中下边界；然后按照上述方法

分别指定上边界为（1，0，-1，1.0e-5），右边界为（-1，0，1，0）。
点击“绘图”选择“颜色”如图 12-2-13 所示。 
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图 12-2-13  设定边界条件 

划分网格和导出数据 
(1).划分网格。点击菜单【网格剖分】-【产生网格】，如图 12-2-14

所示，点击“ok”按钮，即可生成网格模型如图 12-2-15 所示。 

 
图 12-2-14  生成网格对话框 
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图 12-2-15  生成网格模型 

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【文件】-

【保存】菜单，保存为 GID 文件。点击菜单【计算】-【计算】，

弹出“process info”消息框，如图 12-2-16 所示，点击“ok”

按钮，然后退出 Gid，至此前处理工作结束。 

 

图 12-2-16  转化数据消息框 

有限元计算 

点击工具条中的 按钮弹出如图 12-2-17 所示计算模拟窗口。 
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图 12-2-17  计算模拟窗口 

12.2.3 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度，不同方式来输出计算结果。 

(4) 点击后处理按钮 。 

(5) 点击菜单【结果显示】-【云图】-【unoda0】-【v】，如图 12-2-18
所示，显示得到竖向位移场云图分布，如图 12-2-19 所示。 
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图 12-2-18 选择竖向位移场云图 图 12-2-19 竖向位移场云

图 
(6) 点击菜单【结果显示】-【图表】-【点的时程曲线】-【unoda0】

-【syy】，如图 12-2-20 所示，显示得到点的竖向应力时程曲

线分布，如图 12-2-21 所示。 
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图 12-2-20 选择点的竖向应力时程曲线 图 12-2-21 点的竖向应力时

程曲线 
12.3 二维轴对称问题 

12.3.1 问题描述 

本例中所使用的材料为低碳钢，材料参数如下表： 

模型类

型 

参

数 
材料 

弹性模量 
单位（Pa） 

泊松

比 

X 向 
体积

力 

Y 向 
体积

力 

屈服极限 
单位（Pa） 

强化系

数 

理想塑

性 
花岗

岩 
5.0e10 0.22 0 0 3.0e8 0 

强化模

型 
花岗

岩 
5.0e10 0.22 0 0 3.0e8 1e3 

问题类型为二维轴对称弹塑性问题，模型及边界条件如下图： 
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图 12-3-1 

模型单位取 m，约束情况为底边法向约束；加载方式为位移加

载，左边加 X 向位移，共 100 个载荷步，每步位移Δ s 为 5.0e-9m；

使用 misses 准则。 

12.3.2 求解步骤 

选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 12-3-2 所示的对话框。 
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图 12-3-2  选择项目类型对话框 

(2)点击“问题类型”栏中的“二维塑性轴对称”选项。如图 12-3-2
所示。 

(3)点击“OK”按钮完成项目类型的选择。 

设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 12-3-3 所示。或

者单击工具条中的 按钮弹出如图 12-3-4 所示材料参数数据输入表

格。 



 418 

 
图 12-3-3  选择材料参数输入 

 

 

图 12-3-4  材料参数输入对话框 
(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 12-3-5 所示。                 
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图 12-3-5  填写完成材料数据输入 

 

(5) 选择“前处理”—>“边界条件”按钮，如图 12-3-6 所示。

或者单击工具条中的 按钮弹如图 12-3-7 所示数据输入表

格。 

 

 

图 12-3-6 选择边界条件输入 图 12-3-7 边界条件输入对话框 
 (4)按照问题描述中的参数依次填入边界条件数据表格。填写完

成后如图 12-3-8 所示。 
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图 12-3-8  填写完成边界条件输入 

建模、设置材料属性和施加边界条件 

(1) 启动 GID 以创建模型。单击工具条中的 按钮弹出如图

12-3-9 所示前处理初始化窗口。 

 
图 12-3-9 前处理初始化窗口 

(2) 建模。a.点击菜单【模型】-【创建】-【直线】，创建直线，

在命令栏中依次输入坐标 0,0，按 Enter 键，输入 0.05,0，按 Enter 键，
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输入 0.05,0.1，按 Enter 键，输入 0,0.1，按 Enter 键，输入 0,0，按 Enter
键，在跳出的对话框中选择“合并”，生成直线如图 12-3-10 所示。 

 

图 12-3-10  生成直线 

b. 点击菜单【模型】-【创建】-【样条曲面】-【通过封闭的边

界线】，选中所有线以生成一个面，如图 12-3-11 所示。 
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图 12-3-11  生成面 

c.选择问题类型。点击菜单【数据】-【问题类型】-【sci】，弹出

“Dialog Window”，点击“确定”按钮即可。 
d.材料特性、初始条件。点击菜单【数据】-【条件】弹出“condition”

对话框。① 定义材料。点击表示面单元的按钮 ，选中下拉菜单中

的“Surface－aeq4”,在“mate Num”（即 Material Number）中填入

“1”，点击“指定”选择生成的面，点击“完成” 即定义好材料特

性。点击“绘图”选择“颜色”如图 12-3-12 所示。 
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图 12-3-12  定义材料特性 

③ 定义边界位移。点击线单元按钮 ，选中下拉菜单中的

“line-ep2da”，在 u-I，u-D，v-I，v-D，所对应的四栏中分别填入

（1，0，-1，0），点击“指定”，选中上、下两边界；然后按照上

述方法分别指定左边界为（-1，1e-6，-1，0）。点击“绘图”选择

“颜色”如图 12-3-13 所示。 

 
图 12-3-13  设定边界条件 
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划分网格和导出数据 
(1).划分网格。点击菜单【网格剖分】-【产生网格】，如图 12-3-14

所示，点击“ok”按钮，即可生成网格模型如图 12-3-15 所示。 

 
图 12-3-14  生成网格对话框 

 

图 12-2-15  生成网格模型 

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【文件】-
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【保存】菜单，保存为 GID 文件。点击菜单【计算】-【计算】，

弹出“process info”消息框，如图 12-2-16 所示，点击“ok”

按钮，然后退出 Gid，至此前处理工作结束。 

 

图 12-2-16  转化数据消息框 

有限元计算 

点击工具条中的 按钮弹出如图 12-2-17 所示计算模拟窗口。 

 
图 12-2-17  计算模拟窗口 
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12.3.3 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度，不同方式来输出计算结果。 

(7) 点击后处理按钮 。 

(8) 点击菜单【结果显示】-【云图】-【unoda0】-【v】，如图 12-2-18
所示，显示得到竖向位移场云图分布，如图 12-2-19 所示。 

 
 

图 12-2-18 选择竖向位移场云图 图 12-2-19 竖向位移场云

图 
(9) 点击菜单【结果显示】-【图表】-【点的时程曲线】-【unoda0】

-【syy】，如图 12-2-20 所示，显示得到点的竖向应力时程曲线分布，

如图 12-2-21 所示。 
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图12-2-20 选择点的竖向应力时程曲线 图 12-2-21 点的竖向应力时程

曲线 
12.4 三维空间问题 

12.4.1 问题描述 

本例中所使用的材料为低碳钢，材料参数如下表： 

模型类

型 

参

数 
材料 

弹性模量 
单位（Pa） 

泊松

比 

X 向 
体积

力 

Y 向 
体积

力 

屈服极限 
单位（Pa） 

强化系

数 

理想塑

性 
花岗

岩 
5.0e10 0.22 0 0 3.0e8 0 

强化模

型 
花岗

岩 
5.0e10 0.22 0 0 3.0e8 1e3 

问题类型为三维弹塑性问题，模型及边界条件如下图： 
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图 12-4-1 

模型单位取 m，约束情况为底面固定；顶面 X、Y 向约束，Z
向固定位移，共 100 个载荷步，每步位移为 1.0e-5m；使用 misses 准
则。 

12.4.2 求解步骤 

选择项目 
(1)启动 SciFEA，选择“项目”—>“新建项目”菜单或选择新

建项目按钮 弹出如图 12-4-2 所示的对话框。 
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图 12-4-2  选择项目类型对话框 

(2)点击“问题类型”栏中的“三维塑性空间问题”选项。如图

12-4-2 所示。 

(3)点击“OK”按钮完成项目类型的选择。 

设置材料参数和边界条件 
(1)选择“前处理”—>“材料参数”按钮，如图 12-4-3 所示。或

者单击工具条中的 按钮弹出如图 12-3-4 所示材料参数数据输入表

格。 
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图 12-4-3  选择材料参数输入 

  

图 12-4-4  材料参数输入对话框 
(2)按照问题描述中的参数依次填入材料参数数据表格。填写完

成后如图 12-4-5 所示。                 

 
图 12-4-5  填写完成材料数据输入 

 

(6) 选择“前处理”—>“边界条件”按钮，如图 12-4-6 所示。
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或者单击工具条中的 按钮弹如图 12-4-7 所示数据输入表

格。 

 
 

图12-4-6选择边界条件输入 图 12-4-7 边界条件输入对话框 
 (4)按照问题描述中的参数依次填入边界条件数据表格。填写完

成后如图 12-4-8 所示。 

 
图 12-4-8  填写完成边界条件输入 

建模、设置材料属性和施加边界条件 

(1) 启动 GID 以创建模型。单击工具条中的 按钮弹出如图

12-4-9 所示前处理初始化窗口。 
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图 12-4-9 前处理初始化窗口 

(2) 建模。a. 点击菜单【模型】-【创建】-【Object】-【Rectangle】，
在命令栏依次输入点坐标：0,0，按 Enter 键，输入 0.02，0.02, 按 Enter
键，接着按 Esc 键，点击菜单【应用程序】-【复制】，弹出对话框，

改“实体形式”为“面”，改“第二 点”中“z”坐标为 0.1，改“进

行挤出”为“体”，然后，点击“选择”按钮，选择建好的面，再点

击“复制”对话框中的“完成”按钮，模型就建好了。生成体如图

12-4 -10 所示。 

 

图 12-3-10  生成直线 
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b.选择问题类型。点击菜单【数据】-【问题类型】-【sci】，弹出

“Dialog Window”，点击“确定”按钮即可。 
d.材料特性、初始条件。点击菜单【数据】-【条件】弹出“condition”

对话框。① 定义材料。点击表示体单元的按钮 ，选中下拉菜单中

的“Volume-aec8”,在“mate Num”（即 Material Number）中填入“1”，
点击“指定”选择生成的面，点击“完成” 即定义好材料特性。点

击“绘图”选择“颜色”如图 12-4-11 所示。 

 
图 12-4-11  定义材料特性 

④ 定义边界位移。点击面单元按钮 ，选中下拉菜单中的

“Surface-ep3da”，在 u-I，u-D，v-I，v-D，w-I，w-D，所对应的

四栏中分别填入（-1，0，-1，0，-1，0），点击“指定”，选中上

表面；然后按照上述方法分别指定如图 12-4-12 所示的其他三个

边界。点击“绘图”选择“颜色”得到如图 12-4-12 所示的图形。 
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图 12-4-12  设定边界条件 

划分网格和导出数据 
(1).划分网格。点击菜单【网格剖分】-【产生网格】，如图 12-4-13

所示，点击“ok”按钮，即可生成网格模型如图 12-4-14 所示。 

 
图 12-4-13  生成网格对话框 
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图 12-4-14  生成网格模型 

(2).把前处理数据转化为 SciFEA 所需计算格式。点击【文件】-

【保存】菜单，保存为 GID 文件。点击菜单【计算】-【计算】，

弹出“process info”消息框，如图 12-4-15 所示，点击“ok”

按钮，然后退出 Gid，至此前处理工作结束。 

 

图 12-4-15  转化数据消息框 
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有限元计算 

点击工具条中的 按钮弹出如图 12-4-16 所示计算模拟窗口。 

 
图 12-4-16  计算模拟窗口 

12.4.3 结果分析 

对计算结果进行分析属于后处理，GID 提供了丰富的后处理操

作，可以从不同角度，不同方式来输出计算结果。 

(1) 点击后处理按钮 。 

(2) 点击菜单【结果显示】-【云图】-【unoda0】-【w】，如图

12-4-17 所示，显示得到竖向位移场云图分布，如图 12-4-18
所示。 
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图 12-4-17 选择竖向位移场云图 图 12-4-18 竖向位移场云图 
(3) 点击菜单【结果显示】-【云图】-【unodj0】，如图 12-4-19

所示，显示得到竖向位移场云图分布，如图 12-4-20 所示。 

  
图 12-4-19 选择竖向位移场云图 图 12-4-20  应力偏张量第二不变量云图 

(4) 点击菜单【结果显示】-【图表】-【点的时程曲线】-【unodj0】
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如图 12-4-21 所示，在命令行中键入 46 点的坐标（0，0，0.05），
显示得到点的竖向应力时程曲线分布，如图 12-4-22 所示。 

  

图 12-4-21 选择节点应力偏张量第二不变

量随载荷步变化曲线 
图 12-4-22  46 号节点应力偏张量第二

不变量随载荷步变化曲线 
(5) 点击菜单【结果显示】-【图表】-【点的时程曲线】-【unodb1】

-szz 如图 12-4-23 所示，在命令行中键入 46 点的坐标（0，0，0.05），
显示得到点的竖向应力时程曲线分布，如图 12-4-24 所示。 

  
图12-4-23 选择号节点SZZ随载荷步变化

曲线 
图 12-4-24  46 号节点 SZZ 随载荷步变

化曲线 
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以上结果是在强化模型下的计算结果，将材料参数的强化因子去掉，得到

在理想弹塑性模型下的结果如下： 

  

图 12-4-25 竖向位移场云图 图 12-4-26  应力偏张量第二不变量云图 

 

图 12-4-27  33 号节点应力偏张量第二不变量随载荷步变化曲线 
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图 12-4-28  33 号节点 SZZ 随载荷步变化曲线 
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第13章 附件：软件研制的理论基础—有限元方法 

13.1 有限元法的提出 

有限元离散化的思想早在 40 年代已经提出，但到 50 年代中期才从结构矩

阵分析扩展应用于连续弹性体。1956 年美国波音飞机公司 Turner 等人进行后

掠翼结构分析时，首次采用三角形单元进行平面应力分析[4]。 

从应用数学角度而言，有限单元法基本思想的提出，可以追溯到 Courant[5]

在 1943 年的工作，他第一次尝试应用定义在三角形区域上的分片连续函数并

结合最小位能原理，来求解 St. Venant 扭转问题。之后，一些应有数学家、物

理学家和工程师出于各种原因都涉足过有限单元的概念。但只是到 1960 年以

后，随着计算机技术的发展和广泛应用，有限单元法才得以迅速发展。1960

年Clough[6]进一步处理了平面弹性问题，并第一次提出了“有限单元法”的名称，

使人们开始认识了有限单元法的功效。 

从确定单元特性和建立求解方程的理论基础和途径来说，它源于结构分析

的刚度法。1963—1964 年，Besseling，Melosh 和 Jones 等人证明了有限单元法

是基于变分原理的里兹(Ritz)法的另一种形式，从而使里兹法分析的所有理论

基础都适用于有限单元法，确认了有限单元法是处理连续介质问题的一种普遍

方法。利用变分原理建立有限元方程与经典里兹法[7]的主要区别是有限单元法

假设的近似函数不是建立在全求解域而是建立在单元上，而且事先不要求满足

任何边界条件，因此它可以用来处理很复杂的连续介质问题。 

13.2 有限差分法与有限元法 

在研究力学问题和物理问题时，人们已经得到了它们应遵循的基本方程

和相应的定解条件。但能用解析方法求出精确解的只是少数方程性质比较简
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单，而且几何形状相当规则的问题。对于大多数问题，由于方程的某些特征的

非线性性质，或由于求解区域的几何形状比较复杂，不能得到解析解的答案。

解决这类问题通常有两种途径，一是引入简化假设，将方程和几何边界简化为

能处理的情况，从而得到问题在简化状态下的解。但这种方法只是在有限的情

况下是可行的，因为过多的简化可能导致误差很大甚至得到错误的解答。因此

人们多年来寻找和发展了另一种求解途径和方法——数值解法。 

已经发展的主要数值分析方法可以分为两大类。一类以有限差分法为代

表，其特点是直接求解基本方程和相应定解条件的近似解。另一类数值分析方

法是首先建立和原问题基本方程及相应定解条件相等效的积分提法，然后根据

它建立近似解法。如配点法、最小二乘法、Galerkin 法、力矩法等都属于这一

类数值方法。 

有限差分法的特点是直接求解基本方程和相应的定解条件的近似解。有限

差分法的求解步骤是；首先将求解域划分为网格，然后在网格的结点上用差分

方程近似微分方程。当采取较多的结点时，近似解的精度可以得到改进。有限

差分法用差商代替微商，用计算区域网格节点值构成差商，近似表示微分方程

中各阶导数。该方法主要适用于有结构网格，网格的步长一般根据实际情况和

柯朗稳定条件来决定。有限差分形式简单，对任意复杂的微分方程都可以写出

其对应的差分方程。但是有限差分方程的获得只是用差商代替微分方程中的微

商（导数），而微分方程中各项的物理意义和微分方程所反映的物理定律在差

分方程中并没有体现，不规则区域处理繁琐，虽然网格生成可以使有限差分法

应用于不规则区域，但是对区域的连续性等要求较严。使用有限差分法的好处

在于直观、理论成熟、精度可选、易于编程、易于并行。借助有限差分法能够

求解某些相当复杂的问题，特别是求解建立在空间坐标系的流体流动问题，有

限差分法有自己的优势。但在解决几何形状复杂的问题时，它的计算精度将降
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低，甚至发生困难。 

有限元法是结构分析中的一种数值法[21]~[23]，它已成为分析连续体的强有

力的工具。并且它已经能够成功的用来解决热传导、电磁场、渗流和流体动力

学等其它领域中的问题。有限元方法的基础是变分原理和加权余量法，其基本

求解思想是把计算域划分为有限个互不重叠的单元，在每个单元内，选择一些

合适的节点作为求解函数的插值点，将微分方程中的变量改写成由各变量或其

导数的节点值与所选用的插值函数组成的线性表达式，借助于变分原理或加权

余量法，将微分方程离散求解。采用不同的权函数和插值函数形式，便构成不

同的有限元方法。从权函数的选择来说，有配置法、矩量法、最小二乘法和伽

辽金法，从计算单元网格的形状来划分，有三角形网格、四边形网格和多边形

网格，从插值函数的精度来划分，又分为线性插值函数和高次插值函数等[24][25]。 

 

有限元法是一种求解连续介质力学问题的数值方法。在许多工程问题中

由于几何形状和荷载太复杂，因而不可能得到封闭形式的数学解，这就需要一

个数值解，提供数值解最灵活的方法就是有限元法。有限元法是结构分析中的

一种数值法，它已成为分析连续体的强有力工具，但它并不是只限于结构力学

问题，它已经能够成功的用来解决热传导、电磁场、渗流和流体动力学等其它

领域中的问题。 

有限元法是对古典近似计算的归纳和总结，它吸取了有限差分法中的离

散处理内核，又继承了变分计算中选择试探函数并对区域积分的合理方法。有

限元法的基本思想是将连续的求解区域离散为一组有限个、按一定方式相互联

结在一起的单元的组合提。由于单元能按不同的联结方式进行组合，而且单元

本身又可以有不同形状，因此可以模型化几何形状复杂的求解域。有限单元法

作为数值分析方法的另一个重要特点是利用在每一个单元内假设的近似函数
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来分片的表示全求解域上待求的未知场函数。单元内近似函数通常由

未知场函数或其导数在单元的各个结点的数值和其插值函数来表示。

这样一来，一个问题的有限元分析中，未知场函数或其导数在各个结

点上的数值就成为新的未知量（也即自由度），从而使一个连续的无

限自由度问题变成场函数的近似值，从而得到整个求解域上的近似

解。显然随着单元数目的增加，也就是单元尺寸的缩小，或者随着单

元自由度的增加及插值函数精度的提高，解的近似程度将不断改进。

如果单元是满足收敛要求的，近似解最后将收敛于精确解。 
有限元法的理论基础是变分原理或加权余量法，加权余量法的原理是基

于微分方程等效积分的提法，同时它也是求解线性和非线性微分方程近似解的

一种有效方法[44][45]。在有限元分析中，加权余量法可以被用于建立有限元方程，

但加权余量法本身又是一种独立的数值求解方法。 

13.3 等效积分形式与加权余量法 

加权余量法的原理是基于微分方程等效积分的提法，同时它也是求解线性

和非线性微分方程近似解的一种有效方法。在有限元分析中，加权余量法可以

被用于建立有限元方程，但加权余量法本身又是一种独立的数值求解方法。 

13.3.1 微分方程的等效积分形式 

工程或物理学中的许多问题，通常是以未知场函数应满足的微分方程和边

界条件的形式提出来的，可以一般地表示为未知函数 u 应满足微分方程组 

1

2

( )
( ) ( ) 0 ( )

A
u A Ω

 
 

  
 
 

u
A u     在                   

 (10-1) 
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域 Ω 可以是体积域、面积域等，如图 10-1 所示。同时未知函数 u 还满足边界

条件
1

2

( )
( ) ( ) 0 (

B
B Γ

 
 

  
 
 

u
B u u       )在 上                               

(10-2) 

Γ 是域 Ω 的边界。 

要求解的未知函数 u 可以是标

量场(例如压力或温度)，也可以是几

个变量组成的向量场(例如位移、应

变、应力等)。A，B 是表示对于独立

变量(例如空间坐标、时间坐标等)

的微分算子。微分方程数目应和未

知场函数的数目相对应，因此，上

述微分方程可以是单个的方程，也

可以是一组方程。所以在以上两式

中采用了矩阵形式。 

以二维稳态的热传导方程为

例，其控制方程和定解条件如下： 

 

 

)(0)( 内在
































 q

y
k

yx
k

x
A 
                   

 (10-2) 

 

图 10-1 求解区域 Ω 及边界 Γ 

Fig.9-1 Solution domain and boundaries 
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















)(0

)( 0
)(

上在

上在

qq
n

k
B 






                

 (10-3) 

这里 φ 表示温度(在渗流问题中对应压力)；k 是流度或热传导系数(在渗流

问题中对应流度 K/μ； 和 q 是边界上温度和热流的给定值(在渗流问题中分别

对应边界上的压力和边界上的流速)；n 是有关边界 Γ 的外法线方向；q 是源密

度(在渗流问题中对应井的产量)。 

在上述问题中，若 k 和 q 只是空间位置的函数时，问题是线性的。若 k 和

q 是 φ 及其导数的函数时，问题则是非线性的。 

由于微分方程组(10-1)在域中每一点都必须为零，因此就有 

1 1 2 2( )d ( ( ) ( ) )d 0T u v A v A
 

    V A u u              

 (10-4) 

其中 

1

2

v
v
 
 

  
 
 

V                                 

 (10-6) 
其中，V 是函数向量，它是一组和微分方程个数相等的任意函数。 

式(10-5)是与微分方程组(10-1)完全等效的积分形式。我们可以说，若积分

方程(10-5)对于任意的 V 都能成立，则微分方程(10-1)必然在域内任一点都得到

满足。 
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同理，假如边界条件(10-2)亦同时在边界上每一点都得到满足，对于一组

任意函数V ，下式应当成立 

1 1 2 2( )d ( ( ) ( ) )d 0T u v B u v B u
 

      V B  

因此积分形式 

( )d ( )d 0T Tu u
 

   V A V B                    

 (10-7) 

对于所有的 V 和V 都成立是等效于满足微分方程(10-1)界条件(10-2)。我

们把(10-7)式称为微分方程的等效积分形式。 

13.3.2 等效积分的“弱”形式 

在一般情况下，对(10-7)式进行分部积分得到另一种形式： 

( ) ( )d ( ) ( )d 0T Tv v
 

   C D u E F u                   

 (10-8) 
其中 C，D，E，F 是微分算子，它们中所包含的导数的阶数较(10-7)式的 A 低，

这样对函数 u 只需要求较低阶的连续性就可以了。在(10-8)式中降低 u 的连续

性要求是以提高 v 和v 的连续性要求为代价的，由于原来对 v 及v (在(10-7)式

中)并无连续性要求，但是适当提高对其连续性的要求并不困难，因为它们是

可以选择的已知函数。这种降低对函数 u 连续性要求的作法在近似计算中，尤

其是在有限单元法中是十分重要的。(10-8)式称为微分方程(10-1)和边界条件

(10-2)式的等效积分“弱”形式。值得指出的是，从形式上看“弱”形式对函数 u

的连续性要求降低了，但对实际的物理问题却常常较原始的微分方程更逼近真

正解，因为原始微分方程往往对解提出了过分“平滑”的要求。 
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13.3.3 加权余量法  

在求解域 Ω 中，若场函数 u 是精确解，则在域 Ω 中任一点都满足微分方

程(10-1)式，同时在边界 Γ 上任一点都满足边界条件(10-2)式，此时等效积分形

式(10-7)式或(10-8)式必然严格地得到满足。但是对于复杂的实际问题，这样的

精确解往往是很难找到的，因此人们需要设法找到具有一定精度的近似解。 

对于微分方程(10-1)式和边界条件(10-2)式所表达的物理问题，未知场函数

u 可以采用近似函数来表示。近似函数是一族带有待定参数的已知函数，一般

形式是 

1

n

i i
i

u u N a


   Na                                       

(10-9) 

其中 ai是待定参数；Ni是试探函数(或称基函数、形函数)，为已知函数，它取

自完全的函数序列，是线性独立的。所谓完全的函数系列是指任一函数都可以

用此序列表示。近似解通常选择使之满足强制边界条件和连续性的要求。例如

当未知函数 u 是压力时，可取近似解 





n

i
iinn uNuNuNuNu

1
2211   

ai是待定参数，共有 n 个。 

显然，在通常 n 取有限项数的情况下近似解是不能精确满足微分方程(10-1)

式和边界条件(10-2)的，它们将产生残差 R及 R  

RNaBRNaA  )(      ;)(  

残差 R及 R 亦称为余量。在(10-7)式中我们用 n 个规定的函数来代替任意函数
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v 及 v ，即 

)~1(; njWvWv jj   

就可以得到近似的等效积分形式 

( )d ( )d 0 ( 1~ )
T
jjW A Na W B Na j n

 
                      

(10-10) 

亦可以写成余量的形式 

d d 0 ( 1~ )T T
j j j n

 
    W R W R                        

(10-11) 

(10-10)式或(10-11)式的意义是通过选择待定系数 ai，强迫余量在某种平均意义

下等于零。 jW 和 jW 称为权函数。余量的加权积分为零就得到了一组求解方程，

用以求解近似解的待定系数 a，从而得到原问题的近似解答。求解方程(2-10)

的展开形式是 

1 1

2 2

( )d ( )d 0

( )d ( )d 0

( )d ( )d 0

T T

T T

T T
n n

 

 

 

  

  

  

 

 

 

W A Na W B Na

W A Na W B Na

W A Na W B Na

 

其中若微分方程组 A 的个数为 m1，边界条件 B 的个数为 m2，则权函数

),,1( njj W 是 m1 阶的函数列阵， ),,1( njj W 是 m2 阶的函数列阵。 

当近似函数所取试探函数的项数 n 越多，近似解的精度将越高。当项数 n

趋于无穷时，近似解将收敛于精确解。 
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对应于等效积分“弱”形式(10-8)式，同样可以得到它的近似形式 

( ) ( )d ( )d 0 ( 1, , )T T
j j j n

 
    C W D Na E W F Na          

(2-12) 

采用使余量的加权积分为零来求得微分方程近似解的方法称为加权余量

法。加权余量法是求微分方程近似解的一处有效方法。常用的权函数的选择有

以下几种： 

(1) 配点法，这种方法相当于简单地强迫余量在域内 n 个点上等于零； 

(2) 子域法，该方法的实质是强迫余量在 n 个子域 jΩ 的积分为零； 

(3) 最小二乘法，此方法实质是使得近似解和权函数组成的泛函取最小

值； 

(4) 力矩法，该方法是强迫余量的各次矩等于零，通常又称此法为积分法； 

(5) 伽辽金(Galerkin)法。 

加权余量法可以用于广泛的方程类型，选择不同的权函数，可以产生不同

的加权余量法；通过采用等效积分的“弱”形式，可以降低对近似函数连续性要

求；当近似函数满足连续性和完备性要求、试探函数的项数不断增加时，近似

解可趋近于精确解。由于 Galerkin 具有广泛的适用性，因此，下面简单介绍其

基本原理： 

取 Wj=Nj，在边界上 jjj NWW  ，即简单地利用近似解的试探函数

序列作为权函数。近似积分形式可以写成 

1 1
d d 0 ( 1,2, , )

n n
T
j i i i i

i i
N N a N a j n

 
 

   
      

   
  A BTjN       

(10-13) 
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由(10-9)式，可以定义近似解u~ 的变分 u~ 为 

nn aNaNaNu   2211
~  

其中 ia 是完全任意的。(10-13)式可更简洁地表示为： 

( )d ( )d 0T Tu u u u 
 

   A B   

对于近似积分的“弱”形式(2-12)式则有 

( ) ( )d ( ) ( )d 0T Tu u u u 
 

   C D E F   

我们将会看到，在很多情况下，采用伽辽金法得到的求解方程的系数矩阵

是对称的，这是在用加权余量法建立有限元格式时几乎毫无例外地采用伽辽金

法的主要原因，而且当存在相应的泛函时，伽辽金法与变分法往往导致同样的

结果。 

13.4 第四节 变分原理和里兹方法 

13.4.1 变分原理的定义和意义 

讨论一个连续介质问题的“变分原理”首先要建立一个标量泛函 ，它由

积分形式确定 

, , d , , dΠ
x x 

    
     

    
 

u uF u E u                      

(10-14) 

其中，u 是未知函数，F 和 E 是特定的算子，Ω 是求解域，Γ 是 Ω 的边界。Π

称为未知函数 u 的泛函，它随函数 u 的变化而变化。连续介质问题的解 u 使泛

函 Π 对于微小的变化 δu 取驻值，即泛函的 “ 变化 ” 等于零 δΠ=0                                                 

(10-15) 
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这种求得连续介质问题解的方法称为变分原理或变分法。 

如前所述，连续介质问题中经常存在着和微分方程及边界条件不同的，但

却是等价的表达形式，变分原理是另一种表达连续介质问题的积分表达形式。

在用现微分公式表达时，问题的求解过程是对具有已知边界条件的微分方程或

微分方程组进行积分。在经典的变分原理表达中，问题的求解过程是寻求使得

具有一定已知边界条件的泛函(或泛函系)取驻值的未知函数(或函数系)。这两

种表达形式是等价的，一方面满足微分方程及边界条件的函数将使泛函取极值

或驻值，另一方面从变分的角度来看，使泛函取极值或驻值的函数正是满足问

题的控制微分方程和边界条件的解。 

应注意到，经常有些物理问题可以直接用变分原理的形式来叙述，如表述

力学体系平衡问题的最小位能原理和最小余能原理等，但是并非所有以微分方

程表达的连续介质问题都存在这种变分原理。 

13.4.2 变分原理与 Galerkin 法的关系 
研究表明，原问题等效积分的 Galerkin 提法等效于它的变分原理，即原问

题的微分方程和边界条件等效于泛函的变分等于零，亦即泛函取驻值。反之，

如果泛函取驻值则等效于满足问题的微分方程和边界条件，而泛函可以通过原

问题的等效积分的 Galerkin 提法而得到。Galerkin 法的适用性比变分原理要强，

原因是对于有的微分方程很难找到对应的泛函或根本找不到泛函，这时变分原

理不适用，但 Galerkin 法仍然适用。 

13.5 变分有限元和加权余量有限元 

如前所述，无论是加权余量法还是变分原理，虽然可以得到微分程的近似

解，但是由于它是在全求解域中定义近似函数，因此实际应用中会遇到两方面

的困难： 

(1) 在求解域比较复杂的情况下，选取满足边界条件的试探函数，往往会

产生难以克制的困难，甚至有时做不到。 

(2) 为了提高近似解的精度，需要增加待定参数，即增加试探函数的项数，
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这就增加了求解的繁杂性。而且由于试探函数定义于全域，因此不可能根据问

题的要求，在求解域的不同部位对试探函数提出不同精度的要求，往往由于局

部精度的要求使整个问题的求解增加许多困难。 

变分法是把有限元归结为求泛函的极值问题。它使有限元法建立在更加坚

实的数学基础上，扩大了有限元法的应用范围。 

加权余量法不需要利用泛函的概念，而是直接从基本微分方程出发，求出

近似解。对于根本不存在泛函的工程领域都可采用，从而进一步扩大了有限元

的应用范围。 

变分有限元法和加权余量有限元法就是分别以变分原理和加权余量法为

理论基础，通过对求解区域进行单元剖分，把整个的求解区域剖分成有限的小

区域(子域)，然后在子域内定义近似函数(近似解)，因此称为变分有限元法和

加权余量有限元法。变分有限元法和加权余量有限元法虽然在本质上与变分法

和加权余量法是类似的，但由于近似函数在子域(单元)上定义，因此可以克服

上述两方面的困难，并由于和现代计算机技术的结合，使得有限元法成为对物

理、力学以及其它科学技术领域问题进行分析、求解的有效工具。 

13.6 有限元分析的一般过程 

在有限元法中，把所研究的连续介质表示为一些小部分(称为有限元)的集

合。这些单元可认为是一些称为结点的指定结合点处彼此连接的。这些结点通

常是置于单元的边界上，并认为相邻单元就是在这些边界上与它相连接的。由

于不知道连续介质内部的场变量(在固体力学中如位移、应力，在渗流问题中

如压力、饱和度)真实的变化，因此，我们假设有限元内场变量的变化可以用

一种简单的函数来近似。这些近似函数(也称为插值模式)可由场变量在结点处

的值确定。当对整个连续介质写出场方程组(如平衡方程组)时，新的未知量就

是场变量的结点值。求解场方程组(通常以矩阵方程形式表示)，即得到场变量
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的结点值。一旦知道了这些结点值，则可由近似函数确定整个单元集合体的场

变量。 

有限元法求解一般的连续介质问题时，总是依次逐步进行的。以与时间无

关的物理问题为例，说明有限元法的基本步

骤(见图 10-2)： 

(1) 结构或求解域的离散化。有限元法

的第一步，是把求解域分割成许多小部分或

称为单元，因而对于一个具体的有限元分析

问题，首先要用适当的有限元把结构进行剖

分，并确定单元的数量、类型、大小和布置。 

(2) 选择适当的插值模式。由于在任意

给定的约束作用下，问题的准确解为未知，

因此，我们假设用单元内的一些适当解来近

似未知解。从计算的观点看，假设的解必须

简单，而且应当满足一定的收敛性要求。通

常，把解的插值模式取为多项式形式。 

(3) 单元分析。即进行单元刚度矩阵和

载荷向量的推导。根据假设的插值模式，利

用平衡条件或适当的变分原理，就可以推导

出单元 e 的刚度矩阵 Ke 和载荷向量 Fe，形

成单元平衡方程： 
eee FPK   

(4) 总体合成。集合各单元方程以得到总的平衡方程(组)。由于结构是由

若干个有限元组成的，因此，应当把各个单元刚度矩阵和载荷向量按适当方式

 

图 10-2 有限元分析的一般过程 

Fig.10-2 General case of FEM 

analysis 
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进行集合，从而建立如下形式的总的平衡方程： 

KP=F 

其中，K 称为集合刚度矩阵，或称总体刚度矩阵；P 是整体结构的结点参数向

量，F 是它的结点载荷向量。在不同领域的问题中，P 所代表的物理量含意不

同，如在固体力学问题中 P 代表结点处的位移，在渗流力学问题中 P 代表结点

处的压力，在热学问题中 P 代表结点处的温度。 

(5) 引入约束条件。在总体平衡方程的基础上，按问题的边界条件修改总

的平衡方程。考虑了边界条件后，可以把平衡方程表示为 

FPK   

(6) 方程求解。对上述方程进行求解，对于线性问题可以很容易地解出向

量 P，而对非线性问题则要经过一系列的步骤才能求得解答，每一步都要对刚

度矩阵 K 和载荷向量 F 进行修正。 

(7) 计算其它参数。在直接求得结点变量后，可由此计算其它参数，对于

渗流问题可求压力梯度和流量；对于热学问题，可求温度梯度和传热量。 

13.7 有限元的实现 

有限元的基本思想是将场函数的总体泛函或总体求解域上的弱形式积分

看成是由子域（单元）的泛函或弱形式积分所集成。首先利用自然坐标建立起

单元的插值函数，将场函数表示成单元节点的插值形式；再利用数值积分计算

出单元的泛函或弱形式积分；通过单元集成形成以节点场函数值为未知量的代

数方程组，求解该代数方程组即得求解域场函数的近似解。 

一般说来，单元类型和形状的选择依赖于结构或总体求解域的几何特点和

方程的类型以及求解所希望的精度等因素，而有限元的插值函数则取决于单元

的形状、结点的类型和数目等因素。 
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（a）三角形单元             （b）四边形单元 

图 10-3 二维域的有限元离散 
Fig.10-3 Sketch of Finite element discrete in two dimensional space 

(a) element of triangle；(b) element of quadrangle 

从单元的几何形状上区别，可以分一维、二维和三维单元。例如在图 10-3

中，一个二维域可利用一系列三角形或四边形单元进行离散，即将总体求解域

理想化为由很多子域（单元）所组成。 

关于插值函数的形式，有限元方法中几乎全部采用不同阶次幂函数的多项

式。这是因为它们具有便于运算和易于满足收敛性要求的优点。 

在有限元法计算中经常会遇到许多曲边或曲面物体，采用自然坐标系划分

单元是很方便的，但是自然坐标系的方向不一致，对于曲面物体，通常取其自

然坐标为局部坐标，而取直角坐标为整体坐标，计算单元刚度矩阵和等效结点
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载荷向量都是将整体坐标系内的变量(通过换元法)变换到局部坐标系内进行微

积分运算，因此，必须在自然坐标(单元局部坐标)与整体坐标 zyx ,, 之间做坐

标变换。下面将分别介绍任意直边四边形和任意曲边四边形的坐标变换。 

(1) 任意直边四边形单元(4 结点) 

任意直边四边形单元的整体坐标系与局部坐标系，如图 10-4 所示。 

 

(a)整体坐标                  (b)局部坐标(自然

坐标) 

图 10-4 任意直边四边形单元的局部坐标与整体坐标 

Fig. 10-4 Sketch of location system and global system for 
rectangular element 

(a)Global system (b)Local system 

由坐标变换式的性质可知，如果能够找到将图 10-4 ( b )中的正方形映射成

图( a )中的任意直边四边形，则该变换式就是这类单元局部坐标与整体坐标的

变换式(变换函数)。现取插值函数为变换函数，即 

iNXX                                         
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  (10-16) 
其中 
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 (10-18) 

(10-18)式是形状函数，在 i ( i=1，2，3，4)结点处， iN 1 ；在 j ( j=1，2，

3，4)结点处( j  i)， 0iN 。为简便起见，将形函数写成如下通用表达式： 

iN = )1)(1(
4
1

 ii      (i=1，2，3，4)                    

(10-19) 

式中 ii  , 为局部坐标中 i 点的坐标值，在这里主要是用其表达“+”、“-”号。 

(2) 任意曲边四边形单元(8 结点) 

任意曲边四边形单元的整体坐标与局部坐标系，如图 10-5 所示。 
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(a)整体坐标             (b)局部坐标(自然坐标) 

图 10-5 任意曲边四边形单元的局部坐标与整体坐标 

Fig.10-5 Sketch of local system and global system for curve 
quadrilateral element 

(a)Global system (b)Local system 

与前面一样，这里仍取插值函数作为变换函数，将图 10-5 ( b )中的正方形

映射成图 10-5( a )中的任意曲边四边形，即 

iNXX                                               

(10-20) 

式中 
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T
i yxyxyxyxyxyxyxyx )( 8877665544332211X          

(10-21) 
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   (10-22) 

一般表达式为 
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(10-23) 

在有限元分析中，计算单元刚度矩阵和等效结点载荷向量是两个非常重要

的步骤。因为自然坐标与直角坐标的变换比较复杂，因此采用微积分运算的换

元法将整体坐标(直角坐标)的微积分换元成对局部坐标(自然坐标)的微积分进

行运算，直接得出整体坐标下的单元刚度矩阵和等效结点载荷向量。坐标变换

是在微积分运算的换元过程中完成的。因此，在计算单元刚度矩阵和等效结点

载荷向量时，要涉及到整体坐标与局部坐标之间导数的变换、面积和体积的变

换。故需要给出有关变换的计算方法。 

（1）导数之间的变换 

在求解渗流问题过程中，不仅要求解结点处的压力值，而且还要进一步求

解压力梯度值，以计算相应的流量(或流速)，因此需要对结点压力求相应的导

数。对于固体力学问题，求得位移后，还需求应变和应力，因此也需求解结点

参数的导数。下面针对渗流力学问题，推导压力对整体坐标的导数与对局部坐

标导数之间的关系式。 

在平面渗流问题中，若不考虑时间因素，则压力(用 u 表示)是整体坐标 yx,
的函数，而将 yx, 与局部坐标的关系代入，所以 
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  (10-24) 

式中 

































































yx

yx

JJ

JJ

2221

1211

J ，为 Jacobi 矩阵               

   (10-25) 

(2-25)式中各元素的计算公式为 
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式中m 为单元结点数。 

将其代入(10-25)式，则 Jacobi 矩阵可以表示为： 
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对(10-24)式求逆，得导数间的另一个变换关系式 
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 (10-26) 

其中，J -1 为 Jacobi 矩阵的逆。 

（2）面积微元的变换 

在求单元刚度矩阵时，将对整体坐标(直角坐标)的积分变成对局部坐标

(自然坐标)的积分以后，其积分面积微元也由直角坐标中的矩形d dx y 变成了沿

自然坐标割取的曲边四边形d d ，如图 10-6( a )所示。下面推导直角坐标中

的曲边面积微元dA ，用局部坐标中的面积微元d  d  表示的表达式。 
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(a)                   (b)  

图 10-6 任意曲边单元面积微元的变换 

Fig. 10-6 Sketch of the transform of mico-element of quadrilateral 

由图 10-6 ( a )，得 

d d dA  ξ η                                            

(10-27) 

由图 10-6 ( b )，在 xyO 坐标系内的任一微矢量d d dx y r i j。因为 yx, 是  ,

的函数，所以  

d d d d d dx x y yx y   
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故 
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(10-28) 

又因为dξ 是沿 坐标线变化的，所以它只是 的函数，与无关，得 
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d d  d  x y
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同理 
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(10-30) 

将(10-29)和(10-30)式代入(10-27)式，得 
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所以 

d d dA   J                                          

 (10-31) 

由于有限元法需要进行大量的积分运算，因而需要选择一种高效准确的数

值积分方法。高斯积分法在计算效率和计算精度方面均很优秀，因而成为有限
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元分析中常用的数值积分方法。 

对于一维积分： 
1

1
( )dI f  


   

高斯积分公式为： 

1

1
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n
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   

其中，n 为积分点数，ξi 为横坐标值，Wi 为加权系数值。  

一维高斯积分用于二维或三维数值积分时，可以采用与解析方法计算多

重积分相同的方法，即在计算内层积分时，保持外层积分变量为常量。 

对于二维积分 
1 1

1 1
( , )d dI F    

 
    

首先令为常数，进行内层积分： 
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用同样的方法进行外层积分就得到： 
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其中 Hi，Hj 即是一维高斯积分的权系数，n 是在每个坐标方向的积分
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点数。如果 ij
ijaF  ),( ，且 i，j≤2n-1，则上式将能给出积分的

精确值。 
类似地，对于三维数值积分，则有 
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如果  , , i j m
ijmF        ，且 i，j，m≤2n-1，则上式给出精确的积

分结果。 
在上面的讨论中，每个坐标方向上选取的积分点数是相同的。实际上，在

,  和 ζ 各个不同的坐标方向上，可以选取不同的积分点数，即可以根据具体

情况采用不同阶的积分方案。 

在进行数值积分时，如何选择数值积分的阶次将直接影响计算的精度和计

算工作量。如果选择不当，甚至会导致计算的失败。 

选择积分阶次的原则如下： 

(1) 保证积分的精度 

以一维问题刚度矩阵的积分为例，如果插值函数 N 中的多项式阶数为 p，

微分算子 L 中导数的阶次是 m，则有限元得到的被积函数是 2(p-m)次多项式(对

于等参元假设|J|是常数量)。为保证原积分的精度，应选择高斯积分的阶次

n=p-m+1，这时可以精确积分至 2(p-m)＋1 次多项式，可以达到精确积分刚度

矩阵的要求。对于二维、三维单元，则需要对被积函数作进一步的分析。但是

在很多情况下，实际选取的高斯积分点数低于精确积分的要求。因此，为了保

证这部分被积函数积分的精度，式中 p 是插值函数中完全多项式的方次，m 是
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微分算子 L 中导数的阶次，二维单元和三维单元分别采用 n×n 和 n×n×n 高斯

积分来进行单元刚度矩阵的计算。这种高斯积分阶数低于被积函数所有项次精

确积分所需要阶数的积分方案称为减缩积分。实际计算表明：采用减缩积分往

往可以取得较完全精确积分更好的精度。这是由于：精确积分常常是由插值函

数中非完全项的最高方次的要求，而决定有限元精度的是完全多项式的方次。

选取减缩积分方案将使有限元计算模型的刚度有所降低，因此可能有助于提高

计算精度。 

(2) 保证结构总刚度矩阵 K 是非奇异的 

求解系统方程 KP=F，要求方程有解则必须系数矩阵的逆矩 K-1

是存在的，即在引入强制边界条件后 K 必须是非奇异的。系数矩阵 K
非奇异的条件是|K|≠0，或称 K 是满秩的。如果 K 是 N 阶方阵，则要

求它的秩为 N。数值积分应保证 K 的满秩，否则将使求解失败。 
以上分析的原则同样适用于其它二维单元以及三维单元。 

本文推荐 4 结点任意四边形单元的二维等参元刚度矩阵积分阶数为 2×2。 

通过单元分析在公共的整体坐标系中求得单元矩阵和单元载荷向量以后，

下一步工作即是合成总体平衡方程或系统方程。不论问题的类型以及所用的单

元类型和数量如何，从单元分析到合成系统方程的方法是相同的。 

合成单元矩阵和载荷向量的方法是以单元结点处的“协调性”要求为基础。

这意味着在结点处各单元是连在一起的。未知结点自由度(或变量)的值对连接

在该点处的全部单元都相同。在固体力学和结构问题中，结点变量通常为位移。

在渗流力学问题中，结点变量通常为压力(或流体饱和度)。当在公共结点处，

把分配到结点上的每个单元的结点刚度和结点载荷加在一起，就得到结点处的

总刚度和总载荷。 
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设 E 和 M 分别表示单元的总数和结点

自由度的总数(包括边界的和约束的

自由度)；P 表示 M 结点自由度向量；

K 表示 MM 阶的集合系统刚度矩

阵。由于单元刚度矩阵 K )(e 和单元载

荷向量F )(e 分别是 nn  和 1n 阶的(n

为单元自由度数)，故可以用在剩余位

置填入零元素的方法而把他们分布表示为 MM  阶和 1M 阶的矩阵。因此用

代数加法就可得到总则度矩阵和总载荷向量  




E

e

e

1
KK 和  





E

e

e

1
FF 。其中

)(eK 是单元 e 的扩展刚度矩阵( MM  阶)； F )(e 是单元 e 的扩展载荷向量

( 1M 阶)。即使是集合多种形式的单元，单元自由度数 n 从一单元到另一单

元有改变，但以上两个方程仍然适用。 

在实际计算中，不必把单元矩阵 K )(e 和向量 F )(e 表示成总的 K 和 P 的形

式。当 e 值从 1 变到 E 时，识别 K )(e 和 F )(e 的元素在 K 和 P 中的位置，并把

他们加进当前值中去，就可导出 K 和 F。 

一般总刚矩阵集成分为两步： 

扩展过程：将各个单元刚阵按节点总数扩大为 n×n 阶方阵，并将单刚元素

送入该单元节点对应的节点总码的行和列，其余元素置为零。 

叠加过程：扩展后的单元刚阵具有相同的阶数和节点排列顺序，将各个单

元刚阵按式 

 

图 10-7 网格剖分图 
Fig.10-7 Sketch of meshing 
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 

1
K K

en
e

e
     （ en 为单元总数） 

进行叠加，即相同位置的元素相加，就可得到总刚矩阵。 

通过集合单元刚度矩阵K e 和单元特征向量F e ，就可得到总体平衡方程(或

称系统方程，可写为如下形式 

KP=F                                      
(10-32) 

式中，P 为结点的待求场向量。 

由于矩阵 K 是奇异的，因而它的逆矩阵不存在，所以从上述方程无法解出

P。因此给出边界条件是必要的。一般而言，边界条件可分为两类：一是强制

的(或本质的)，二是自由的(或自然的)。如果用变分法来推导系统方程，就只

需满足本质边界条件，而自然边界条件将在求解过程中隐含地得到满足。因此，

只需把本质边界条件引入方程(10-32)。以下方法可以把本质边界条件引入方程

(10-32)。 

方法 1 
为了便于，把方程(2-32)分块如下 



























2

1

2

1

2221

1211

  F
F

P
P

KK
KK

                                    

 (10-33) 

其中，P1 是无约束的结点自由度向量，P2 是规定的结点自由度向量，F1

是已知的结点载荷向量，F2 是未知的结点载荷向量。 

方程(10-33)可以写为 
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K11P 1+K12P2=F1 

即 
K11P 1= F1- K12P2 

和 
K12

TP1+K22P2=F2 

其中，K11是非奇异的，因而可以解方程得出 

P1=K11
-1(F1-K12P2) 

一旦求求得了 P1，就可以由方程求得未知结点载荷向量 F2。在全部规定

的结点自由度都等于零的特殊情况下，我们可以删除对应于 P2 的各行和各列，

故可把方程简述为 

K11P1=F1 

方法 2 
由于全部规定的结点自由度通常不能在向量 P 的端点求得，故方法 1 的

编号方法是很麻烦的。即使在规定的结点自由度不为零时，也可以看出，为了

重新排列方程以及求解方程要消耗大量计算时间，还要冗长的程序段。因此，

为了引入规定的边界条件 P 2 ，可以采取以下方法。 

把方程合在一起写为 














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

















2

2121

2

111 -
   0

0 
P

PKF
p
P

I
K

                     

 (10-34) 
在实际应用中，方程(10-34)所示的过程可以在不重新排列所述方

程的情况下用下述分块的方法来进行。 
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1）如果把 Pi规定为
*

iP ，则特性向量 F 可以修改为 

Fi=Fi-Kij Pi
*  ，当 i=1，2，…，M 

2）除对角线元素以外，使 K 中对应于 Pi 的行和列为零，而对角线元素为

1，即 

Kji=Kij=0，当 i=1，2，„，M 

Kjj=1 

3）在特性向量中引入规定的 Pi值，即 

Fi=Pi
* 

对全部规定的结点自由度 Pi 均应反复运用上述过程(步骤 1 到 3)。应当指

出，由于这个过程保持了方程的对称性，因此，K 可以按带状存储，而且几乎

不会增加编制程序的工作量。 

对方程组的求解我们采用高斯消去法。高斯消去法属于直接解法，具有

计算速度快、精度高的特点。由于在求解压力场问题时，结点总数(即方程组

的阶数)一般较多，因此方程系数矩阵的元素个数可能非常大，如果全部存放，

则远非一般机器的容量所能允许。所以我们必须从系数矩阵的特点出发，根据

它们的特点给出对系数矩阵高效的存储方法，以减少存储量。综合以上分析，

文中采用变带宽高斯削去法求解方程。下面将分别介绍有限元方程系数矩阵的

特点和变带宽存储法。 

最后形成的有限元方程的系数矩阵 K 的形式如图 10-8(a)所示，它具有如

下特点： 

① 对称正定性：利用对称性，我们只需存储其下三角中的元素，对角线

上面的元素根据对称性的原则可得； 

② 高度稀疏性： K 的阶数愈高，非零元素也就愈稀疏。对于数百阶以上
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的方程组求解，系数阵 K 的非零元素一般都在 5%以下； 

③ 非零元素分布的规则性：适当编排所划分单元的结点号，可使系数阵

K 中的非零元素有规则地分布在主对角线附近的相当狭小的一定宽度中。 

 

(a)                    (b) 

图 10-8 系数矩阵元素的分布及存储方式 

Fig.10-8 Distribution of factor matrix and the storage scheme 
这种对称正定带型矩阵对消去法求解计算非常有利，因为消去法的顺追赶

过程是把下三角中元素消成零，而逆追赶过程是把上三角中的元素消成零，最

后只剩下主对角线上的元素。对于带型矩阵来说，只要把带型宽度中的非主对

角线元素消成零即可，所以在带型宽度以外的零元素，在计算过程中是用不到

的，也就不必进行存储。 

非零元素分布的规律性是压缩存储法中很重要的一个先决条件。如果在每

一行的非零元素中夹杂有零元素，那么在消去过程中，这些零元素都会变成非

零元素。所以夹杂在中间的零元素都要参加运算，也要存储。 

对非零元素的存储，一种方法叫等带宽(或称半带宽)存储，该方法存储系

数矩阵中非零部分的一半宽度的元素，其宽度取为最长一行非零元素的宽度，
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其存储量为见图 10-8 (b)所示的矩形内全部元素。该方法虽然已经大大地压缩

了矩阵元素的存储量，但在有限元法的实际应用中，由于系数阵 K 不一定非常

规则，各行宽度一般并不相等，有的行较长，有的行较短，有时其长度相差可

能较大(见图 10-8(b))，所以这种压缩方法仍存在较大的浪费问题。另一方法为

变带宽存储，该方法是把系数矩阵中的各行非零元素联接起来，以形成一个一

维数组，其存储量为见图 10-8(b)中左侧图形包围的元素。这样，可减少对零

元素的存储量。 
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